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 Welcome
After seven years and three different iterations of Windows,  
we’re finally here at issue 100 of the magazine. It’s been an 
amazing ride and though the world has changed a hell of a 
lot technologically, one thing remains: a Windows PC is still 
the best tool to help you get things done.

Sure, tablets and smartphones have made technology 
instantly accessible, no matter where you might be, but 
there’s still a lot to be said for a big screen, a full size 
keyboard and mouse, and a comfy desk. For years we’ve 
been showing you how to use your computer to do more in 
life, and in issue 100 we’ve pushed the boat out a little.

To celebrate, we’ve unlocked 100 of the best secrets hidden 
inside Windows (plus 21 bonus tips), including how to give it 
a speed boost, essential customisation tricks and much more. 
Enjoy the issue and we hope you feel as inspired as we do.

GET MORE FROM WINDOWS WHEN 
YOU SUBSCRIBE AND SAVE!

We pride ourselves in being the only magazine 
on the shelves to show you exactly how to get 
the best from the Windows operating system, 
whether it’s 7, 8, Vista or even XP. Windows 7 
Help & Advice also comes with a disc, on which 
you can find some of the great apps covered  
in the magazine. If you get a chance, why not 
take out a subscription and pay as little as £2.99 
per issue. See page 32.

Includes guides for 
Windows 8 as well!
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8 Discover Use online tools to take 
control of your household finances

29 Next month Gaze into the 
future… What’s happening in November?

32 Subscriptions Save up to 35 
per cent when you subscribe today!
 
42 Reader offers We’ve a selection 
of money-saving deals just for you
 
75 Overseas reader? Get your 
mag for less with a subscription 
 

76 Four pages of essential 
expert help for all your 
tricky technical queries

ReGUlaRS

FeatUReS

SUppoRt

Includes guides for 
Windows 8 as well!

14 100 great Windows tips 
Do more than ever in Windows with  
this bumper selection of tricks

64 Protect your PC
learn about the types of malware that 
threaten your pC, and how to stop them
 
72 Essential Facebook apps 
Have even more fun with your friends  
on the world’s biggest social network

exploRe The best PC tutorials

Want more? Visit our website at 
www.facebook.com/windowsmag

26 Set up a digital  
media library

30 protect any folder  
on your hard drive

34 Improve your  
summer photos

38 Supercharge the  
Windows Start menu

44 access and troubleshoot  
a computer remotely 

48 Keep your files  
in sync with oneDrive

50 Make the most  
of your dual monitors

54 Make your favourite  
online apps more powerful

56 Create your own  
flowcharts with libreoffice

60 tune up your  
Windows jumplists 

Your guide Nicholas Odantzis says…
“each month we include as wide a range of tutorials 
as possible, to help you use your computer more 
efficiently and inspire you to try new things.”
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 NEW thiNgs to do  amaziNg WEbsitEs  fasciNatiNg facts

Financial times it’s actually really easy to 
manage your money when you know how
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The Knowledge…

The Money Advice Service’s Budget 
Planner is an essential tool for working 
out how much you’ve got to spend, save 
and enjoy each month. It’s a good idea to 
grab a few months’ worth of bank 
statements before you begin to try and 
work out how much you spend on average. 
Once you’ve figured out what’s going out 
and what’s coming in, visit the calculator 
at www.moneyadviceservice.org.uk/en/
tools/budget-planner.

How to take control of 
your finances online

Out of the red

 W
e all know how easy it is to lose 
track of finances. Juggling 
credit cards, loans, mortgages 
and savings can become a 

nightmare made of floating pound 
symbols and cackling bank managers. 
Luckily, the internet has made it easier 
than ever to keep an eye on your cash. The 
most essential tool in 21st-century 
banking is an online account. 

UK banks all use different systems, but 
security and privacy 
are priorities for all of 
them, so you needn’t 
worry about hackers 
accessing your 
information. Once 
you’ve got online banking set up you can 
view statements, make payments and even 
receive text message alerts when your 
account dips below a certain balance.

Being able to view and manage your 
bank account does not necessarily lead to 
financial bliss, but it’s a good idea to look 
at your statements and work out where 
your money’s going. The Money Advice 
Service (www.moneyadviceservice.org.uk) 

is a great place to begin your journey to 
financial freedom. This site is packed with 
useful advice on debt, borrowing, 
budgeting, saving and investing. 

Another brilliant site is www.
moneysavingexpert.com, created by 
financial expert Martin Lewis. Lewis has 
made a name for himself by providing 
easy-to-understand financial tips and 
tricks, and the site itself covers everything 
from finding the best bank accounts to 

tracking down great 
shopping deals. 

Even the best of us 
can go wrong, 
though. If you find 
yourself in financial 

difficulty, try not to stress too much. It’s 
best to notify debtors as soon as you 
realise there’s an issue, but if you’re still 
facing money problems the Citizens 
Advice Bureau (www.citizensadvice.org.
uk) offers free and impartial advice. The 
Consumer Action Group (www.
consumeractiongroup.co.uk) is also on 
hand to help with unscrupulous debt 
collectors and nasty bank charges.

Use the internet to manage your bank accounts and  
keep track of all your spending

Project Loon
that name sounds a little loony!
Well the project itself may sound even 
more loony – it’s Google’s plan to use 
balloons floating on the edge of space to 
beam the internet to remote and 
inaccessible parts of the world.

are we talking kids’ party balloons?
No. Think more along the lines of the great 
big weather balloons scientists send up to 
the edge of space to monitor the climate 
and temperature. These will float around 
in the stratosphere at an altitude of at 
least 18km (11 miles) and wirelessly send 
internet signals to people below.

How do the balloons go to the right 
locations?
Each of the balloons contains a variety of 
solar-powered technology, including GPS 
sensors and altitude adjusters, so the 
balloons can move up and down into 
different air currents depending on where 
they’re needed.

can anyone use loon’s internet 
connection?
Rather than connecting as you would 
Wi-Fi or 4G, you’ll need a satellite dish-like 
receiver somewhere on your property. It’s 
not clear if Google will charge for these, 
given that the company is attempting to 
bring the internet to impoverished areas, 
but its cable internet offering is currently 
free in the US.

Will it actually work?
In theory, yes – a company already 
provides a similar service for people 
working in the unconnected deserts of 
middle America. Google believes users will 
be able to get 3G-like internet speeds 
from the service, too, which will be 
enough for tasks like emailing and 
Facebooking, although signal fluctuations 
may cause streaming services such as 
YouTube and Skype to fail.sliding scale click the plus symbol next to each 

one, then use the slider to specify the amount.
grand total Work through the categories and 
you’ll see what’s left over at the end of the month.

get started click ‘work it out here’ to see 
common incoming and outgoing money.

Budget PLanner Stay solvent with this 

the most essential tool 
in 21st-century banking 

is an online account

1

23

Discover
Manage finances online
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HENRY WINCHESTER 

TECH EXPERT

Tip of the month Chrome Remote Desktop

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 
‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

One of the biggest advantages of Windows 8 
is its OneDrive sync functionality. This nifty 
feature stores all of your settings (such as 
wallpapers, tile layouts and apps) in the 
Cloud so you can seamlessly switch between 
computers and have the same experience 
on each one. It’s switched on by default in 
Windows 8, providing that you’ve signed in 
to a Microsoft account. To find its settings, 
swipe in from the right or hover the mouse in 
the lower-right corner, then choose ‘Settings 
> Change PC settings > Onedrive > Sync 
settings’. Here you will find toggles to 
determine exactly what is shared, and you 
can turn on shared passwords once you have 
verified your computer.

In sync

After 14 years, Windows XP is no longer 
supported by Microsoft. This means that no 
more updates or patches will be issued for 
the operating system, which could leave it 
vulnerable to cyber-criminals and viruses. If 
you continue to use XP, you won’t suddenly 
find it’s overrun with malware – most nasties 
are let in by weaknesses in other programs, 
so running secure and up-to-date software 
such as Google Chrome could help protect 
you. Upgrading to Windows 7 or 8 is easy; 
both are a pleasure to use and – crucially –
they’ll be supported for many years to come.

Goodbye  
Windows XPWindows’ default behaviour is to only load 

one window of a program at a time, which 
makes it easy to manage your desktop. 
However, there are times when you may 
wish to have more than one instance of a 
program running – you might be comparing 
two videos, for example, or want to open a 
couple of Word documents. To open more 
than one program at once, simply find it in 
the Start menu, then hold [Ctrl] and click on 
its icon. If you’re really in a hurry, there’s an 
even quicker way to do it: simply use the 
middle mouse button on an icon in the 
Taskbar and a brand new program window 
will open up for you.

Multiple windows

The ability to remotely access your 
computer from a smartphone or tablet 
is the Holy Grail of mobile computing, 
but until now it’s been complicated to 
set up and meant spending cash on 
software. Yet Google’s Chrome 
Remote Desktop feature has made it 
all a lot easier, and – best of all – it’s 
completely free. Fire up Chrome and 
enter chrome://apps/ in the address 
bar. Click the ‘Web Store’ icon to the 

lower right, search for remote 
desktop and click the ‘+’ icon on the 
first result. Follow the steps to install it 
and set up a PIN if necessary. Next, 
install the Google Remote Desktop 
app on your Android or iOS device, fire 
it up and log in. You should now have 
access to your desktop and programs. 
It even works if you’re on a mobile 
network connection, although you’ll 
need to ensure your PC is turned on.

Access your PC via your phone
Google’s Remote Desktop software is simple to use 
and completely free as well

Get the app Quickly access your computer remotely by using  
Google’s Remote Desktop application
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 F
ollowers of smartphone news will 
know that there are three main 
companies that make operating 
systems for mobiles: Google, Apple 

and Microsoft. It has always been a 
three-horse race – but it could have just 
become a two-horse one, thanks to 
Microsoft’s decision to release the Nokia 
X2, which is a smartphone that runs 
Google’s Android operating system.

This isn’t the version of Android you’ll 
find on most Android phones – it’s 
Android Open Source Project (AOSP). 
This is a minimalist variant of the 
operating system that doesn’t 
include any Google apps or 
services, so you won’t find 
Gmail or Google Maps on it. 
Instead, it’s been ‘reskinned’ 
to look and perform like 
Microsoft’s 
Windows 
operating system, 
complete with its 
distinctive coloured tiles 
and OneDrive, Outlook and 
Skype apps.

But why has Microsoft decided to 
embrace one of its biggest competitors? 
The X2 is aimed at the lower end of the 
smartphone audience, with an attractive 
sub-£100 price tag that should appeal to 
emerging markets and casual users. The 
hope is that people will buy the phone, 

and then migrate onto Windows Phone 8 
devices when they upgrade.

It’s a risky strategy. AOSP is a fairly 
limited version of the operating system, 
and Google’s apps are a major part of 
usual Android experience. While 
Microsoft’s apps are meant to make up for 
the lack of Google’s, they’re designed for 
Android and therefore don’t fit into the 
overall operation of the phone as neatly as 
they would on a Windows phone.

This straddling of the two operating 
systems could well cheapen the Microsoft 
and Nokia brands in the eyes of people 

who own the phones, pushing them 
away into the welcoming 

arms of Android. It’s 
slightly odd that Microsoft 
has built the device at all 
– the news that Windows 8 
is now free for phones and 
tablets means that low-cost 
devices should be plentiful.
Reading between the lines, 

it seems that Microsoft has created 
what is essentially a demonstration 

device – something that shows off 
Windows phones a little without giving 
users a full experience. Microsoft says it’s 
all part of a grander strategy that puts 
services such as Bing search and Skype 
above operating systems such as 
Windows, but this could turn out to be 
another nail in the company’s coffin.

In a surprise about-turn, the Windows developer decides to 
embrace Google’s free mobile operating system

Everyone’s talking about...

1Which feature could 

make the Kudoso 

router a hit with parents?

A) It only lets kids online 
when their chores are done
B) It cleans kids’ rooms 
C) It blocks Facebook access

2The UK’s technology 

strategy board wants 

to test robots where?

A) Old nuclear power plants
B) International war zones
C) Wetherspoon’s branches

3 Apple’s Steve 
Wozniak binned 

which gizmo after just 

half a day?
A) A PlayStation 4 
B) A Microsoft Surface Pro 
C) A Samsung Galaxy Gear

4 Philips’ new lighting 

system is powered 

by which connector?

A) USB
B) Ethernet
C) SCSI

5 Google’s VR headset 

is made from what?

A) Titanium
B) Cardboard
C) Mimetic polyalloy

6 What is the key 
selling point of 

Microsoft’s smart watch?

A) It’s not stupidly big
B) Apple’s Steve Wozniak 
might like it
C) It works with both 
Android and iOS

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1A 2A 3C 4A 5B 6C

Microsoft going Android Blitzortung.org
www.blitzortung.org

If you’ve got a basic knowledge of 
German, you will realise that Blitzortung 
roughly translates to ‘lightning locator’, 
which is exactly what this fascinating 
website does. It gives a live view of 
lightning strikes currently occurring 
around the planet, providing maps of 
each continent and real-time animations 
for strikes. It’s incredible to witness, with 
the French Alps seemingly a permanent 
hotbed of stormy activity.

It’s run entirely by the general public, 
with users creating lightning detection 
devices that can accurately detect the 
atmospheric fluctuations caused by a 
strike, even if they’re hundreds of miles 
away. Clicking ‘Detectors’ on the site even 
lets you see which devices have picked up 
the strike, and if you’re technically-
inclined you’ll find instructions to make 
your own detector and get involved.

Donner unD blitzen Shock your friends by 
accurately predicting when a storm will arrive

Discover
Tech talk
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How do people 
express laugHter 

online?

Which countries have the fastest 
broadband connections?
IT company Akamai recently surveyed 
connection speeds and figured out 
the average per country. In Europe, 
Switzerland comes top with an average 
speed of 12.7Mbps, closely followed by 
the Netherlands’ 12.4Mbps and Sweden’s 
11.6Mbps. The United Kingdom’s 9.9Mbps 
average puts it in 10th place. On a global 
scale, South Korea is the place to live if 
you want speedy broadband, with an 
average connection speed of 23.6Mbps. switzerland

12.7Mbps
sweden
11.6Mbps

CzeCH 
repuBliC
11.2Mbps

Finland
10.7Mbps

norwaY
10.1Mbps

uK
9.9Mbps

netHerlands
12.4Mbps

ireland
10.7Mbps

denMarK
10.5Mbps

soutH Korea
23.6Mbps

BelgiuM
10.0Mbps

A recent spate of high-
profile security breaches at 

major internet retailers such as eBay have – 
unsurprisingly – put a large number of 
Americans off shopping via the internet. In a 
survey conducted by USA Today, 24 per cent 
of participants hadn’t bought anything online 
recently because they were worried about 
entering data. Some 56 per cent said they 
would avoid smaller sites and stick to larger, 
more trustworthy ones – which is exactly the 
strategy we recommend.

Have seCuritY 
BreaCHes 
put You oFF 
sHopping 
online?

3.28% express laughter in some other manner
3.46% roll on tHe Floor laugHing tHeir asses oFF

3.74% roll on tHe Floor laugHing

11.39% laugH tHeir asses oFF

17.23% tYpe ‘HaHaHa’

60.89% laugH out loud
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Henry Winchester reveals a host  
of fascinating digital facts



…are less depressed and more 
mentally active, according to a 
report from NeoMam studios 
titled Why the Internet is Good 
for You. It doesn’t just help 
older people, either; one in six 
teens use the internet to find 
information about health issues 
they wouldn’t normally ask 
about. It also helps people find 
love, with 35 per cent of couples 
married between 2005 and 
2012 originally meeting online. 
It’s not all bad!

Skyscanner says that UK 
passenger figures are expected 
to increase to 312 million by 
2030, and our approach 
to air travel will have to 
change as a result. The 
flight comparison 
website believes 
that our luggage 
will be connected to the internet 
so we can track it on its 
journey, and biometric data 

cards will replace passports. The 
stuffy, drab interiors of current 
departure lounges will be replaced 

with soothing open-air 
oases, and you’ll be able 
to hold 3D holographic 

conversations with 
friends and family 
while you’re in 

flight. No word on whether or not 
aeroplane meals will become 
edible, though.

senior 
Citizens wHo 
spend More 
tiMe online…

Gaming company valve began developing its digital 
download software in 2002 as a way to keep games – 
such as the company’s Counter-Strike – up to date.

the steam software beta was first made available to 
download in January 2003 alongside Counter-Strike 
version 1.6.

up to 300,000 gamers tested steam, and the platform 
almost completely collapsed as a result of the strain on 
its servers.

nevertheless, the company persevered and in 2004 
released Half-Life 2 via steam which helped cement the 
service as an alternative to cds and dvds.

in 2005, valve negotiated deals with the developers 
of Rag Doll Kung Fu and Darwinia to become the first 
third-party titles available via the service.

by 2007, 150 games were on sale via steam and 13 
million user accounts had been created.

steam cloud hit the service in 2009, allowing gamers to 
save in-game progress on one computer and continue 
on another.

initially Pc-only, steam was released for apple’s Mac os 
X in 2010 and Linux in 2013.

screen digest estimates that 75 per cent of games 
bought for Pcs are sold via steam.

there are now 75 million active steam user accounts, 
and Dota 2 is the most popular game on the service 
with over 700,000 players.

Top STeam facTSHow successful 
are mobile 
games?

47 per Cent...

Very! Independent gaming 
studio Fireproof’s iPad 
game The Room cost £160,000 
to develop, but sold a million units 
in 14 weeks. Its success led to iPhone 
and Android versions, and a sequel. 
These have reached combined 
downloads of almost 10 million. 
Apple’s iOS platform is the most 
popular, with 86 per cent of sales 
coming from the App Store. Android 
purchases make up the rest.

...of American smartphone users believe 
they couldn’t last more than a day 

without their mobile phones. According 
to the survey conducted by Braun 

Research, 85 per cent of respondents 
check their phone at least a few times a 
day, and 35 per cent look at it constantly, 

which makes you wonder how they 
found time to fill in the survey. Forty-five 
per cent said they’d rather live without 

booze than their handheld gizmos.

wHat will air travel 
Be liKe in 2024?

source: www.steampowered.com, http://en.wikipedia.org, http://technology.ihs.com
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Cover feature
100 Windows secrets

T o celebrate our 100th issue, we thought we‘d 
include the 100 best Windows tips around.  
And since we always like to deliver more than 
expected, we’re bringing you 21 amazing bonus 

tips, tricks, secrets and shortcuts too! Don‘t forget, there 
are plenty more on this month‘s cover disc as well.

This feature includes some fantastic tweaks – keep 
reading and you‘ll discover simple but effective techniques 
to cut your PC‘s boot time, fix annoying problems and 
revitalise your desktop. There are amazing shortcuts to 
speed up file management and have you navigating 
Explorer like a pro. Most of the tips we've listed here 
will work on all Windows versions, but some are version 
specific. So, without further ado, let’s get stuck in! 

100
Windows
secrets

 Discover how to do so much more in 
Windows with our bumper selection of 

tips and tricks. By Mike Williams



XP

Look & feel
Revitalise your desktop

1View eVeryThing 
The Windows 7 

Computer folder no longer 
displays the Control Panel 
or Recycle Bin on its 
opening view. But there is 
an easy way to bring them 
back – click ‘Tools > Folder 
Options’, check ‘Show All 
Folders’ and click ‘OK’.

2easy folder 
swiTching 

To select a window, you 
normally have to click it, but 
there‘s another Windows 7 
option that‘s easier. Click 
‘Start’, type Ease, click ‘Ease 
of Access Center > Make 
the mouse easier to use’, 
and check ‘Activate a 
window by hovering over it 
with the mouse’. Leave the 
cursor over a window for a 
second, and Windows 
brings it to the foreground.

3 Take conTrol of 
your windows 

If you don‘t like the way 
Windows 7 automatically 
resizes and relocates 
windows when they‘re 
moved to the edge of the 
screen, turn the feature off. 
Click ‘Start’, type Ease, click 

the ‘Ease of Access Center’ 
link, and select ‘Make it 
Easier to Focus on Tasks’. 
Check the ‘Prevent windows 
from being automatically 
arranged button’, and then 
click ‘OK’.

4creaTe a deskTop 
slideshow 

Right-click an empty part  
of the desktop, click 
‘Personalize > Desktop 
Background’, and select  
the ‘Windows Desktop 
Backgrounds’ folder under 
‘Picture Location’. Then 
hold down [Ctrl] while 
clicking every wallpaper 
you like, or press [Ctrl] and 
[A] to select them all. 
Windows switches from one 
to the next every 30 
minutes, though you can 
set a different frequency by 
selecting it in the ‘Change 
picture every’ box.

5disable aero peek 
By default, Windows 7 

hides open windows to 
display the desktop when 
you move your mouse over 
the lower right-hand corner 
of the screen – this feature 
is called Aero Peek. If you 

find this 
annoying, 
it‘s easy to 
turn off. 
Right-click ‘Start’, select 
‘Properties > Taskbar’ and 
clear ‘Use Aero Peek to 
preview the desktop’.

6resize The 
cursor 

If it‘s hard to see the 
single-line Windows cursor, 
in Windows 7 click ‘Control 
Panel > Ease of Access > 
Ease of Access Center’, 
select ‘Make The Computer 
Easier To See’ and set the 
thickness of the blinking 
cursor to what suits you.

7access eVeryThing 
For an easier way to 

access all the advanced 
applets and maintenance 
options in Windows 7, 
create a folder and call it 

Everything.{ED7BA470-
8E54-465E-825C-
99712043E01C}. You‘ll see 
shortcuts to useful network 
options, troubleshooting 
tools, user account settings 
and more. 

9reVeal empTy 
driVes 

The Computer folder 
confusingly hides all the 
drives that aren‘t currently 
in use, such as a memory 
card reader that doesn‘t 
contain a card. If you want 
to show all your drives, all 
the time, click ‘Tools > 
Folder Options > View’, 

clear the ‘Hide empty 
drives in the 

Computer 
folder’ box 

and then 
click the 

‘OK’ button.

10pin a driVe To  
The Taskbar 

To pin a drive icon to your 
Taskbar, right-click an 
empty part of the desktop, 
and select ‘New > Text File’. 
Rename the TXT extension  
so it reads C.exe (replace 
the ‘C‘ with the drive letter 
you want to launch). Drag 
and drop C.exe on to the 
Taskbar, and delete the 
original file. Right-click its 
new icon, then right-click ‘C’ 
on the jump list and select 
‘Properties’. Change the 

contents of the Target and 
Start In boxes to point to 
your chosen drive. Click 
‘Change Icon’, choose an 
icon for the drive, click ‘OK’.

11sTay alerT 
When a Windows 7 

program wants to tell you 
something, its Taskbar 
button flashes, but only 
three times – it‘s easy to 
miss. If you‘d like to increase 
the number of flashes, run 
REGEDIT, go to HKEY_
CURRENT_USER\CONTROL 
PANEL\DESKTOP and 
double-click ‘ForeGround 
FlashCount’. Choose the 
Decimal option and set it to 
the number of flashes you 
need. Beware: entering zero 
doesn‘t stop it flashing – it 
ensures the button flashes 
until you click it to see 
what‘s going on.

8 Instantly resize icons Hold down the 
[Ctrl] key while rotating the mouse scroll 
wheel to increase or decrease the icon size.

RoTATE 
youR bACk- 
gRounDS
Windows 7 
can change 
your 
wallpaper 
for a more 
interesting 
desktop
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Speed
Give Windows a boost

12creaTe a reTro 
Taskbar

If you‘re not so keen on 
the combined Taskbar 
buttons in Windows 7, 
restore the old Windows 
XP and Windows Vista 
style – right-click the 
Taskbar, select 
‘Properties’, and set the 
Taskbar buttons option to  
‘never combine’.

13rearrange 
your apps

Windows 7 Taskbar 
buttons are now 
moveable – drag, drop 
and reposition them to  
suit your needs.

14keyboard 
speedup #1

To select a Taskbar app 
from the keyboard, hold 
down the [Windows] key 
and hit [1] to launch the 
first icon, [2] the second, 
[3] the third, up to [0] 
(which represents 10).

15View a websiTe
Want easier access 

to the web? Right-click 
the Taskbar, select 
‘Toolbars > Address’, then 
enter a uRL such  
as www.bing.com 
whenever you like to 
open a browser window 
at that page.

16fasT Task-
swiTching

To switch quickly 
between windows of the 
same application, hold 
down [Ctrl] as you click  
the app‘s Taskbar button.

17relaunch 
wiTh a click

If you‘ve launched an 
application and then want 
to run another copy, don‘t 
go back to the Start menu 

Top 10 Taskbar tips
Get more from your 
Windows 7 Taskbar 

– just hold down [Shift], 
click the app‘s Taskbar 
icon and Windows fires 
up another instance of 
the program.

18rearrange 
your windows

Do you miss the  
old ‘Minimize all 
windows’, ‘Cascade’, 
‘Tile’ and other 
options that no longer 
appear when you 
right-click a Taskbar 
button in Windows 7? 
Then hold down 
[Ctrl]+[Shift] as you 
right-click – and 
they‘re displayed.

19Quick launch 
reTurns

If you‘d like the old Quick 
Launch toolbar back, 
right-click the Taskbar, 
click ‘Toolbars > new 
Toolbar’, type 
%userprofile%\AppData\
Roaming\Microsoft\
Internet Explorer\Quick 
Launch in the folder box, 
and click ‘Select Folder’.

20keyboard 
speedup #2

To switch to a Taskbar 
application from the 
keyboard, hold down the 
[Windows] key and press 
[T] to select the Taskbar, 
then use the left and 
right arrows to select an 
application, and [Enter] to 
launch it.

21shrink The 
Taskbar

Cutting the Taskbar  
down to size leaves more 
screen space for all your 
applications. Right-click 
the Taskbar, select 
‘Properties’ and check  
‘use Small Icons’ to make 
it happen.

22halT runaway 
programs 

If a program is grabbing all 
your processor time and 
slowing everything down, 
but you can‘t close it, hit 
[Ctrl]+[Shift]+[Esc] to launch 
Task Manager. Click 
‘Processes’, then select 
‘Show processes from all 

users’. Click the 
CPU column 
header, and 
find the 
program using 
the most CPU 
time. Right-
click the 

program, 

select ‘Set Affinity’, 
clear all but one of your 
processor core boxes, and it 
won‘t be able to use them. 
Your PC will speed up.

23uninsTall 
surplus 

sofTware
Uninstalling unwanted 
programs can speed up 
your PC. But which ones 
should go? Launch the 
Uninstall a Program applet 
in Control Panel, and click 
the ‘Installed on’ column 
header to sort your 
programs by the date you 
installed them. (Don‘t see 

Installed On? Right-click a 
column header, and check 
the Installed On box – if 
necessary, click ‘More’ to 
locate it.) You can see 
programs you installed 
long ago. If there are any 
you‘ve forgotten about that 
are surplus to requirements, 
uninstall them to make 
room for others.

25launch ie fasTer 
If IE8 seems slow to 

launch, fire up the browser, 
click ‘Tools > Manage 
Add-ons’, and click 
‘Toolbars & Extensions’. This 
displays all your add-ons, 
along with a Load Time 
figure that shows how long 
they took to launch. If you 
spot one that‘s wasting 
time that you don’t need, 
uninstall it, or click the 
extension and hit ‘Disable’.

26power up 
The Windows 7 

Power Options can make a 
real difference to system 
speed. Go to ‘Control Panel 
> Hardware and Sound > 
Power Options’, and 

ensure you have ‘High 
Performance’ selected.

27booT Quickly 
Install multiple 

versions of Windows on a 
PC and you get a menu 
asking which one you‘d like 
to launch. By default this 
waits up to 30 seconds 
before selecting the default 
choice, but if that‘s too 
long, launch MSCONFIG.
EXE, click the ‘Boot’ tab and 
set the Timeout figure to, 
say, 10 seconds instead.

28free up hard 
driVe space 

If you‘re running short of 
hard drive space, Windows 
Disk Cleanup can help. Click 
‘Start’, type Disk and click 
‘Disk Cleanup’. Choose the 
drive you‘d like to clean  
and click ‘OK’. Disk Cleanup 
displays files it thinks you 
can delete. By default, only 
a few are selected, so check 
the boxes next to anything 
else you don‘t need and 
click ‘OK > Delete’.

29remoVe old 
picTures 

Fix a photo in Windows Live 
Photo Gallery and it keeps 

24 Uninstall easily If the 
uninstaller fails, boot into 
Safe Mode and try again.

TAkE 
ConTRoL
blocking 
access to 
your CPu 
cores 
quickly 
brings any 
program 
into line
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the original forever; great if 
you need to undo it, but 
otherwise a waste of space. 
To tweak this, launch Photo 
Gallery, click ‘File > 
Options’, and set ‘Move 
originals to Recycle Bin 
after’ to, say, one month.

30saVe resources 
If you‘ve installed an 

antivirus package, you don‘t 
need Windows Defender. 
Click ‘Start’, type Defender 
and click ‘Windows 
Defender’ to fire up the 
program. Click ‘Tools > 
Options > Administrator’ 
and clear the ‘Use This 
Program’ box, then click 
‘Save’ to turn off Defender.

31spoT hidden 
windows 

Sometimes programs 
display a message asking 
you to do something, but 
it‘s under another window 
and you don‘t see it. You‘re 
waiting for the program, it‘s 
waiting for you, so nothing 
happens. The window is 
made visible after 200 
seconds, but you can 
shorten the delay. Launch 
REGEDIT, go to HKEY_
CURRENT_USER\Control 
Panel\Desktop, double-click 
‘ForegroundLockTime 
out’ and select ‘Decimal’. 
Change the value to 30,000 
milliseconds (30 seconds) 
and see how this works.

32browse menus 
aT speed 

A Registry edit can shorten 
the pause before Windows 

menus expand, speeding 
up navigation. Launch 
REGEDIT, go to HKEY_
CURRENT_USER\Control 
Panel\Desktop, double-click 
‘MenuShowDelay’, and 
select ‘Decimal’. Change the 
default to something a little 
snappier – 200 (which is 0.2 
seconds) works for us.

33disable aero 
(Temporarily) 

When you‘re running a 
program that requires all 
your RAM, you can give it a 
little extra by automatically 
(and temporarily) turning 
off Aero. Browse to the 
executable file or its 
shortcut, right-click it, select 
‘Properties > Compatibility’ 
and check ‘Disable desktop 
composition’. Run the 
program and Aero is turned 
off, then restored when the 
program is shut down.

34locaTe 
unwanTed 

serVices 
Many applications install 
Windows services, which 
run all the time, consuming 
valuable resources. To view 
these, run MSCONFIG.EXE, 
click ‘Services’ and check 
‘Hide all Microsoft services’. 
Don‘t disable anything 
unless you know what 
you‘re doing, because it can 
be dangerous. But if you 
recognise apps that are still 
installed, and you no longer 
use them, uninstall them.

35use one defrag 
Tool only 

If you‘ve installed a 
third-party defrag tool, 

disable the Windows 
version, because it may still 
be running, wasting time 
and resources. To turn it off, 
click ‘Start’, type Defrag, 
click ‘Disk Defragmenter’ 
and select ‘Configure 
Schedule’. Clear the ‘Run on 
a schedule’ box.

37disable aero 
(always) 

If you‘re running Windows 
7 on an underpowered PC, 
improve performance a 
little by turning off the Aero 

interface. Right-click an 
empty part of the desktop, 
select ‘Personalize’, scroll to 
Basic and High Contrast 
Themes and click ‘Windows 
7 Basic’. If you miss the  
old look, return to the 
Personalize dialog and 
choose an Aero Theme.

38solVe slow 
sTarTs 

If Windows 7 is taking a 
long time to launch or shut 
down, Event Viewer may 
tell you which program or 
driver is responsible. Click 
‘Start’, type Eventvwr.msc 
and press [Return], then 
expand the Applications 
and Services Logs section, 
and browse to Microsoft\

Windows\Diagnostic 
Performance\Operational. 
Scroll the events list on your 
PC to see if Windows knows 
who to blame for 
performance issues.

39fix This odd 
booT bug 

Is your Windows 7 desktop 
background a solid colour? 
Then it may mean your PC 
takes 30 seconds longer 
than usual to boot. Change 
your background to an 
image to restore normal 
start-up performance,  
or install a hotfix from 
Microsoft (http://support.
microsoft.com/kb/977346).

40saVe driVe space 
Windows 7 keeps 

files on your last 50 crashes. 
If you‘ll never look at this 
data, though, it‘s a waste  
of hard drive space. Run 
REGEDIT, go to HKEY_
LOCAL_MACHINE\SYSTEM\
CurrentControl 
Set\Control\CrashControl, 
and set MiniDumpsCount 
to 5. Windows now keeps 
the last five dumps, so you 
have some info if you need 
to diagnose crashes but you 
also gain a little drive space.

36 Command line speed-up Drag and drop 
a file on the Windows 7 command window 
and the full name appears automatically.

DISAbLE 
DEFEnDER
If you‘ve 
installed a 
full security 
package, 
running 
Windows 
Defender is 
a waste of 
resources

TuRn  
AERo oFF
Some PCs 
seem a little 
faster when 
using the 
Windows 7 
basic theme
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keyboard shortcuts
Learn these keyboard 
shortcuts if you want to 
use your apps like a pro
41 [windows] key and left 
arrow Docks the current window 
to the left half of the screen.

42 [windows] key and right 
arrow Docks the current window 
to the right half of the screen.

43 [windows] key and  
up arrow  
Maximises the current window.

44 [windows] key and  
down arrow  
Minimises the current window.

45 [windows] key and [m]  
Minimises all windows.

46 [windows] key and space  
Makes all windows transparent  
so you can see the desktop.

47 [windows] key and [shift] 
and left arrow/right arrow  
on a multi-monitor PC, this 
shortcut moves a window from  
one monitor to another.

48 [windows] key and [b] 
Moves focus to the system tray.

49 [windows] key and [e] 
Launches Windows Explorer.

50 [windows] key and [f]  
Displays the Find dialog.

51 [windows] key and [ctrl]
and [f] Displays the Find 
Computer dialog.

52 [windows] key and [pause] 
Displays System Properties dialog.

53 [windows] key and [+]  
Zooms in on the screen.

54 [windows] key and [-] 
Zooms out from the screen.

55 [windows] key and [alt] 
and [1] to [9] opens jump list for 
the icon in that Taskbar position.

➜

➜
➜

➜

Space

Shift

Ctrl

Alt

Pause 
Break

+

-

M

B

E

F

➜

➜

F

1

Power user 

56repair broken 
windows

Poorly written software can 
remove vital Windows files, 
leaving your PC unreliable. 
If you‘re having problems, 
asking Windows to look for 
and restore any damaged 
files may help. Click ‘Start’, 

type Command, right-click 
the ‘Command Prompt’  
link and select ‘Run as 
Administrator’. At the 
command prompt, type  
sfc /scannow and press 
[Enter]. The SFC tool checks 
your PC, applies any fixes 
where necessary, and lets 
you know what‘s happened. 

problems, it may also break 
DVD burning and other 
drive-related programs that 
you‘ve installed. If so, you 
need to reinstall them.

59close hung 
programs 

When a program locks up, 
you normally press 
[Ctrl]+[Shift]+[Esc] to launch 
Task Manager, click the 
program name, then select 
‘End Task’. But sometimes 
this doesn‘t work, and the 
program stubbornly refuses 
to die. If this happens to 
you, right-click the program 
in Task Manager, and select 
‘Go To Process’. Right-click 
the process again, select 
‘End Process’, and with any 
luck your misbehaving app 
will finally bite virtual dust.

60share your 
driVe space 

If you want to stop a 
particular user on your 
PC from tying up all 
your hard drive space, 
the Disk Quota option 
can help. Click 
‘Computer’, right-click 
on a drive you‘d like to 
protect, and select 
‘Quota > Show Quota 
Settings’. Check ‘Enable 
Quota Management’, 
click the ‘Quota Entries’ 
button, double-click any 

user you‘d like to restrict, 
and select the maximum 
amount of disk space 
they‘re able to use.

61command line 
Trickery 

Sometimes you might want 
to make a note of all the 
files in a particular folder, 
but unfortunately Explorer 
still provides no way to do 
this. A little command line 
work can help, though: 
simply click ‘Start’, type 
CMD /C DIR "C:\Program 
Files" | Clip and press 
[Enter]. This opens a 

57 You have the power! 
Right-click Start, select 
Properties, and choose 
the action you‘d prefer.

IP ADDRESS
It‘s time to 
tweak your 
router. Pity 
you‘ve 
forgotten  
its address…

58resTore missing 
dVd driVes 

If Windows doesn‘t 
recognise your DVD drive, 
try rebooting. No change? 
Run REGEDIT, browse to 
HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControl 
Set\Control\Class\
{4D36E965-E325-11CE-
BFC1-08002BE10318}, then 
delete both UpperFilters 
and LowerFilters in the 
right-hand pane. Then 
reboot again. Beware, while 
this usually fixes odd drive 

Tips to help you take control
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command window for one 
command only,  
lists all the files in the 
specified folder (replace  
C:\Program Files with 
whatever you‘d like to use), 
then copies the list to the 
clipboard, ready for pasting 
wherever you like.

62Turn a folder 
inTo a driVe 

When you‘re regularly 
working in a folder deep 
in your file system, you 
probably spend lots of time 
expanding other folders to 
reach it. But Windows does 
provide another way. Click 
‘Start’, type SubST z: "c:\my 
data\work\accounts\2008\
december" and press 
[Enter], for instance, and 
Windows creates a virtual 
drive called Z: that actually 

points to the folder you‘ve 
specified. (Enter a drive 
letter that doesn‘t exist on 
your PC, and a folder path 
that does, surrounded by 
quotes.) Your new drive 
appears in the Computer 
folder, and in file Save or 
Open dialogs, so it‘s easy to 
select. And if you save, or 
drag-and-drop files to that 
folder, they actually go to 
the folder, just as you‘d 
expect – very convenient. 
Reboot, or enter SubST  
z: \D to delete a virtual 
drive (don‘t worry, the 
contents of your folder 
remain untouched).

63searching 
command 

prompT windows 
Every power user needs to 
work at the command line 

71iobiT 
uninsTaller

www.iobit.com/
advanceduninstaller.html
An easy-to-use tool that 
(unlike the Windows 
equivalent) removes 
every trace of a program 
from your PC.

72VisTa 
swiTcher

www.ntwind.com/
software/vistaswitcher
Replaces the [Alt]+[Tab] 
dialog with a full list of 
all running programs, 
and larger previews, 
making it far easier to 
switch applications.

73copy handler
www.copy 

handler.com
Replaces the Explorer 

file copy function; it‘s 
more configurable, 
often faster, enables you 
to pause and resume 
copies, and cancel 
individual files.

74ulTra search
www.jam-soft 

ware.com/ultrasearch
ultra Search is ultra-fast 
and locates files with the 
names you specify 
almost as fast as you can 
type. It‘s far speedier 
than Windows Search, 
and doesn‘t waste time 
building indexes.

75shuTdown 
Timer

www.sinvise.net
need a more flexible 
way to shut down your 
PC? Shutdown Timer 

closes in a few minutes, 
at a named date and 
time, when your CPu is 
idle, network activity has 
stopped, and more.

76explorer++
www.

explorerplusplus.com
This is fast, small and 
configurable, featuring 
tabbed folders for easy 
file management on 
even the most complex 
of hard drives.

77windows 
media  

player plus
http://bmproductions.
fixnum.org
This free plug-in extends 
Media Player with an 
easy-to-use tag editor, 
adds ‘What‘s Playing 

now‘ information to the 
title bar and Windows 
Live Messenger status, 
simplifies searching, 
restores the last active 
playlist when you restart 
Media Player, and more.

78sTarT menu 
cleaner

www.iceview.com/
start-menu-cleaner
Every Start menu gets 
cluttered with broken 
shortcuts and empty 
folders. This program 
finds and deletes them, 
making it quicker and 
easier to navigate the 
rest of your system.

79folder menu
http://foldermenu.

sourceforge.net
Forget desktop 

shortcuts or Taskbar 
buttons, Folder Menu 
brings up a customisable 
menu of favourite 
folders with just a  
click of the middle 
mouse button, then 
provides many shortcuts 
to help you access them 
more quickly.

80diTTo
http://ditto-cp.

sourceforge.net
Ditto extends the 
Windows clipboard, 
storing everything you 
copy there. If you copy 
one image to the 
clipboard, say, then 
another, Ditto ensures 
the first is still available 
and you can paste it into 
a document in a couple 
of clicks.

add-ons Enhance your PC with these powerful free tools

occasionally. But it‘s not 
easy, and you‘ll often find 
yourself scrolling up and 
down the window, looking 
for a particular file name or 
some other detail. Don‘t 
forget, though – there is a 
quicker way. Just right-click 
in the command window, 
choose ‘Find’, enter a key 
word and then Windows 
quickly locates and displays 
it for you.

64close explorer 
gracefully 

If you need to close 
Explorer for some reason, 
don‘t do so with Task 
Manager except as a last 
resort. Instead, click ‘Start’, 
hold down [Ctrl]+[Shift], 
right-click any empty part 
of the Start Menu and 
select ‘Exit Explorer’.

65sTop windows 
updaTe 

rebooTing your pc 
Windows may reboot your 
PC to install some new 
update – annoying if you‘d 
left a program running and 
all its work is lost. To fix this, 
run REGEDIT, browse to 
HKEY_LOCAL_ MACHINE\
SOFTWARE\Policies\
Microsoft\Windows\
WindowsUpdate\AU, create 
a 32-bit DWORD value 
called NoAutoReboot 
WithLoggedOnUsers and 
set it to 1. 

66Turn hibernaTe 
off 

If you don‘t use the 
Windows 7 Hibernate 
feature, turning it off frees 
up a little hard drive space, 
and delivers a tiny 
improvement in PC speeds. 
Click ‘Start’, type CMD, click 
the cmd.exe link, and select 
‘Run as Administrator’, then 
type powercfg / hibernate 
off to disable hibernation, 
or powercfg / hibernate 
on if you need to turn it 
back on again later.

AuToMATIC 
REbooT
That huge 
file you  
wanted to 
download? 
you‘ll have 
to start 
again, sorry
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Troubleshooting

81solVe power 
problems 

If your Windows 7 laptop 
battery life isn‘t what you 
expected, a command line 
tool may be able to tell you 

Repair Disc’ option, then 
follow the instructions to 
burn a disc. You can‘t 
reinstall Windows with this, 
but it does have useful 
disaster recovery tools, so  
if your PC won‘t start in 
future, boot from the 
Repair Disc instead and it‘ll 
do its best to help.

84search 
accuraTely 

If Windows Search isn‘t 
finding files you know are 
there, rebuilding its index 
may help. Click ‘Start’, type 
Index, click ‘Indexing 
Options > Advanced > 
Rebuild > OK’, and try 
searching again once the 
index has been recreated.

85solVe hard 
driVe problems 

If your PC seems unreliable, 
crashing all the time, you 
may have hard drive errors. 
Open the Computer 
window, right-click your 
main system drive, select 
‘Properties > Tools > Check 
Now’ and click ‘Start’ to 
track them down. And 
repeat the process on other 
hard drives you use for 
good measure.

86memory 
maTTers 

Faulty memory can cause 
all kinds of odd PC 
behaviour, and is difficult  
to detect – but Windows 
has a RAM checker that can 
reveal the problem. Click 
‘Start’, type Memory and 
then click on the ‘Windows 
Memory Diagnostic’ link. 
Click ‘Restart Now’ and 
your computer will reboot, 
then will run a check of 
your memory, and let you 
know whether it‘s detected 
any problems.

67‘run as‘ reTurns 
Right-click a program 

in Windows XP and you see 
a ‘Run as‘ option, enabling 
you to launch the program 
as a different user. This is 
handy if you need to run a 
program with different 
security privileges to your 
current account. This 
disappeared in Windows 
Vista, but Windows 7 brings 
it back – hold down [Shift] 
as you right-click a program 
and choose the ‘Run As 
Different User’ option. 

68find your 
rouTer‘s  

ip address 
If you need to change  
your router settings, you 
probably have to enter its 
IP address into a browser. 
But which address is that, 
exactly? To find out, type 
cmd and click the ‘cmd.exe’ 
link to open a command 
window, then type ipconfig 
/all and press [Enter]. Scroll 
down the list, looking for 
the network adaptor that‘s 
connected to your router, 
check its Default Gateway 
setting, and that‘s usually 
the router address.

69Tweak sysTem 
resTore 

System Restore is a great 
disaster recovery tool, but 
can consume loads of hard 
drive space. To recover 
some of it, click ‘Start’, 
right-click ‘Computer’, 
select ‘Properties’, and click 
‘Advanced System Settings 
> System Protection’. Then, 
for each drive where System 
Restore Protection is set to 
On, click ‘Configure’, and 
set the Max Usage figure to 
the maximum amount of 
drive space you can afford 
to lose.

70saVe your chaTs 
Windows Live 

Messenger can save your 
chats for reference later, 
with a tweak – click ‘Tools  
> Options > Messages and 
check ‘Automatically  
keep a history of my 
conversations’.

87recoVer losT 
files 

If you‘ve accidentally 
deleted a file, right-click the 
folder where it was stored, 
and click ‘Properties > 
Previous Versions’. If you‘re 
in luck, you‘ll see earlier 
versions of the folder, each 
dated at some point in the 
last few days. Double-click 
one from a time when  
you knew the file was still 
around, it opens in Explorer, 
and if the file is present, you 
can open it as normal.

88geT a pc healTh 
check 

If your Windows 7 system 
isn‘t performing very well, 
hold down the [Windows] 
key, press [R], then type in 
perfmon /report and press 
[Enter] to generate a 
diagnostic report. This 
includes details of your 
computer‘s current status, 
any problems that you 
might have, and 
recommendations on  
how to fix them.

89sharpen up 
your TexT 

Windows 7 doesn‘t always 
display text as clearly as it 
should. To check your PC, 
click ‘Start’, type ClearType, 
and click ‘Adjust ClearType 
Text’ to launch the 
ClearType Text Tuner, which 
applies several simple tests 
to help ensure that text is 
sharp and easy to read.

90annihilaTe 
Windows 7 

sometimes issues pointless 
alerts, such as complaining 
that you‘re not using 
Windows Backup even if 
you‘re regularly running 
another back-up tool. To fix 
this, go to ‘Control Panel > 

83 Run as Administrator To run any Windows 7 program as 
administrator, hold [Shift]+[Ctrl] as you click its shortcut.

why. Click ‘Start’, type 
Command, right-click  
the link to ‘Command 
Prompt’ and select ‘Run  
As Administrator’. Type 
powercfg –energy and 
press [Enter]. The PowerCFG 
tool spends a while 
browsing your PC, then 
produces a report detailing 
power-related problems 
and recommendations that 
seem relevant.

82fix an 
unbooTable pc 

If Windows 7 won‘t start, 
you can use its installation 
DVD to try to fix the 
problem. But what if your 
system didn‘t come with a 
DVD, or maybe you‘ve lost 
it? Fortunately, Windows 7 
can burn a separate System 
Repair CD that carries out 
the same functions. Click 
‘Start’, type Repair and 
choose the ‘Create a System 

unDELETE 
EASILy
Lost an 
important 
file? The 
Previous 
Versions 
dialog may 
help to 
bring it back

Eradicate PC problems yourself
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Make life easier
Zebra in their contents, for 
instance.

100easy screen 
grabs 

Click ‘Start’, type Snip and 
click ‘Snipping Tool’. When 
you want to take a grab, 
select ‘File > New Snip’, 
drag the mouse cursor 
around the area to capture, 
and it appears in the 
Snipping Tool window. Click 
‘Tools’ for various options 
to draw on your grab, or 
‘File > Save As’ to save it as 
a PNG, GIF or JPG file.

101upload To 
flickr 

Don‘t look for a program to 
upload your photos to 
Flickr – Windows Live Photo 
Gallery can do it. Click 
‘Publish > Publish on Flickr’ 
and follow the instructions.

102launch 
appleTs fasT 

Don‘t browse Control Panel 
for an applet – launch it 
directly. To run Device 
Manager, say, click ‘Start’, 
type Device in the search 
box and Windows should 
display a Device Manager 
link for you. Or type the 
applet‘s executable file 
name, such as devmgmt.
msc (Device Manager), 
services.msc (Services), 
diskmgmt.msc (Disk 
Management), or 
compmgmt.msc 
(Computer Management).

103access 
neTwork files 

To work on network files 
even when that PC isn‘t 
connected (in Windows 7 
Professional, Ultimate or 
Enterprise) there‘s an easy 
fix. When the network 
computer is available, 
browse to the file or folder 

you need, right-click it, 
check ‘Always 
Available Offline’, 

items of hardware – just 
right-click on any of these 
for a list of settings that you 
can tweak.

95solVe email 
problems 

If Windows Live Mail isn‘t 
working as it should, 
logging all its activities may 
reveal the problem. Click 
‘Tools > Options > 
Advanced > Maintenance’, 
and check the logs  
you need in the 
Troubleshooting section. 
The logs are saved in the 
Store Folder.

EASy 
ACCESS
Devices and 
Printers 
provides an 
easier way 
to tweak  
all your 
hardware

SuPER SHoRTCuTS 
navigate your folders 
quickly with our Windows 
Explorer secrets

Time-saving advice

System and Security > 
Action Center > Change 
Action Center Settings’, 
then clear the boxes next to 
Windows Backup and any 
other types of messages 
that you don‘t want to 
receive.

91The righT Time 
Windows 7 

automatically sets your PC‘s 
clock once a week, using a 
very accurate internet time 
server to make sure it‘s 
correct. If the time has 
drifted off for some reason, 
though, you can quickly set 
it again by clicking the 
system tray clock, and 
selecting ‘Change Date and 
Time Settings > Internet 
Time > Change Settings > 
Update Now’.

92Trouble-
shooTing 

ToolkiT 
For quick access to all the 
best Windows tools, click 
‘Start’, type MSConFIg and 
press [Enter] to launch the 
System Configuration 
program, then click the 
‘Tools’ tab. This lists tools 
such as the Action Center, 
Troubleshooting applet, 
System Restore option, 
command prompt, 
Resource Monitor and 
more, and they‘re all just a 
double-click away.

93fixing  
windows 7 n 

If you have Windows 7 N, 
that means you don‘t get 
Windows Media Player, 
Media Center, DVD Maker 
and other goodies, and 
third-party apps that rely 
on these may not install or 
work properly. Fortunately, 
you can download and 
install the missing 
components in the shape  
of Microsoft‘s Windows 
Media Pack – it‘s available 
at http://support.microsoft.
com/kb/968211.

94simple 
hardware 

managemenT 
Tweaking your PC‘s 
hardware settings used to 
involve browsing a host of 
separate Control Panel 
applets, but Windows 7  
has made life a little easier. 
Go to ‘Control Panel > 
Hardware and Sound > 
Devices and Printers’ and 
you‘ll see icons for all major 

96open websiTes 
wiTh a keypress 

Click ‘Favourites’, right-click 
the Favourite for your 
particular site, and select 
‘Properties’. Click in the 
‘Shortcut Key’ box and 
press the key combination 
you‘d like to launch the site 
– [Ctrl]+[Alt]+[G] for 
Google, say. Close your 
browser, press your 
shortcut key, and your 
default browser opens to 
display the site.

97moVe files  
easily 

If you want to move 
some files to one of 
your main folders 
– Pictures, Music, 

Downloads, the desktop 
and more – select the files, 
hold down [Shift] as you 
right-click one of your 
selections, and choose 
‘Send To’. Select the folder 
you need and the files are 
moved right away.

98resTore run
If you miss the 

Windows XP Run option, 
right-click ‘Start’, select 
‘Properties > Customise’, 
check the ‘Run Command’ 
box and click ‘OK’, and a 
Run option now appears on 
the Start menu.

99search 
file 

conTenTs 
If you occasionally 
need to search the 
contents of files 
that haven‘t been 
indexed, just start 
your search with 
content:  
So typing 
content:zebra 
locates files  

that have  
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and Windows makes  
a local copy available.

104search The 
web from 

your sTarT menu 
Run REGEDIT, browse to 
HKEY_CURRENT_USER\
Software\Policies\
Microsoft\Windows\
Explorer, create a DWORD 
value called AddSearch 
InternetLinkInStartMenu 
and set it to 1. Search your 
PC for something, and at 
the bottom of the Start 
menu you‘ll see Search the 
Internet. If search results are 
insufficient, click this and a 
browser window opens with 
results of a web search.
 

105copy files 
Select your files, 

click ‘Edit > Copy to Folder/
Move to Folder’, choose the 
destination folder and 
Windows moves them! 

106pasTe more 
accuraTely 

If you paste web page text 
into Word or Excel and find 
it‘s incorrectly formatted, 
paste it into Notepad first, 
then copy the Notepad 
text, and paste it into your 
app. Still problems? Check 
the Edit menu for an option 
such as Paste Special, and 
choose ‘Unicode’.

107don‘T miss a 
pop-up alerT! 

Windows displays warnings 
in the bottom-left of the 
screen. If you miss a few, 
click ‘Start’, type Ease, click 
‘Ease of Access Center’, 
select ‘Make it Easier to 
Focus on Tasks’, and change 
the ‘How long should 
Windows notification dialog 
boxes stay open’ figure.

108enjoy larger 
preViews 

Move your cursor over a 
Windows 7 Taskbar button 
and you see a tiny preview 
of the application window. 
To make this larger, launch 
REGEDIT, go to HKEY_
CURRENT_USER\Software\
Microsoft\Windows\

112To quickly open 
your user folder 

in Explorer, hold down 
the [Windows] key on 
your keyboard and press 
[R] to launch the Run box, 
type . and press [Enter].

113
Entering something 

else opens different 
folders. Launch the Run 
box, type .. and press 
[Enter] to launch the 
users folder, for instance.

114The Shell 
commands are 

also handy. To open your 
Startup folder, say, click 
‘Start’, type shell:startup 
and press [Return].

115When you want 
to search for 

something in an Explorer 
window, don‘t reach for 
the mouse. Just press [F3] 
– the cursor jumps 
straight to the search 

Time-saving 
explorer tips
Boost your file 
management productivity 
with these shortcuts

box, type your keyword 
and press [Return].

116And don‘t 
bother 

browsing for folders that 
you‘ve accessed recently.  
Press [F4] and you can 
probably choose them 
from the History list – 
much quicker.

117If an Explorer 
window seems 

to be missing a file, folder 
or drive, press [F5] to 
refresh the window  
and new information  
may appear.

118And if you‘re 
examining an 

enormous list of files and 
need all possible screen 
real estate, you can  
press [F11] to toggle 
full-screen view.

119It‘s easy to 
navigate your 

folder trees from the 
keyboard. Press [+] on  
the numeric keypad to 
expand the currently 
selected folder,  
for instance.

120Pressing [*] on 
the numeric 

keypad expands all 
folders below the current 
one, although be careful 
– this can take ages.

121And press [-] on 
the numeric 

keypad to collapse the 
current folder. n 

CurrentVersion\Explorer\
Taskband, right-click in the 
right-hand pane and create 
a new DWORD value called 
MinThumbSizePx. Double-
click this, choose ‘Decimal’, 
set it to 300 and reboot.

109enhance 
moViemaker

Windows Live MovieMaker 
doesn‘t enable you to 
import files on a network 
drive. So run REGEDIT, 
browse to HKEY_CURRENT_
USER\Software\Microsoft\
Windows Live\Movie 
Maker, add a DWORD value 
called Allow 
NetworkFiles 
and set it to 1.

110open 
files 

wiTh any 
app 
Click ‘Start’, 
type Default 
and click 
‘Default 
Programs’. 
Click 
‘Associate a 
file type of 
protocol with 
a program’. Scroll down 
until you find the file type 
you‘d like to modify. Click 
‘Change Program’, and 
choose the app you‘d like 
to open this sort of file.

111change your 
prinTer 

To have Windows switch 
your default printer as you 
change networks, click 
‘Start’, type Devices, and 
click ‘Devices and Printers’. 
Choose a printer and click 
‘Manage Default Printers’. 
Select ‘Change my default 
printer when I change 
networks’, choose a 
network, the default printer 
you‘d like, and click ‘Add’. 
Repeat for other networks, 
and pick a default printer. 
Now, when you connect to 
a network, Windows sets 
the printer you defined.

That‘s your 100 tips, plus 21 bonus tips! – you‘ll find lots 
more in the magazine, plus the extras on your disc!

PubLISH 
youR PICS
upload 
pictures 
directly  
to Flickr 
from your 
desktop
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This month, Nick Peers shows 
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with Media Browser Server, 
Christian explains how to 
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your PC, and Matt helps you 
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time to see how your PC can 
make your life easier than ever!
Nicholas Odantzis,  
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nick.odantzis@futurenet.com Turn to page 50 for more
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Your guide  
Christian Hall says…
“Still using a single PC 
screen? A dual-monitor 
setup can allow you to 
take your productivity 
even further, and 
UltraMon is the perfect 
tool to help.”

This issue’s free disc is packed 
with full software, essential 
toolkits, apps and resources  
to help you get the most  
from your computer.

Look out for the badge 
(below) pointing to key files  
for the article you’re reading.
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Learn how to…
Set up a digital 
media library

“Share music, video and photos 
across your home from your PC 
for free with Media Browser.”

ost of us have music, movies 
and photos stored on our 
PCs, but how can we access 

them from other computers, mobiles 
and smart devices without creating 
extra copies? The solution is to set up 
a media server, and Media Browser 
is the perfect tool for the task, 
particularly if you want to set up 
shared access with members of your 
family or housemates.

Media Browser organises your 
movies, TV shows, music and more 
into user-defined libraries, 
automatically downloading artwork 
and useful information such as 
episode synopses to help everyone 
easily browse and access what they 
want to watch. You can set up 
separate user accounts for each 
person in your house, and regulate 
access using parental controls and 
other restrictions. It all adds up to a 
win-win in the media-sharing stakes. 
Read on to find out how to set it up.

1 Install server
Install Media Browser Server from the cover disc. Wait while 

the installer verifies its requirements, then click ‘Run’ when you 
see the Application Run security warning dialog box. From here, 
Media Browser will download the latest version of its setup file 
and install it automatically. Once installation is complete, your 
browser will open to the Media Browser configuration wizard.

2 Create user
First, click the English (United States) drop-down menu and 

choose ‘English (United Kingdom)’ before clicking ‘Next’. Media 
Browser supports multiple user profiles, allowing friends and 
family members to access your media collection using their own 
settings (you can also configure parental controls). For now, verify 
that your first name is correct and click ‘Next’ again.

Step-by-step Set up and configure your server

Your guide Nick Peers says… BrowSe liBrarieS
Set up libraries and 
organise your media 
into them for quick 
and easy access via 
app or web browser. 

M
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKill leVel

Time TaKen

SuiTaBle for

45 minutes

meTadaTa 
manager
Click this link to view 
and edit all your TV, 
music and movie 
metadata, grouped 
by library and title. 
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3 Set up media library
You’ll now be prompted to select your first media folder. For 

Media Browser to work correctly, your media files must be named 
and organised correctly – click the ‘Refer to the media library wiki’ 
link for brief details. For a more extensive guide – including tips 
for renaming your files – go to www.techradar.com/1155622. 
Once your media is named correctly, click ‘Add media folder’.

4 Select first folder
Give your first folder a suitable name to reflect its content, 

such as ‘TV – Comedy’. Select the folder type from the drop-down 
menu and click ‘OK’. Click the ‘Media Locations’ button to select the 
folder on your hard drive containing the media in question. Click 
the arrow next to the drive letter to browse its contents. Click again 
to drill down until you open the target folder, then click ‘OK’.

Jargon buster!
 media server

The computer on 
which your media 
collection is stored 
and subsequently 
shared with other 
devices on your 
network or over the 
internet.

 metadata
Useful information 
attached to a media 
file, such as an 
episode synopsis, 
featured actors or 
the episode’s 
parental rating.

 windows Service
A computer program 
that works silently in 
the background, and 
can be configured to 
run automatically 
with Windows.

epiSode SynopSiS
Name your files 
correctly and Media 
Browser can 
automatically 
download all the 
information you 
need to identify 
each one. 

SelecT player
Choose another 
computer (or Media 
Browser Theater) as 
your default 
playback device 
when selecting 
content from the 
server. 

SwiTch uSerS
Media Browser is 
designed for a family 
or shared house 
– each person has 
their own preferences 
and level of access. 

daShBoard
Click this button to visit 
the Media Browser 
Server dashboard, 
where you can 
configure your libraries, 
user accounts and more. 

Nick’s best tiP!
Quickly rename media files using Filebot (www.filebot.net). Look out for a dedicated guide in an upcoming issue.

Explore 
Set up a digital media library
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9 Personal preferences
Click the person icon at the top of the screen and choose ‘My 

Preferences’. If you’ve set up multiple libraries for different types of 
content (such as comedy and drama TV), untick them under ‘My 
Views’ so they appear as separate categories. Use the ‘Web Client’ 
tab to customise how your personal homepage is displayed when 
accessing your media collection through a web browser.

7 Final steps
Leave the next three boxes ticked and click ‘Next’. Ignore the 

comment about windows Service – for the purposes of this 
tutorial we’re sticking with the desktop application. Click ‘Next’ 
then ‘Finish’. You’ll be taken to the main Media Browser dashboard 
– scroll down to the Running Tasks section to see a progress bar 
indicating how much of your media has been added to the library.

5  Create more libraries
You can add multiple folders to the same library if you wish 

– click the ‘Add media locations’ button to select them. You’ll also 
see buttons for editing your library; you can rename it, change its 
type and remove it completely. Once you’re happy with this 
media library, click ‘Add media folder’ to create another one 
following the same steps. When everything is in place, click ‘Next’.

10 Enjoy your media
With your server set up, click the ‘Home’ button in the top 

left-hand corner of the screen to browse your library through your 
web browser. From here you can play media through your web 
browser, or install Media Browser Theater (Windows 7 or later) 
from the cover disc if you prefer. You can also purchase apps for 
various mobile devices so you can watch your media on the go. ■

8  Configure users
Select ‘Users’ in the left-hand pane and click ‘Add User’ to set 

up more users. Unless they’re trusted, untick ‘Allow this user to 
manage the server’ before clicking ‘Save’. If the user is a child, click 
their username in the list and switch to ‘Library Access’. Choose 
which libraries they can view, and set parental ratings (including 
the blocking of material with no rating attached). Click ‘Save’.

6 Configure settings
You’ll be prompted about downloading artwork and 

metadata from the internet – leave this box ticked so Media 
Browser can display posters and episode information about your 
media collection when browsing. It’s up to you if you wish to save 
this into your media folders, but unless you plan to edit it, leave this 
option unticked. Set country to United Kingdom, then click ‘Next’.
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best photo 
editing apps

Get more from your Windows PC
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Learn how to…
Protect any folder  
on your PC

“Locking folders from being accessed on your own 
user account is not part of Windows by default. 
Folder Password Expert helps keep your data safe.”

older Password Expert is a 
program that allows you to 
protect folders against 

unwanted access. It can lock folders 
on an internal hard drive, flash drive, 
external USB drive and network drive. 
When folders are password protected 
and locked, their contents cannot be 
read, copied, modified or deleted. To 
access the locked folders, you must 
supply the correct password.

Folder Password Expert guarantees 
your privacy by making it impossible 
for anyone to access your data – even 
in Windows Safe Mode. If somebody 
logs on under your Windows account, 
they will not be able to access your 
data without that crucial password, 
which for added security is not stored 
anywhere in Windows. To download 
the program, go to www.folder-
password-expert.com and click ‘Try It 
Free’ in the top-left. Once installed, 
select ‘Run Trial Version’ to use the 
30-day trial ($39.95 thereafter).

1 Lock folders
On the Welcome screen, deselect ‘Show this screen each 

time Folder Password Expert starts’, otherwise you’ll be constantly 
reminded to upgrade. Click on ‘Next’. You’ll then need to choose a 
task (‘Lock folders’ or ‘Unlock folders’). Choose ‘Lock folders’ and 
click ‘Next’. On the next screen, click on ‘Add’ and browse to the 
folder or folders that you want to lock and click ‘OK’.

2 Enter password
Choose ‘Next’ and you will be asked to enter a password. 

You’ll notice that if you tick the option below the password fields, 
you can enter a password hint. When choosing a hint, ensure that 
only you will understand it. Click on ‘Next’ and you will be told 
that your folders have been locked. Click ‘Next’ again and you’ll 
see the ‘Select a Task to Perform’ screen again.

Your guide Christian Hall says…

F

CHristian’s best tip

secure folders larger than 

4Gb by formatting your drive 

in ntFs. Each file in the 

folder must be under 4Gb.

Step-by-step Lock and unlock folders in Folder Password Expert

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

10 minutes
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7 Secure a USB or network drive
As well as being able to secure folders found on any drive or 

partition on your PC, you can also secure folders on a network-
attached hard drive or one connected by USB. Simply navigate to 
the folder using Windows Explorer, right-click and choose to lock 
or unlock folders. Remember that any network-attached drive will 
need to be discoverable in Windows Explorer.

8 Trial version notes
To unlock the full version from the trial one, you’ll need to 

enter the code that you receive after purchase (there’s a ‘Paste 
from the Clipboard’ option) and then click ‘Next’. If you let the trial 
period expire without paying for the full version, the program will 
not be able to lock new folders; however, it will still be able to 
unlock protected folders on your computer. ■

5 Protect folders in Windows Explorer
You don’t have to open up the program first to use Folder 

Password Expert’s features. Right-click the folder in the right-hand 
pane of Windows Explorer and select ‘Lock folder’ from the 
pop-up menu. To complete the process, enter your chosen 
password. Unlocking the folder is also easy: double-click it in the 
right pane of Windows Explorer and enter the password.

3 Verify locked folder
Let’s test what happens when you lock a folder. Navigate to 

the folder in Windows Explorer and you will see that it now has a 
little red stop sign next to it, indicating it’s locked. Double-click 
the folder to open it. Folder Password Expert will be launched and 
you’ll need to enter your password for access. The password hint 
(if you provided one) can be acquired by clicking ‘Get a hint…’

6 Quick access
Folder Password Expert helpfully adds a context menu to 

the Start menu entry. An arrow points to the right showing your 
recent protected files. Here you can permanently pin folders to 
the Recent list, unlock them or remove them entirely. If you 
manually pin the Folder Password Expert start menu icon to the 
Taskbar you still get the Recent menu when you right-click.

4 Unlock folders
Open up Folder Password Expert again, but this time 

choose ‘Unlock folders’ and on the next screen select the folder 
from the list (if you have more than one locked folder) and click 
‘Next’. Tap in your password on the next screen. The next screen 
will say you can now open the folder normally. Remember to go 
back and lock it again if you want to keep it secure.

Explore 
Protect your folders
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Learn how to…
Improve your 
summer photos

“Want to touch up your holiday 
snaps? Use GIMP to transform 
them and make the sun shine.”

he summer is one of the 
times when you’re going 
to be using your camera 

the most. The beautiful weather, 
combined with exotic locations and 
plenty of time to soak in the sights is 
the perfect recipe for some amazing 
photographs. However, the nature 
of summer photography offers 
some challenges as well. If you’re 
on holiday you’re unlikely to bring 
equipment such as tripods and extra 
lenses that can help you compose 
a shot, and whipping out your 
camera to catch the perfect sunset 
or bird in flight could lead to some 
rushed photos. Strong sunlight can 
also lead to exposure problems. 

Thankfully, the days of returning 
from the photography shop or 
chemist only to be disappointed by 
your freshly developed holiday snaps 
are a thing of the past – with GIMP 
you can easily improve your digital 
photos thanks to this guide.

1 Save a backup
Before you get started, you’ll need to install GIMP from your 

free disc. Once that’s done, open the program and click on ‘File’ on 
the menu bar. Click ‘Open’ and then browse to where your photo 
is stored and double click it to open it. Now click ‘File > Save as’ to 
save a copy of your photo. You can now edit it without worrying 
about losing your original if something goes wrong. 

2 Straightening up
If you take a photo without a tripod, then you might notice 

that the resulting image isn’t completely straight. To check and 
adjust this, click on the ruler at the top of the photo and drag it 
down to a part of the image that you know should be horizontal 
(in our case, the actual horizon). If you want to straighten vertical 
elements, click the ruler on the left-hand side and drag it right.

Step-by-step Fix your summer photos

Your guide Matt Hanson says…

Improved colourS
Make the photo more 
vibrant by bringing out 
the colours. Make your 
friends jealous with 
some fake weather! 

Improved ShadowS
Make even shadows 
look impressive by 
tweaking the brightness 
and contrast settings. 
Honest, it really was 
this sunny! 

T
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKIll level

TIme TaKen

SuITable for

30 minutes
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3 Getting perspective
One of the ways to straighten your photo in GIMP is 

with the program’s built-in Perspective tool. To select this, press 
[Shift]+[P] on your keyboard. A grid will appear across your 
photo. You can then grab parts of your photo and drag them to 
align with the ruler markers from step 2. Once you’re done, click 
‘Transform’ and your photo will be rotated for you.

4 Rotating
Another way you can ensure your photo is correctly aligned 

is to use GIMP’s Rotate tool. To select this, press [Shift]+[R] on 
your keyboard. Again, a grid will appear helping you line up your 
photo. You can click and drag the photo to rotate it into the 
correct position, or use the slider and text boxes for more control. 
Once you’re satisfied, click ‘Rotate’ to apply. 

remove objecTS
Use the Clone tool to 
remove objects from the 
photograph. Unwanted 
nudists begone! vIrTual TrIpod

Use the Perspective or 
Rotate tool to straighten 
your photos. Nobody 
will ever know how 
many cocktails you had 
before taking the shot.

Matt’s best tip!
try selecting the sky, then 
using the tools in the Colors 
menu to turn an overcast day 
into a beautiful sunny one.

Explore 
Improve your summer photos
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9 Clone out those people
With the clone tool selected, hold the [Ctrl] key and click an 

empty part of the photo with the same background as the object 
you want to remove. In our example we’ve clicked an empty area 
of sand just to the right of the person we want to remove. Now 
let go of [Ctrl], then use your mouse to paint over the unwanted 
sunbather. The beach will be deserted in moments! 

7 Improve colours
Is the sky not quite blue enough, or are the trees not the 

vibrant green you remember them being? You can fix this by 
clicking ‘Colors’ and then selecting ‘Hue saturation’. Select the 
colour you want to enhance (such as blue if you want to give the 
sky a boost) then drag the ‘Saturation’ slider until you’re happy 
with the result, then click ‘OK’.

5  Crop the photograph
 If you used the Perspective or Rotate tools, you’ll see that 

the edges of your picture are now showing a gray chequerboard 
pattern. The Crop tool cuts out and keeps the parts of the photo 
you want – this is also useful to cut out unsightly parts of the 
photo, such as litter. Press [Shift]+[C], drag a box over the area 
you want to keep, then click or press [Enter].

10 Deepen shadows
To ensure shadows look their best, click ‘Colors > Curves’. 

You’ll see a graph with a diagonal line running from the bottom 
left to the top right. Click roughly two squares up from the 
bottom of the line and nudge it slowly upwards, brightening up 
the image. Then click two squares down from the top of the line 
and drag it downwards to improve contrast. 

8  Start removing objects
We want to give the illusion that we had the beach all to 

ourselves, so we’re going to the Clone tool to magically erase 
people strolling along on the sand. To do this, press [Z] to bring 
up the zoom tool. Click the photo to zoom in to the desired level. 
To zoom out, hold down [Ctrl] on the keyboard and click. Now 
press [C] to bring up the Clone tool.

6 Fix levels
If you took the picture on a particularly sunny day, the 

colours might appear washed out. Let’s fix that with ‘Colors > 
Levels’. Moving the arrows below the graph will help you balance 
the whites and blacks of the photo, giving it a more vibrant look. 
As you change the settings, the changes will be previewed to help 
you get a better idea. Click ‘OK’ when you’ve finished.
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15 Saving your work
By default, GIMP saves your file in XCF format. This is 

GIMP’s own proprietary file type, which keeps you layers and 
other settings. If you want to save your photo as a more widely 
compatible format, such as a JPG, click ‘File > Export as’. At the 
bottom of the window, click the ‘+’ symbol, select the file type you 
want to use, then click ‘Export’.

13 Free and automatic selection
If you need to select more complex shapes in your photo, 

you can use the third tool in the list, which is represented by a 
lasso icon. This lets you use the mouse (or a touchscreen and 
stylus for better control) to draw the shape that you want to 
select. Next to this is the Fuzzy Select tool, with the magic wand 
icon. Just click to select areas of a similar colour.

11  Fix exposure problems
If your holiday photo is over or under exposed, one of the 

quickest and easiest ways to correct the problem is to adjust 
the brightness and contrast levels of your photo. To do this, click 
‘Colors’ then ‘Brightness-Contrast’. You can now adjust both 
settings using the sliders. Carefully balancing the two can make 
your photos look much more vibrant.

16 Enjoy your work!
Congratulations, you’ve now improved your first summer 

photograph! The techniques you’ve learnt here can be used to 
touch up photographs taken not just in the summer, but all year 
round – with a little bit of tweaking. Compare your new photo 
with the original to see just how much of an improvement your 
tweaks and adjustments have made. ■

14  Intelligent edge selection
One of the most powerful selection tools is the scissor 

selector, also known as the Intelligent Edge tool, which helps to 
quickly select complex shapes such as trees and hair. Click the 
scissor icon, then click one end of the area you want to select. 
Next, click on another part of the photo, and you’ll notice that 
GIMP has cleverly selected the edges. 

12 Editing certain parts of a photo
So far, all the changes we’ve made affect the whole photo, 

but you can also use GIMP’s array of tools to select certain parts 
of the photo to edit independently. The first seven tools in the 
toolbox give you various options for selecting parts of your 
photos. The first two let you drag rectangle and ellipse shapes 
to quickly select a portion of the photo. 

Explore 
Improve your summer photos
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Learn how to…
Supercharge the  
Start menu

“In just a few minutes, you can customise the 
standard Windows 7 Start menu, making it quicker 
and easier to find your favourite programs.”

he Start menu in Windows 7 
is quite similar to the old one 
from Windows XP and Vista, 

but Microsoft made some subtle, yet 
significant improvements to make 
it even more useful. As before, it’s 
divided into three different areas. 
The first of these is the top section, 
where you can pin your favourite 
programs so they are always easy 
to access when you want them.

Below this – with a line separating 
it from the pinned programs area 
– you’ll find the recently-used 
programs list. To the right of this is 
the part of the menu that takes you 
to commonly-used folders and 
options, such as your Music library 
and the Control Panel.

As good as it is though, there’s 
still some room for improvement. 
In this eight-step guide, we’ll 
show you how to make the most 
of your menu by personalising it 
to suit your needs.

1 Pin your favourite programs
When you want to access your most commonly used 

programs, the best place to put them is in the Pinned Programs 
area at the top of the Start menu. To do this, right-click a program 
and select ‘Pin to Start menu’, or drag-and-drop it into position. 
If you want to remove a program from the Start menu, right-click 
again and select ‘Unpin from Start Menu’.

2 Streamline the menu
When you open a program, it’s automatically added to 

the list of recently-opened programs on the left. If you want to 
change the number of programs that appear here, right-click 
the Start button, select ‘Properties’ and under the ‘Start Menu’ tab, 
click on ‘Customise’. Enter the new figures in the box labelled to 
‘Number of recent programs to display’.

Your guide Nicholas Odantzis says…

T

Nicholas’s best tip!
the classic start menu no 
longer exists in Windows 7, 
but you can get it back with 
cSMenu (www.csmenu.com).

Step-by-step Fine-tune your Start menu

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

10 minutes
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7 Move the Start menu
The standard location of the Start menu is at the bottom-

left of the screen, but you can move it to the top or right of the 
screen if you prefer (if it’s blocking your desktop wallpaper, for 
example). Right-click the Taskbar, and make sure there is no tick 
next to ‘Lock the Taskbar’. Then left-click the Taskbar and drag it to 
another area of the screen to move it.

8 Make it work for you
All this should take around 10 minutes, and once you’re 

done, you should find that the Start menu is vastly improved 
over its standard configuration. You can access programs that 
you want to use more quickly, make your PC easier to control and 
change the look to suit your taste. A few minutes of work will save 
you hours in the long run if you use your PC regularly. ■

5 Get a new power button
When they want to turn off their Windows 7 computer, most 

people open the Start menu and click ‘Shut down’, but you can 
change what this button does if you don’t often shut down your 
PC fully. Right-click the ‘Start’ button, and under the ‘Start Menu’ 
tab click on the drop-down menu next to ‘Power-button action’ to 
change it to something else, such as Restart or Sleep. 

3 Open old files quickly
If you open the Start menu, you might notice that certain 

programs (including Microsoft Word and Excel) have an arrow 
next to them. When you click this, you’ll be presented with a Jump 
List, which shows you which files you’ve recently opened in that 
particular program. You can open them without having to spend 
time browsing through your Documents library. 

6 Change the links
On the right of the Start menu are links that take you to 

your most frequently used folders and libraries. You can remove 
any that you don’t want to appear by right-clicking the Start 
button, selecting ‘Properties’ and clicking on ‘Customise’. Select 
‘Don’t display this item’. If you want to create a menu within each 
link here, click ‘Display as a menu’. 

4 Change your picture
At the top of the Start menu is a small picture that 

represents your user account. If you fancy a change of scenery, 
click on ‘Control Panel > User Accounts and Family Safety > User 
Accounts’ and click on ‘Change your picture’. Choose a new image 
from the list, or click on ‘Browse for more pictures’ to use one of 
your own. Pictures should be 128x128 pixels in size. 
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Set up multiple user 
accounts for your family

Create a handy wireless 
network in minutes

Learn how to…
Set up multiple user 
accounts in Windows 7
Everyone should use multiple accounts for different users on their 
home computer, even if it’s just to prevent silly accidents

ome is where the heart  
is, as the saying goes. It’s 
also where your PC is. It’s a 

machine you may share with your 
husband or wife, and possibly your 
kids, if they’re old enough to use it. 

But the last thing you want is for 
them to be able to mess up the PC by 
deleting important files or changing 
settings, or to have to put up with 
your partner’s awful choice in 
desktop wallpaper when you’re 
trying to get some work done. 
Thankfully, with the easy process of 
setting up additional user accounts 
on a Windows 7 PC, you can keep all 
of your computing lives separate and 
ensure that your kids can’t uninstall 
any safeguards – such as Windows 
Live Family Safety – that you’ve put 
there to keep the family PC safe. 

Everyone should use multiple user 
accounts on their home machine, and 
you can get started in 10 minutes, so 
there’s no reason not to.

1 Control Panel
The tools we need to create new user accounts on our PC 

are tucked away in the Windows Control Panel. Begin by clicking 
the ‘Start’ orb on the left of your Taskbar, then click ‘Control Panel’, 
on the right-hand side. In the window that pops up, you should 
see the option ‘Add or remove user accounts’ listed under User 
Accounts and Family Safety. Left-click it.

2 A new account
You’ll see a screen that lists your current user accounts. If 

you’re like most people, these are your own account and a guest 
account, which is switched off. It theoretically allows people 
without accounts to use your PC without any risk of harming it, 
but it’s much more secure to leave it switched off. Left-click 
‘Create a new account’ to continue.

7 Parental controls
You should be back at the ‘Make Changes’ page at this point 

– if you’re not, double-click the account you want to tweak. The 
‘Set up Parental Controls’ link enables you to set up various 
restrictions on standard user accounts. Click it, then click on the 
account you want to change. You can set time limits for computer 
use, block certain applications and more – ideal for children.

5 Customising
Click the ‘Create Account’ button to finalise this new 

account. Now let’s give it a bit of personality. Double-click on  
the account and click ‘Change the Picture’ to choose from a vast 
selection of images to represent the account on the login screen. 
Click the one you want to use, then click the ‘Change Picture’ 
button at the bottom of the window to select it.

3 Pick a name
Now type the name of the new account in the box. This 

might be the name of the person who will use it, or anything you 
like – but bear in mind that this will be displayed on a login screen 
when you start up Windows, so keep it clean! Next you need to 
choose the type of account you wish to create, ‘Administrator’ or 
‘Standard’. But which to choose?

8 Switch and test
It’s time to test your new account. Click the ‘Start’ orb on the 

left-hand side of your Taskbar, then click the arrow to the right of 
‘Shut Down’. Choose ‘Switch User’ to go back to the Windows login 
screen, click your new account and then log in using the 
password you set. You’ll see a clean, unfettered desktop, 
indicating that your new account is now active. ■

6 Password protect
Click ‘Create a Password’ to begin the process of protecting 

your newly created account with, yes, a password. You don’t have 
to do this – you could keep your kid’s account password-free, for 
example – but it’s a good idea. Type the password in both of the 
boxes at the top, then a hint (don’t make it too easy to guess) in 
the bottom box. Now click ‘Create Password’.

4 To administrate?
If you want the user of the new account to be able to easily 

install and modify software, by all means make it an administrator 
account. Any other user, however, should definitely have a 
standard account. It’s actually more secure if you use a standard 
account day to day yourself, and save your administrator account 
for major changes.

Step-by-step Make a new account

TOP TIP!
If you choose ‘Log Out ’ rather 
than ‘Switch User ’ when 
changing accounts, your 
applications are closed.

Works with…
OS H

Essential 
guide

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Learn how to…

If you’re not connecting wirelessly, you’re 
missing out on a lot of networking flexibility!

3 What’s around? 
Left-click the stepped icon and you’ll see all the networks in the 

area. These might include those owned by your neighbours, because 
Wi-Fi signals readily travel through walls. You can check the signal 
strength and various other information about each network by 
hovering the mouse pointer over them.

4 Pick your network 
You need the log-in details of your desired network – its name, 

otherwise known as the SSID, and its password – before you can 
connect to it. That’s not something we can help you with, because it’s 
different for everyone. Click on the network name you want to 
connect to, then click the ‘Connect’ button. 

BREAK FREE If you ever want to 
disconnect from a network, click 
here. This can be handy if there  
are multiple networks close by and 
you want to make sure you’re 
connected to the right one.

SEE THE STRENGTH The green 
stepped icon displays the at-a-
glance strength of any networks in 
the vicinity. We can see here that the 
‘onion’ network is the strongest in 
our neighbourhood.HARDWARE SETTINGS From here 

you can change the settings for the 
physical  network adapter that is 
inside your PC. You can prevent or  
allow your machine’s visibility.

FIX PROBLEMS If you’re having 
network connection problems, then 
this is the place to go. You’re taken 
step by step through the things you 
need to fix.

EASY ACCESS Everything you  
need for your network can be found 
by clicking this icon, from new 
connections to the status of your 
current connection.

Get a wireless 
network

 Dongle
This is a colloquial term 
given to a small bit of 
hardware that extends  
your computer’s 
capabilities – a USB 
Wi-Fi module, for 
example, or an external 
sound card.
 

 Router
A router or access point 
is a piece of hardware 
that manages multiple 
connections on  
a network, and 
broadcasts and 
receives Wi-Fi signals. 
Your router might 
include a modem to 
connect to the internet, 
or it might connect to a 
separate cable modem.
 

 SSID
The Service Set 
Identifier is the name 
given to a wireless 
network. Each network 
in the vicinity needs a 
different SSID, or their 
signals will clash.

1 Plug it in 
This won’t be applicable if you have a relatively recent laptop, 

but you may need to plug in a wireless dongle before you’re able to 
pick up a Wi-Fi signal. Insert it into a USB port and Windows 
automatically sets it up. Wait for the appropriate message to pop up 
before continuing.

2 Check the status 
All being well, you’ll have a small icon similar to a set of steps in 

your Taskbar at the very bottom-right of the screen. Hover your 
mouse over this and you’ll see the current status of your wireless 
connection. If you’re currently disconnected, it has a yellow flash over 
the top of it, too.

i-Fi isn’t just the next 
generation of networking – it’s 
true digital freedom. Forget 

sitting next to your internet connection. 
If you can hook your laptop (or 
smartphone, or even desktop 
computer) up to a wireless network, 
you can wander about where you 
please and enjoy mobile access with no 
additional charges. Of course, you need 
to stay in range of your access point. 
Most have a realistic range of 50 feet or 
so, but if you can get access to the 
actual router hardware, and if it has 
external aerials, it’s worth pointing 
them in the direction you’re likely to be, 
so that you get a stronger signal. You’ll 
find a wireless network gives you so 
much more freedom, enabling you to 
use your PC wherever in your home is 
most convenient. Read on to connect 
wirelessly today! 

Essential 
guide

Step-by-step Get hooked up to Wi-Fi

WWorks with…
OS

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Jargon buster!

Every month in Windows 7 Help & Advice we include all the best 
tutorials to help you do more with your Windows PC, whether 
you’re a beginner or you’re looking for more advanced help. For 

those of you who are new to the magazine, and – possibly – new to 
Windows, we want to make sure you’re able to learn the basics of what 
your machine can do. In each issue, we are now going to include eight 
of the handiest tutorials to get you started, all of which can be found  
on the cover disc in PDF format. Just load the disc and enjoy!

Our new range of tutorials shows you 
how to get to grips with Windows

Master 
the basics

Everyone should use multiple accounts for different 
users on their home computer, even if it’s just to 
prevent silly accidents, such as children disabling 
programs that they’re not supposed to.

If you’re not connecting to the internet wirelessly, 
you’re missing out on the freedom that it offers. 
Speeds are good, too – most modern routers are 
fast enough to rival an Ethernet connection.

Learn how to…
get the guides here

You can find all the 
tutorials in PDF format 
by either tapping here 

or using this link 
http://bit.ly/OQNy4r
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Back up your files in case 
the worst happens

Transfer all your old files  
to a new computer

Manage all your emails 
using Windows Mail

Create the perfect desktop 
environment for your PC

Learn how to…
Back up your files in case 
the worst happens
Would you want to lose everything if your computer went kaput? Of course not, 
so it pays to create a backup of your PC – here’s how to do it

hen you buy a new PC 
or build your own, you 
should make it a priority 

to back everything up. If you don’t 
and something goes wrong, you 
could lose everything on it. 

Creating a backup doesn’t 
require any specialist knowledge, 
and takes the same amount of 
time as it does to watch an 
episode of Coronation Street. The 
initial backup takes a little while 
to complete, but subsequent 
backups don’t take anywhere near 
as long, because you’re only 
making copies of files you’ve 
recently changed or added. 

To make a backup, you need 
something to save your files on. 
Most people use an external 
hard drive because they’re 
cheap, have a very large 
storage capacity, and you can 
plug them in with a USB cable 
and use them immediately. 

1 Choose a drive
To start backing up files from your PC, plug in your external 

hard drive and click ‘Start > Control Panel > System and security > 
Backup and restore’. Now click on ‘Set up backup’ and select your 
external hard drive from the list of possible destinations. Before 
you proceed, make sure that the external hard drive is bigger than 
the internal drive you’re backing up. 

2 Different location
If you have more than one PC, you might prefer to back up 

to a network drive. The benefit of this is that all the PCs on your 
network can access it, so you don’t need an external hard drive 
for each one. To save files to a network drive, click on ‘Save on a 
network’. Enter the location of the network (browse for it on your 
PC), then enter the username and password.

Create a backup right now

7 Resurrect your PC
If something goes wrong and you want to restore your PC 

using your backup, go to the Backup and Restore Center and click 
on ‘Restore my files’. If there’s a serious problem and you can’t 
even access Windows, press [F8] on your keyboard before the 
Windows logo shows during startup, insert your Windows 7 CD 
and choose ‘Repair your computer’. 

5 Make an image
Keep the ‘Include a system image of drives’ 

tick box checked if you want to be able to easily 
restore your PC if something goes wrong, then click 
‘Next’ and confirm that you’re backing up the right 
folders. If you want to change how often you back 
up your PC, click on ‘Change schedule’. 

3 Back up everything
Select what you want to back up. The easy 

option is ‘Let Windows choose’. This backs up most 
of your files and folders, except ones that aren’t 
needed, or can’t be backed up. It also creates a 
system image, like a mirror of your PC, so if there’s 
a problem with your PC, you can easily restore it.

8 Breathe a sigh of relief
You should now be feeling much more confident, because 

your PC is a lot safer. You’ve created a backup of your PC on an 
external hard drive or network drive, and you can restore it to its 
old settings if anything gets wiped accidentally. You can even get 
everything back if you have a more serious problem that prevents 
you loading Windows. ■

6 Change schedule
By default, backups 

are made once a week, but 
if you use your PC a lot, it 
might be a good idea to 
increase the frequency of 
backups. On the other 
hand, if you don’t use your 
PC much – perhaps only a 
few times a week – you can 
reduce how often you 
perform a backup. The best 
time to make a backup is 
when you’re not likely to be 
using your computer, such 
as overnight or when you’re 
at work. This is especially 
true if you have a lot of  
files to back up. Use the 
drop-down menus to 
change the schedule. Click 
on ‘OK’ and your computer 
begins making a backup.

4 Pick and choose
If you only want to select a few folders to back 

up, rather than most of what’s on your PC, select the 
‘Let me choose’ option from the list. This also gives 
you the opportunity to change when you perform a 
backup. Click on ‘Next’ and select the folders that 
you would like to include in your backup. 

Jargon buster!
 Network 

Two or more PCs 
linked together using 
Ethernet cables or a 
wireless connection 
so they can 
communicate with 
each other and share 
files, printers and an 
internet connection.
 

 USB
Short for Universal 
Serial Bus, USB is the 
de facto standard for 
connecting things to 
your PC. 

FIND THE SOLUTION! Save hard drive space 
Go to the Backup and Restore Center, click ‘Manage space > 
View backups’ and delete all but the most recent backup.

Works with…
OS W

Essential 
guide

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Step-by-step Create a backup right now

1  Find it 
To start transferring files from one Windows 7 computer to 

another, type Windows Easy Transfer into Start Search and hit 
[Return] to open it. The process for Windows 8 is almost identical. If 
you’re transferring from a Windows Vista or Windows XP computer, 
you need to download and install it from http://tinyurl.com/n8ge3b.

7  Transfer it 
Once the file is saved, click ‘Next’, then ‘Next’ again, then ‘Close’. 

Now turn on your new PC, plug in the external hard drive you copied 
the Windows Easy Transfer file to, browse to it and double-click it. 
When prompted, enter the password and on the next screen click 
‘Transfer’. Your old items are transferred over.

5  Select less 
If you’d like to customise which files or settings Windows 

transfers, click on ‘Customize’ underneath your computer’s name, and 
select or deselect folders you’d like to copy. To delve even deeper and 
further customise what you transfer, click on ‘Customize > Advanced’, 
select more folders and then click ‘Save’.

3  Which PC? 
First of all, you’re going to transfer files over from your old 

computer, so you need to select ‘This is my old computer’ from the 
two options that appear. Windows now takes a good look through 
your hard drive to see what sort of items you can transfer to your new 
Windows computer. 

2 Choose how to transfer 
Once you’ve opened Windows Easy Transfer, click on the ‘Next’ 

button in the box that opens. The following screen asks you how you 
want to transfer items to your new PC. If you’ve got an Easy Transfer 
cable, choose this option – if not, opt to use an external hard disk or 
USB flash drive, or transfer via a network.

8 Moving stuff 
You now have a new PC that looks like your old one, and all 

your files have been transferred to the hard drive, so there’s little left 
to do except install old programs. Click ‘See a list of programs you 
might want to install’ for a report of which apps you should install, 
based on what you were using on your old computer. n 

6  Protect and save 
All your files and settings are saved in one file, which you can 

password-protect. This prevents anyone tampering with it before it’s 
moved. Next choose where to save the file – we saved it to a portable 
external drive. Saving can take a while depending on how big the file 
is, so do something else while you wait.

4  Select what to transfer 
If you’re happy with everything Windows has found on your 

computer to transfer, click on ‘Next’. Windows Easy Transfer tells you 
how big the files you’re transferring are in the bottom right-hand 
side, so check there’s enough space on your external drive if that’s 
how you’re going to transfer them.

Learn how to…
Transfer files to  
your new computer
Save heaps of time when moving files from an old computer to a new 
one – just use Windows Easy Transfer. It’s easy, and we’ll show you how!

eople often make life more 
difficult for themselves than 
they need to. They buy a new 

computer, and then spend hours 
needlessly copying files across from 
their old PC, folder by folder, tweaking 
the desktop so that it looks the same as 
it used to, and adding all their shortcuts 
to the menus. 

Sometimes, you’ve just got to step in 
and lend a hand, and we’ve 
recommended to many a friend that 
they do the job with Windows Easy 
Transfer instead. It helps to migrate files 
and settings, such as photos, contacts 
or favourites, from one PC to a new one 
– so everything is ready to use just like 
before. Windows Easy Transfer is 
pre-installed in Windows 7 and 8. If 
you’ve got Windows Vista or Windows 
XP, though, don’t worry because you 
can download and install it for free. 

Works with…
OS P

Essential 
guide

Step-by-step Transfer data from one PC to another

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

FIND THE SOLUTION! Some installation required
Using Easy Transfer copies all your old program settings to your 
new computer, but you still need to install the old programs.

1 Download and install Windows Mail
Windows Mail is a free Microsoft email program. Download 

it from http://download.live.com/wlmail. Click ‘Download’ and 
when the File Download – Security Warning box opens, click ‘Run’. 
Follow the instructions and click ‘Install’. For a faster install, make 
sure only Windows Mail is checked.

2 Run Windows Mail
Recently installed programs are highlighted in your Start 

menu. Click ‘Start’ and type mail into the search box. When you 
run Windows Mail for the first time, you are asked to add an email 
account. If you’re not asked for one, click ‘Add email account’ 
under Quick Views.

7 Send emails from your accounts
You can start writing emails by clicking ‘New’. Click the 

address book icon to add your contacts, or type the recipient’s 
name into the ‘To’ field. You can add pictures and stationery to 
your emails and you can select which webmail account you send 
the email from if you have added more than one.

5 Import your Windows Hotmail address book
You can also import your address book from your webmail, 

so you can quickly send emails to friends and families. If your 
webmail is Hotmail, all you need to do is click ‘Sign in’ to access 
your contacts. When you create a new email, you can select your 
contacts from a list.

3 Add your webmail account
After clicking ‘Add email account’ you’ll be taken through 

a wizard that can help you add and configure your webmail 
account in Windows Mail. Enter in your email address and the 
password you use to log into your webmail account into the 
relevant text boxes.

8 You’re all done!
There you have it. You’ve imported your webmail account 

into Windows Mail. You can send and receive emails as before – 
but with the added benefit of using Windows Mail’s advanced 
tools to sort and store your emails. And don’t worry – your emails 
are still online for you to access anywhere. ■

6 Import a different address book 
To import an address book from a different webmail, view 

your contacts on your webmail’s site and click ‘Tools > Export’. 
Save as a Comma Separated Value (CSV) file, then in Windows Mail 
click ‘Contacts’ and press [Alt]+[M]. Select ‘Import > Comma-
separated values (CSV)’. Select the file you downloaded.

4 View your emails
Once you have added all the information and clicked ‘Next’, 

your emails are downloaded into Windows Mail. Depending on 
how many you have, this might take a while. Once completed you 
can view your emails, place them in folders, designate them as 
junk mail or add the sender to your contacts list.

ebmail accounts can be very 
useful for allowing access to 
your emails away from 

home. With them you’re able to read 
and send emails from anywhere in 
the world – all you need to do is log 
on to the webmail service’s website 
to view your inbox. This is useful 
when you’re travelling, but when you 
are at home you can also import your 
webmail account into Windows Mail, 
enabling you to use all of the great 
features of Windows Mail with your 
webmail account. 

You can get visual indications 
when you receive new emails – 
something you can’t get with normal 
webmail accounts. Even better, if 
you have a number of webmail 
accounts, you can access them all 
straight away without having to log 
on to each website. Just enter your 
password once, and get all your 
emails in one place.

WWorks with…
OS

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Learn how to…
Access webmail 
through Windows Mail
Import your webmail account into Windows Mail and access all your emails 
straight from your PC – no more messing with multiple mail accounts.

Step-by-step Import your webmail accounts into Windows Mail

Essential 
guide

Learn how to…
Create the  
perfect desktop
Bored of the wallpapers and screensaver that came with your computer? I’ll show 
you how to tweak your Windows theme until it’s just the way you want it.

f you’re still staring at  
that peaceful Windows 7 
goldfish, chances are you 

think it’s time for a change on 
your computer. It’s incredibly easy 
to replace your desktop wallpaper 
with a favourite family photo or 
film poster, and you can even set 
the computer to cycle through a 
selection of your best shots if you 
can’t make  
up your mind which one you 
want. Personalising your 
computer needn’t stop there, 
though. With Windows desktop 
themes, you can tweak  
every aspect of your computer’s 
appearance, from the screensaver 
to the exact amount of 
transparency in your windows 
borders. It’s really simple to 
create the computer 
appearance of your dreams – 
just pick your pictures and follow 
the steps below.

1 Get personal
Right-click on your desktop and select Personalize to open 

the applet. If you’ve previously made changes to your theme, 
you’ll see these at the top under My Themes. To start from scratch 
with today’s changes, select one of the pre-installed Windows 
themes underneath, and start to tweak.

2 Picture perfect
Select the theme you want to personalise, then click on 

Desktop Background. You’ll see a selection of images – probably 
the standard Windows backgrounds. To make your wallpaper 
more personal, click on the drop-down menu by Picture location 
and select ‘Pictures Library’. You now see all your own images.

Create a backup right now

7 Hear the noise
One final change you may want to make is to your theme’s 

sounds – though we recommend turning them off. It can be fun 
to choose a different noise for everything your computer does, 
but it gets annoying. Click on ‘Sounds’, and you can select any 
computer event, then choose a sound file to go with it. Click ‘OK’.

5 The perfect mix
Click on ‘Window color’ to choose the colour 

of window borders, as well as the Start menu and 
Taskbar. Pick from the colours available, or click 
‘Show color mixer’ to create a shade. You can also 
enable the transparent borders that give Windows 
Aero its stylish look (but can slow down your PC). 

3 More or less
If you just want one main image to be your 

wallpaper, select it now and click ‘Save changes’. 
However, you can also select more than one image 
using the [Shift] or [Ctrl] keys, which creates a 
slideshow on your desktop, cycling through your 
favourite shots. 

8 The personal touch
Your theme should now be much more to your tastes, 

showcasing your favourite photos, colours and images. For more 
ideas, click ‘Get more themes online’ in My Themes for a huge 
range of pre-packaged themes, including ones created around 
recent films, that can all be tweaked to your tastes. ■

6 Screen select
To pick a screensaver, 

click the link at the bottom, 
then select a screensaver 
from the list. Some are  
just repeating moving 
images, such as Ribbons, 
but others, such as 3D  
text, can be customised  
by clicking on ‘Settings’. 
Click ‘Windows Live Photo 
Gallery’, then click ‘Settings’ 
to choose which photos to 
cycle through – you can 
choose specific folders, tags 
or ratings, plus speed and 
whether the images are 
shuffled. Specify how long 
you want your PC  
to wait before activating 
the screensaver.

4 Shuffle your shots
If you’ve selected more than one picture, you 

can adjust the drop-down menu at the bottom of 
the screen, to choose how long each image remains 
on your desktop. You can also tick the box next to 
this menu to shuffle your images, showing them in 
a random order. Once done, click ‘Save changes’.

Jargon buster!
 Windows Aero 

The fantastic look of 
Windows Vista and 
Windows 7. The 
transparent windows 
look great and are 
handy for seeing 
what’s behind them.
 

 Windows Live 
Photo Gallery
A free program  
from Microsoft  
that enables you to 
organise, edit and 
share photos. It’s on 
on your free disc.

Works with…
OS I

Essential 
guide

     Windows 8
     Windows 7
     Windows Vista
     Windows XP

Step-by-step Personalise your desktop

FIND THE SOLUTION! Dream themes
You can save as many different themes as you like – try a family 
photos one, or one based around your favourite artist.

Would you want to lose everything on your 
computer if your drive went kaput? Of course you 
wouldn’t, so it pays to create a backup of your PC 
in case anything bad happens. We show you how.

Save heaps of time when moving files from an old 
computer to a new one – just use Windows Easy 
Transfer. It’s simple, and we’ll show you how to get 
your new machine ready to use in minutes.

Import your webmail into Windows Mail and you 
will be able to access all of your emails straight 
from your computer – no more messing about 
with multiple email accounts. What a time-saver!

Bored of the wallpapers and screensavers that 
came with your computer? We are going to show 
you how you can tweak the Windows theme until 
you’ve got it precisely to your liking.
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Discover practical and creative ways 

Learn everything 
there is to know 
about the biggest 
social network on the 
planet! Stay safe, play 
games with friends 
and make Facebook 
the best place to 
hang out.

Welcome to the 
complete guide to 
Libre Office – the free 
alternative to MS 
Office. We’ll show you 
how to make docs, 
spreadsheets and 
more. Comes with 
Libre Office too!

Libre Office: The  
Complete Guide

Organise a year’s 
worth of Windows 7: 
Help & Advice with 
this stylish binder. No 
more torn corners or 
folded pages – store 
all your issues neatly 
on a bookcase.

Keep your magazines  
looking neat and tidy!

http://bit.ly/17GayFS

www.myfavouritemagazines.co.uk

Only 
£9.99!

Interact with the high-resolution magazine on your 
computer, laptop, tablet PC or smartphone
•  Download the day it goes on sale
• Read it in page-swiping glory
• Pay just £19.99 for 13 issues

Get the Windows 7 Help & 
Advice digital edition today!

http://gb.zinio.com & http://itunes.apple.com 

Save!  
13 issues  

just 
£19.99!

Only 
£9.99!

Only 
£9.99!

Facebook: Your complete
guide 2014

www.myfavouritemagazines.co.uk
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Make sure you don’t 
miss any issues of  
the only Windows mag 
to help you get the 
most from your PC.
•  Every issue delivered 

straight to your door
•  Just £26.99 every  

six months

31% off! 
Subscribe 

today  

to use your PC

Learn more with  
a mouse click…

www.myfavouritemagazines.co.uk/WOMP2S

Get acquainted with 
the new update to 
Microsoft’s great 
operating system: 
Windows 8.1. Learn 
the basics, discover 
hidden secrets and 
find out how to get 
more out of your PC.

Windows 8.1: The 
Complete Guide

Subscribe to Windows 7 
Help & Advice

www.myfavouritemagazines.co.uk

www.myfavouritemagazines.co.uk

Sell it  
Online!
Turn your creative 
hobby into a career 
with the ultimate 
guide to starting a 
home craft business. 
Packed with all the 
practical skills and 
advice you need to 
start selling today!

Only 
£9.99!

Only 
£12.99!



Learn how to…
Remotely 
access a PC

“Giving technical advice to family 
and friends over the phone isn’t 
easy, but Soluto can help.”

etting a phone call from my 
mum isn’t unusual, but to 
get a call asking me to help 

her fix her laptop was a bolt out of 
the blue. The surprise wasn’t that 
she asked me, it was that I thought 
she never used her computer! I was 
wrong, but what she clearly hadn’t 
ever done was take the time to give 
her laptop a bit of TLC. 

Her problem was that her PC was 
running really slowly and she was 
getting a message that 4oD couldn’t 
complete its download. Instantly 
I knew her hard drive was full, but 
I wondered if it had a partition. 
Unfortunately, as soon as I started to 
ask her questions it was apparent that 
I was talking in another language. 
What I needed was a program that 
would give me access to my mum’s 
laptop so I could fix the problem. 
It would also need to be something 
that she could use. The answer was 
a web-based service called Soluto.

1 Log in
The first step is to go to www.soluto.com/trial-register. 

You’ll need to sign up before you can use the service. If you have a  
Windows Live or Google account, you can sign in using the same 
details and start using it instantly. If not, you can sign up using 
your email address instead. You’ll need to activate your account 
by following the instructions received in the email.

2 Installation
The next step is to download and install the software to 

your PC. You can have up to five PCs listed here. Should you wish 
to have more you can contact Soluto who may be able to help 
you. It’s also handy to name the PC, especially if you have multiple 
computers. Now click ‘Download to this PC’. Soluto will take a few 
minutes to download and install.

Step-by-step Help others with their PC

Your guide Simon Arblaster says…

Main SCReen
This button takes you 
back to the home 
screen where you can 
access other computers 
onto which you have 
downloaded Soluto. 

FRuStRation level
This level shows you 
how many problems you 
may or may not have 
had with your computer. 
Go to the ‘Frustrations’ 
menu tab for a more 
detailed outline. 

Menu
These quick menu items 
allow you to jump to 
each of Soluto’s sections 
quickly without having 
to scroll up and down 
the window. 

G
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKill level

tiMe taKen

Suitable FoR

20 minutes
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3 Overview
Soluto’s interface is very simple and will be the same across 

any other computer you use. Each machine is divided up into six 
main areas. These include tools to help you delay programs that 
start when you turn on your PC and find out of date programs 
and any potential problems with your machine. On top of this you 
get an overview of your PC’s performance in a handy timeline.

4 Help someone
To start helping a friend or relative, go back to your 

account’s main page by clicking on the Soluto logo at the  
top of the page. Below the area that shows you a list of your 
computers, you’ll see a ‘People I help’ window. Click on the  
‘Add someone’ button on the right-hand side and enter their 
email address into the field provided.

Jargon buster!
 Defragmented

Files on your hard 
drive become 
fragmented  
when moved,  
or programs are 
installed/removed. 
Defragmenting the 
drive puts the pieces 
back together, 
making it easier  
to read them.

 Junk mail
Emails from 
untrusted sources, 
especially from 
non-contacts, can 
end up in your junk 
email folder. Be sure 
to check it regularly 
just in case. 

SySteM oveRview
This section gives you 
an overview of the PC in 
question, showing you 
basic information and 
giving you the option 
to jump straight to a  
specific area. 

SIMON’S beSt tip!
When doing maintenance on 
another person’s pC, make 
sure it ’s switched on and 
they’re not using it.

Explore 
Remotely access a PC
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9 The right time
The process may not start right away. This could be for a 

number of reasons such as the recipient’s PC might be switched 
off or on standby. Another problem that can make your computer 
sluggish is the amount of applications that are running in the 
background. With Soluto you can pause or even delay a program 
that usually starts with Windows.

7 Find the problem
Once the program has installed on their computer, it will 

show up in your account. If you’re thinking about helping out 
more than one person then it would be wise to rename it just  
to make things clear. Click on the icon in the ‘People I help’ 
window to view the other person’s PC. Any potential problems  
are outlined underneath their description.

5  Personal message
Click the ‘Add this person’ button. This will bring up a small 

window with a short message addressed to the person whose PC 
you want to access. You can edit the message should you wish to 
make it more personal, which may be a good idea just in case 
they mistake it for junk mail. Details are given within the email  
on what the recipient should do next.

10 Reciprocate
Well done! You’ve completed a thorough clean-up of your 

friend’s PC. The good news is, they can return the favour should 
you ever need help solving an issue with your computer. Once a 
connection has been made between two people they can each 
look after the other’s machine. If you wish to spread the word 
then do so by sharing on Facebook or sending an email. ■

8  Not enough space
 Clicking on the warning will take you to the relevant menu 

– in this case, Hardware. As the problem is a lack of free space on 
the primary hard drive, expand the ‘Hard drives’ option. Here I can 
see the problem isn’t just a space shortage – the disk needs to be 
defragmented. Clicking ‘Clear space…’ will show a breakdown of 
all the unneeded files. To start the cleaning process hit ‘Clear’.

6 Verification
Once your friend or family member has received the email 

and followed the instructions, they will be asked to download the 
software. It’s recommended they contact you to verify that you 
are who you say you are, so expect an email or a phone call. This  
is the same program as installed in step 2, so there will be a short 
wait while the file is downloaded and installed.
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Learn how to…

wning a computer is no 
longer considered a luxury. 
In fact, many people – or 

households, at least – have more  
than one machine at their disposal. 
If you’re one of those people who 
often find themselves working with 
multiple computers – perhaps a 
desktop PC and a laptop, for example, 
or a couple of desktops in different 
rooms of the house – you will be 
only too aware of the problem of 
ensuring that you have access to all 
the important files you need on the 
computer you are using.

This is where Microsoft’s OneDrive 
cloud storage service is hugely 
helpful. It makes it possible to 
synchronise files between computers, 
and it even gives you the option 
of accessing them online. It’s an 
amazing way to ensure that you can 
always work on your files no matter 
which computer you end up using. 
Read on to find out how.

1 Download OneDrive
If you are using Windows 7, you need to install a copy of 

OneDrive on your PC. Go to https://onedrive.live.com/about. Click 
in ‘Download’ in the top menu, then scroll down and click on 
‘Download OneDrive for Windows’ underneath Windows Vista, 7 
or 8. Click on ‘Save’ (if using Internet Explorer) and run the 
OneDriveSetup file once it’s downloaded.

2 Install and get started
Click ‘Yes’ if a User Account Control dialog appears and wait 

while the installation runs its course. Once this is complete, an 
introductory screen is displayed – click ‘Get started’ to continue. 
In order for your files can be synchronised, you need to sign into 
your Microsoft account, so enter your email address and password 
before clicking the ‘Sign in’ button.

O

Nicholas’s best tip
if you have to use a computer 
that does not allow software 
installation, access your files 
through OneDrive’s website.

Step-by-step Synchronise files with OneDrive

“If you often need to jump from one computer to another, but don’t 
want to deal with the hassle of using a USB drive, OneDrive is a great 
way to access the files you need on any PC.”

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

15 minutes

Your guide Nicholas Odantzis says…

Keep your files in 
sync with oneDrive
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7 OneDrive in Windows 8.1
If you have upgraded your computer to Windows 8.1, you 

will find that OneDrive is now built-in as standard – there is no 
need to install it separately. As well as integrating with Explorer 
just as in Windows 7, there is also a dedicated Windows 8 app that 
provides an extra means to access your files, but everything works 
in much the same way.

5 Synchronising files
The beauty of OneDrive is that you really don’t have to do 

anything. When you save a file that you want to access on other 
computers, just make sure you save it to your OneDrive folder. You 
will need to install the OneDrive software on other computers you 
use. You can tell that your files are synced by the appearance of a 
green tick on folder icons.

3 Configure your folder
Although Microsoft OneDrive stores your files online for 

easy access, they still need to be kept on your hard drive so you 
have a local copy. By default, a folder is created for this purpose in 
your user folder, but you can click the ‘Change’ button to choose 
a different location. When you are happy with the folder that’s 
being used, click ‘Next’.

8 Enjoy easy access!
That’s all there is to it! Providing you remember to save  

your files into the OneDrive folder, you need never think about 
moving files from one computer to another – it is all taken care of 
for you! Some people worry that talk of working ‘in the cloud’ is 
complicated, but it makes everything so much easier when you 
move between PCs. Give it a try for yourself and find out. ■

6 Access on the web
As you save files to your OneDrive folder on your computer, 

they are automatically uploaded to the OneDrive website. You can 
view them online at https://onedrive.live.com, where you can also 
keep an eye on the amount of online storage space that’s 
available to you. These files are downloaded automatically to  
any other computer with the OneDrive application installed.

4 Set sync options
The OneDrive folder includes sub-folders for pictures, 

documents and shared files, all of which are synchronised by 
default. If you are happy with this, click ‘Next’. Alternatively, select 
‘Choose folders to sync’ and tick the boxes next to the folders to 
synchronise. Leave the box labelled ‘Let me use OneDrive to fetch 
any of my files on this PC’ ticked and click ‘Done’.

Explore 
Keep your files in sync
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Learn how to…

“Still using a single PC screen? A dual monitor setup 
can allow you to take your productivity even further, 
and UltraMon is the perfect tool to help.”

odern computing is all about 
multitasking. Do you use 
email, a web browser, Office 

and Twitter simultaneously? There’s no 
better way to see lots of data at the 
same time than with two – or even 
three – separate monitors.

Having an extra monitor extends the 
scope of a single program. With email, 
for example, you can have your email 
client on one monitor and your 
browser in the other. If you have a web 
link in a message, just drag it onto the 
other monitor and into the browser. 

Most PCs have video adaptors built 
into the motherboard, or have a 
separate graphics card with dual ports 
(HDMI, DVI or old-fashioned VGA). 
Turn off your PC, connect the monitor 
cable and boot up. Windows will spot 
the second monitor and a multiple 
displays drop-down list will appear. 
Windows doesn’t offer many options, 
but the UltraMon software provides 
extra versatility. Let’s get started.

1 Set up screens
Windows should automatically detect each monitor. If not, 

right-click the desktop and click ‘Screen Resolution’, then ‘Detect’. 
Under the ‘Multiple displays’ drop-down list you can choose to 
‘Extend your displays’, ‘Duplicate your displays’ or ‘Show desktop on…’ 
The latter is commonly used with a laptop if you want to keep your 
laptop screen blank after you’ve connected to a desktop monitor.

2 Install UltraMon
After downloading UltraMon from www.realtimesoft.com/

ultramon, run the free installer. You don’t need to enter the 
registration information during the 30-day free trial, so just leave 
it all blank and click ‘Next’. On the Customize Installation screen 
you can choose to install some of the key features in a different 
location (or not to install them at all). Click ‘Next’.

Your guide Christian Hall says…

M

Step-by-step Make more of dual monitors with UltraMon

Make the most of 
your dual monitors

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

20 minutes

CHristian’s best tip
Hotkeys are available to make 
it even faster to use. Define 
your hotkeys by going to 
‘Options > Hotkeys’.
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7 Make shortcuts
You can create shortcuts that open programs on a particular 

monitor or at a specific position. You can access shortcuts from 
UltraMon’s menu, or save them as Windows shortcuts and access 
them from the desktop or Start menu. On the context menu, click 
‘Shortcuts > New Shortcut’. On the new window, find the 
application and hit ‘Next’. Pick a monitor and click ‘Next’ to finish.

5 Get smart
UltraMon’s Smart Taskbar includes additional 

Taskbars for other monitors. Right-click the UltraMon 
Taskbar icon and choose ‘Smart Taskbar > Enable’. Go 
to ‘Options’ to choose between two modes. In 
‘Standard’, each Taskbar only shows apps from the 
monitor it is on. In ‘Mirror’, each Taskbar shows all tasks.

3 Access UltraMon in Taskbar
All of UltraMon’s action takes place in the 

system tray’s ‘Show hidden icons’ area. Click the 
arrow on the Taskbar, then right-click on the 
UltraMon icon to see all your options. From here, 
you can manage your monitors without ever having 
to go into the Windows Control Panel.

8 Display profiles
Display profiles make it easy to switch between desktop 

configurations. A profile stores the display mode and state of each 
monitor, as well as which monitor is the primary one. You can use 
display profiles as you do with Windows User Accounts. From the 
right-click menu, choose ‘Display Profiles > New Display Profile’. Click 
‘Next’ and you will be able to name your profile and select options.

6 Taskbar settings
Right-click Windows Taskbar to adjust Taskbar 

settings. You can add toolbars, such as True Launch Bar. 
Visit www.truelaunchbar.com to download and install. 
On your second monitor, right-click the Windows 
Taskbar and go to ‘Toolbars > True Launch Bar’ to add 
it. Keep the standard Taskbar on the first monitor.

4 Manage your windows
To move windows in UltraMon, click in the 

top-right of any window. UltraMon allows you to use 
the mouse to move maximised windows – just drag 
the title bar. As soon as you do this, the mouse pointer 
changes to the move cursor. The window is moved to 
the monitor on which you release the mouse.

Jargon buster!
 HDMI

High-Definition 
Multimedia Interface 
(HDMI) is used as an 
option in the very 
latest HD monitors. 
HDMI has become 
standard as the 
analogue cable 
replacement.

 DVI
Digital Visual 
Interface (DVI) is the 
industry standard for 
digital connection in 
computer monitors  
that don’t have 
HDMI output. Its 
specification is 
compatible with 
VGA, hence there are 
cables that will 
connect both up.

 VGA
Video Graphics Array 
(VGA) was produced 
back in the 1980s 
and remained the 
peripheral standard 
for monitors and 
other devices until 
being phased out in 
favour of DVI.

Explore 
Boost your dual monitor setup
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13 Custom Display Properties applet
UltraMon supports the exact physical positioning of 

monitors by entering coordinates directly in the Custom Display 
Properties applet. Unlike Windows Display Properties, more than 
10 monitors can be configured. Under ‘Display Settings’, click on 
‘Actions’ to open up the Arrange Monitors screen. From here you 
can choose from various different screen setups.

11 Mirror your screens
You can use a second monitor to mirror what you see on the 

first screen for presentations etc. Here, UltraMon gives you more 
options than Windows. From the right-click menu, choose ‘Mirroring 
> Settings’ and pick from one of the options. For presenting, being 
able to mirror a single application or part of a desktop is handy. Go 
into the context menu again and choose ‘Mirroring > Enable’.

9  Extending wallpapers
With UltraMon, you can use a single image for the whole 

desktop, or different images for each monitor. You can also create 
gradient colour backgrounds that extend across two monitors. To 
extend a wallpaper, choose ‘Wallpaper’ from the right-click menu. 
Select ‘One background/image for whole desktop’. Get an image 
by clicking ‘Browse’, and when you’ve found one, choose ‘Stretch’.

14 UltraMon options
Further tweaks are found in the right-click menu under 

‘Options’. There are eight tabs that offer small tweaks to your 
setup. One clever option in UltraMon restores icons to their 
original position. Go to the ‘General’ tab and choose ‘Save Now’ to 
take a snapshot of your current icon positions. Use the ‘Restore 
Now’ button if you ever change your setup and want to revert. ■

12  Primary monitor selection
From the right-click menu you can quickly set the main 

monitor by going to ‘Set Primary > Monitor 1 / 2’. You can also 
quickly disable or enable secondary monitors from the UltraMon 
menu or with a hotkey (see Best Tip). When re-enabling secondary 
monitors (there’s an ‘Enable Secondary’ option in the right-click 
menu), windows are moved back to their original positions.

10 Multiple screensavers
To add a multi-monitor screensaver, go to ‘Screen Saver > 

Configure’. Choose a screensaver from the drop-down list and 
click ‘OK’. UltraMon can also disable secondary monitors when the 
screensaver gets started – this is useful if a screensaver doesn’t 
work correctly with multiple monitors enabled. Go into the 
‘Options’ tab and check ‘Disable secondary monitors’.
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Learn how to…

“IFTTT is a brilliant free online service that speeds up 
the way you work with multiple web applications and 
services by linking them together.”

f you’ve ever found yourself 
manually uploading photos 
you’ve been tagged in from 

Flickr to your OneDrive or Dropbox 
account, or copying and pasting your 
latest tweet into a Facebook post, 
you need IFTTT. This clever free 
online service stands for “If this then 
that”, and makes it really easy to link 
an action that you perform in one 
web application with an automatic 
update in another.

IFTTT is incredibly simple to pick 
up and use. First, create a ‘this’ 
condition in one online service, then 
generate an automatic ‘that’ action in 
another based on a specific trigger, 
such as making a new connection on 
LinkedIn. Over 100 accounts, apps 
and services – including email, phone 
calls on your mobile and the latest 
Google Calendar update – are 
supported, and in this tutorial we’ll 
show you how to link them together.

1 Sign up
Open your browser and go to http://ifttt.com. Click ‘Join 

IFTTT’ to create a free account: you’ll need to provide a username, 
email address and password. Once done, click ‘Create account’ to 
access the dashboard where you’ll see an example recipe is ready 
and waiting for you to add to your account – it’ll automatically 
email new recipes to you on a daily basis. Ignore it for now.

2 Your first recipe
We’re going to create an easy recipe to demonstrate how 

IFTTT works. Click ‘Create’ at the top of the screen. You’ll see ‘if this 
then that’ prominently displayed. Click the highlighted word ‘this’ 
to select your Trigger Channel from the supported apps, services 
or devices. Type Facebook into the Search box and choose 
‘Facebook’ from the filtered list to select it as your channel.

Your guide Nick Peers says…

I

Step-by-step Create your first recipe

Make favourite online 
apps more powerful

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

15 minutes

Nick’s best tiP!
Manage your channels by 
clicking the ‘Channels’ tab. 
some, such as Email and 
Feed, are already activated.
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7 Manage recipes and test
You’ll be taken to the My Recipes section of your dashboard, 

where you’ll see your recipe listed with options for disabling, 
triggering and deleting your recipe – click the ‘>’ button for more 
options including sharing and reviewing a log. Test your recipe by 
performing the action to trigger it, then wait for the recipe to run 
automatically or click the trigger button to run it immediately.

5 Set up action
The ‘If this then that’ line reappears with ‘this’ 

replaced by your trigger. Click ‘that’ to select the channel 
your recipe will affect. For example, choose ‘Email’ to 
send an email based on the trigger, or pick a storage 
provider if you want to upload files online. You have to 
activate the destination channel the first time you use it.

3 Authorise service
The first time you select a channel, IFTTT will ask 

you to link that channel’s account to your IFTTT 
account. Click ‘Activate’ and enter your account 
credentials. Give IFTTT permission to post to that 
account if necessary. Click ‘Done’, then ‘Continue’ to 
select the trigger action that makes the recipe run.

8 Add more recipes
Congratulations, you’ve linked your first two web services 

together, allowing you to automatically perform joint actions 
between them quickly and without fuss. You’re now able to create 
more recipes from scratch, but before doing so, click the ‘Browse’ 
button to search recipes created by others to see if it already 
exists. If it does, you can then add it to your own collection. ■

6 Complete recipe
Again, follow any 

additional steps required to 
complete the action – some 
fields may be pre-filled and 
can be left alone; others 
can be filled or tweaked as 
required - click the ‘+’ 
button for a list of available 
presets. Once done, click 
‘Complete action’. A 
descriptive title will then be 
created for you, which you 
can replace with one of 
your own. Click ‘Create 
recipe’ to finish the task.

4 Choose a trigger
You’ll see a list of available triggers for the 

selected channel. Select the trigger, then perform 
any additional actions required – such as specifying 
a location using an interactive map or typing a 
hashtag – to complete it. Once done, scroll down 
and click on ‘Create trigger’.

Jargon buster!
 Channel

An online web 
application or service 
such as social media 
or cloud storage that 
can be used in IFTTT. 
Over 100 are 
currently supported.

 recipe
A statement that 
describes how an 
action performed in 
one channel (‘if this’) 
automatically 
triggers a specified 
action in another 
(‘then that’).

 Trigger
The action that has 
to be performed in 
the first selected 
channel in order for 
the recipe to 
perform the ‘then 
that’ action.

Explore 
Automate and link web services
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Learn how to…
Create your  
own flowcharts

“Flowcharts can be incredibly 
useful, and with LibreOffice Draw 
it’s easy to make your own.”

ometimes, you really need 
to create a flowchart to 
illustrate the organisation 

structure or workflow process that 
you’re describing. Rather than 
struggling to make your own by 
drawing lines and boxes around bits 
of text, turn to LibreOffice Draw, 
which gives you a set of tools built 
specifically for the purpose.

In this tutorial we’ll show you the 
built-in tools that LibreOffice Draw 
has for creating flowcharts, and 
introduce the two key concepts of 
connectors and glue points, which 
are crucial to creating diagrams. 
Connectors and glue points are 
highly customisable too, and we’ll 
show you all the different ways that 
they can be used. Follow the advice 
here and you’ll find that it’s easy to 
make adjustments as you add, move 
or remove elements. Download 
LibreOffice from www.libreoffice.org, 
open Draw and let’s get started!

1 Add objects to your workspace
To understand how to create flowcharts, you need to get 

used to using the connector tool to draw links between objects. 
First you need to create a couple of objects to practice on, so use 
the basic shapes tool to add two shapes to a blank workspace. 
You can choose any type of shape you like – it doesn’t matter 
while you’re just experimenting.

2 Choose a connector
Move to ‘Connector’ on the Drawing toolbar, click on the 

downward arrow and choose a type of connector at the top left of 
the menu that appears. The one shown above is the most useful 
type, since it will readjust itself so the connecting line always has 
a 90º angle. Along the top of the toolbar you can choose from 
three different connector styles.

Step-by-step Make your own flowchart

Your guide Sue Huntley says…

ConneCtorS
The connector tool is located 
on the Drawing toolbar. Here 
you’ll find 12 different types of 
connector, including straight 
lines, right angles and curves.

objeCtS
Any graphic object can 
be used as a flowchart 
item, and Draw will 
automatically add some 
glue points for you to 
work with.

FlowChartS
You’ll find a tool called 
Flowcharts on the 
Drawing toolbar that 
contains a number of 
standard graphics to 
show information.

S
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKIll leVel

tIme taKen

SuItable For

30 minutes
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3 Connect them together
With the connector selected, move your mouse cursor over 

one of the objects on the workspace. The glue points are shown 
by little crosses. If you click and hold the left mouse button near 
a glue point, your line will snap to it. Drag the line towards a glue 
point on the other object. When you get near, release the mouse 
button and it will snap into place.

4 Move your objects
Now try moving either of the two objects around the 

workspace. You’ll notice that the connectors stay linked as the 
objects move, and this type of connector adapts to make sure it 
never crosses over another object. Try the same experiment with 
some of the different types of connectors, and you’ll discover how 
each type behaves differently. 

optIonS
You can use filled-in 
or outlined objects 
in your flowcharts – 
both work together 
with glue points 
and connectors.

Glue poIntS
The glue points on an 
object appear at the 
corners and half way 
along most edges, but 
you can also add your 
own by customising 
glue points.

text
You can add text 
to the connectors 
between objects in 
your flowcharts, as 
well as inside the 
objects themselves.

Sue’S beSt tip!
to enter text inside any 
graphic object on the 
workspace, just double-click 
it and start typing.

Explore 
Create your own flowcharts
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9 Add text to connectors
Adding text to graphic objects is easy – just double-click 

inside and start typing – but with flowcharts you often need to 
add text to the connectors themselves. Select the connector you 
want to add the text to (its handles become active when you do 
this) then click on the Text icon in the toolbar. A cursor will start 
flashing next to the connector.

10 Modify text location
As you type, the text appears next to the connector you 

selected. This text will be linked to the connector, but if it isn’t in 
the right place, you can move it somewhere more convenient. 
Right-click the text and choose ‘Text’ from the menu that appears. 
You can now choose to anchor the text to its connector in a 
number of different ways.

7 Add glue points
To create your own glue points, choose ‘Glue 

points’ from the Edit menu. Select the first item, 
which is called ‘Insert glue point’. Now you can click 
anywhere on an object and add another glue point. 
There’s no limit to how many you can add.

5 Modify connectors (part one)
If you add a third shape, you’ll see that it’s 

possible for a connector line to run through it. 
Using the selection tool, click on any connecting 
line and you’ll see red handles appear. You can 
adjust the connector by dragging these.

8 Remove glue points 
If you think you’ve added too many glue 

points to an object, just click on one and it should 
become highlighted (provided ‘Edit glue points’ is 
still selected in the main LibreOffice Edit menu). 
Simply tap [Delete] on your keyboard to remove it. 

6 Modify connectors (part two)
You can make precise modifications using the 

Connector dialog box. Right-click a connector line 
and choose ‘Connector’. Here you can enter the 
amount of space that appears before a connector 
branches off and the line skew.

Jargon buster!
 Connectors

Connectors are 
accessible from the 
Drawing toolbar, 
and are used to link 
objects together. 
The beauty is that 
they move with the 
objects they link to.

 Glue points
Glue points are the 
fixed spots where 
the connectors 
attach themselves 
to objects. They 
appear automatically 
on all objects on 
the workspace once 
you’ve selected the 
connector tool.

 Snap
When you’re 
adding connectors 
to objects, you’ll 
notice that they 
automatically ‘snap’ 
themselves to the 
nearest glue point. 
This means you don’t 
have to be totally 
accurate when 
connecting objects.
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15 Use alignment functions
A quicker way to get objects to line up is to us the 

Alignment features from the ‘Modify > Alignment’ menu. Select 
an object, then choose one of these options to make your object 
align horizontally to the left, centre or right of the page. There are 
also options for top, centre or bottom vertical alignment. This is a 
quick way to get things in the right place.

13 Duplicate objects
Alternatively, choose ‘Bitmap’, then select a colourful 

background if you want to really make your flowcharts pop. 
Once you’ve spent a bit of time creating great looking objects, 
duplicating them for further additions to your flowchart can save 
you a lot of time. To make an identical copy an object, simply 
select it, then click ‘Edit > Duplicate’.

11  Use the Flowchart toolbar
LibreOffice Draw has a special tool on the Drawing toolbar 

called Flowcharts, which contains a number of objects that work 
particularly well with these diagrams. Here you’ll find symbols for 
essential elements such as documents, merging, preparation and 
manual input. They’re just shapes, but you’ll find them very handy 
for representing common functions.

16 Put it all together
Now you know everything you need to know about the 

flowchart tools in Draw, it’s time to bring it all together. To move 
your finished flowchart into a text document, select all the parts 
while holding [Shift], and copy and paste them into the text 
document. The objects will be grouped and transferred to Writer, 
where they can be ungrouped if required. ■

14 Position objects
By now you should have a pretty good idea how to create 

objects and link them, but if you’re creating large flowcharts, you 
might find it useful to turn on the background grid. This enables 
you to visually align boxes so they look pleasing to the eye. 
From the View menu choose ‘Grid’. This displays the grid in the 
background that objects snap to.

12 Use different fills
There’s no reason to make flowcharts boring black-and-

white affairs. LibreOffice Draw supports a number of different 
ways to shade and fill objects. You can go for a single hue – just 
select ‘Colour’ in the Fill drop-down, then a colour in the Line and 
Filling toolbar at the top of the window – or you can choose 
‘Gradient’ to add a bit of style.

Explore 
Create your own flowcharts
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Pin it
When you pin a site it appears 
in the top area of the Jump List 
menu. Just hit the pin to the 
right of something to pin or 
unpin it.

Learn how to…
tune up your 
Jump Lists

“You can open documents and 
programs more easily than ever 
with customised Jump Lists.”

indows is packed with 
features that make your life 
easier and more productive, 

but none gives you as much control 
over your files as Jump Lists. These 
lists, as the name implies, provide 
easy access to your most common 
files and let you ‘jump’ to them with a 
couple of mouse clicks. We’re happy 
to say that this spells the end of those 
frustrating trawls through folders, 
hunting for a file you use all the time.
Jump Lists enable you to quickly 
access recently opened files, but 
clever Windows users have found 
other ways to exploit the Jump Lists 
to make them even more useful. One 
application we’ve been playing 
around with is Jumplist-Launcher, 
which is a free Windows 8 app that 
enables you to drag-and-drop files, 
programs and shortcuts to build 
completely custom lists. It also works 
in Windows 7, albeit with some slight 
changes to the steps below.

1 Pin it down
In Windows 8, apps found on the new Modern Ui Start 

menu reflect the most commonly used programs in your arsenal, 
and it is possible to add them to your desktop taskbar from here. 
Simply click on one (or more) and right-click the bottom of the 
screen to activate the menu. Then, click (or tap) on the ‘Pin to 
Taskbar’ option to pin it.

2 Tidy Taskbar
The Taskbar works as a dock for all your programs, and you 

can launch your favourite ones from there. If there’s something 
you use a lot – and it doesn’t just have to be a program, you can 
pin folders, URLs and documents to the Taskbar, too – just 
right-click on the program icon on your desktop, and choose  
‘Pin to Taskbar’ to put it in place. Add more if you like.

Step-by-step Master Jump Lists

Your guide Nicholas Odantzis  says…

W
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKiLL LEVEL

tiME tAKEn

SUitAbLE for

15 minutes
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Doing MorE
We’re using Jump Lists 
in this example to help 
us do more with Internet 
Explorer. eBay was 
opened straight from 
the Jump List.

LiSt oPtionS
Near the bottom of all 
Jump Lists are options 
to do more with the 
program, such as 
unpinning it from the 
Taskbar or performing 
specific tasks.

tASKbAr JUMPS
To access any Jump Lists, simply 
right-click any of the programs 
found in your Taskbar and the 
Jump List will appear straight away.

frEqUEnt fiLES
Depending on what 
you’re using Jump Lists 
for, it’s reflected in here. 
In ours, you can see all 
the websites we visit 
most often.

3 Right-click to find the list
Most programs – and that includes Windows Live, Windows 

programs such as Microsoft Paint, and a whole host of third-party 
applications – add Jump List functionality to the Taskbar. To 
access a program’s Jump List, all you need to do is right-click on 
its Taskbar icon and from the menu that appears, you can open 
the program or choose from recent files.

4 Save time
When you open files associated with programs on the 

Taskbar, they appear on the Jump List. By default, there is space  
for 10 items, and the entries change frequently as you open more 
files. If you want to ensure that an entry remains on the list, it’s 
possible to fix items in place by clicking the pin icon that’s found 
on the right, after the entry you want to retain.

Jargon buster!
 icon

A small image or 
logo that you 
double-click to 
access a file, program 
or folder.

 Jump List
A Windows feature 
where some 
programs have extra 
right-click menus, 
populated by 
recently-used 
shortcuts, files  
and templates.

 Modern Ui
The name of the  
new Windows 8 user 
navigation system, 
but also the name of 
the design language 
Microsoft has been 
developing since 
Windows Phone 7, 
which focuses on 
clean typography.

 taskbar
The bar at the 
bottom of the 
screen, which holds 
open programs, 
windows and folders. 
In Windows 7 you 
can pin programs  
to the Taskbar 
permanently.

Explore 
Master the Jump Lists
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9 Ready when you are
Once you’ve set up Jumplist-Launcher, you will want it to 

stay on the Taskbar permanently, or you will find yourself being 
forced to reopen the program every time you restart your 
computer. To do this, just right-click the Jumplist-Launcher icon 
and then choose ‘Pin to Taskbar’. Now it will always be easy to 
access whenever you want it.

7 Set up Jump Lists
If the Jump Lists in Windows help you work more effectively, 

try Jumplist-Launcher to build custom Jump Lists, available to 
download from http://en.www.ali.dj/jumplist-launcher. To  
open the file, you need a copy of WinRar, which you can get from 
www.rarlab.com. Click on ‘Downloads’ and then choose either the 
32-bit or 64-bit version.

5  More for your money
Like most parts of Windows, the Jump List menus are fully 

customisable, and you can change the size of the menu according 
to your tastes using the Start menu properties. To make some 
custom adjustments to your Jump Lists, just right-click the 
Taskbar and go to ‘Properties’, click the ‘Start menu’ tab and 
choose ‘Customize’.

10 Ready for launch
Now that you’ve organised your life a little more, when you 

start your computer, you can just right-click on the Jumplist-
Launcher icon on your Taskbar to bring up the customised list you 
created earlier. You can pin these in place by clicking the small 
icons to the right of the items, just as you can with all your other 
Jump List options. ■

8 Customise
Once Jumplist-Launcher is downloaded, unzip it and install 

it. As soon as it’s set up and running, open it, then drag-and-drop 
files, programs or shortcuts into the main window. Once you’ve 
done all this, it’s very easy to order your Jump Lists so that they’re 
as efficient as possible – all you need to do is click the up and 
down arrows at the side. 

6 Up the number
At the bottom of the Customize window, you can increase  

or decrease the number of default entries that your Jump Lists 
display. The default is set at 10, but you can type in any number 
you wish, which enables you to create massive lists with access  
to all your files – or, if you prefer, you can save on space with 
minimalist access as required.

62  |   Help & Advice  |  October 2014



Plus all this and much more!

28 pages of handy tutorials

Boot your PC from  
a USB thumb drive

Unleash yoUr 
creativity

October 2014  |   Help & Advice  |  63

Catch up with us on…

www.facebook.com/windowsmag

In the next issue...

 
Have fun with Lego 
Digital Designer
Improve your PC’s 
wireless security
Update all your  
drivers in moments
Get more room to 
work with Dexpot

Transform your photos with the power  
of Paint.net

www.twitter.com/windowsmag

www.facebook.com/windowsmag

Editorial
acting editor Nick Odantzis
New media editor Jeremy Ford

art/ProdUCtioN
art editor Fraser McDermott
deputy art editor Mat Gartside
Managing editor Catherine Emma Ellis
deputy managing editor Alice Lipscombe-Southwell

CoNtriBUtorS 
Editorial Nick Peers, Mayank Sharma, Henry Winchester 
Photography Joseph Branston, Dave Caudrey, Philip Sowels, 
Thinkstock.com, iStockphoto.com, Gettyimages.com

SENior MaNaGEMENt
Group art director Steve Gotobed
Group senior editor Paul Newman
Head of computing group Ian Robson
Group managing director Nial Ferguson
Creative director Bob Abbott
Editorial director Jim Douglas

adVErtiSiNG
advertising director james.ranson@futurenet.com
advertising sales manager ashley.snell@futurenet.com
Senior advertising manager charlie.said@futurenet.com
Senior sales executive michael.carrington@futurenet.com
Senior sales executive sally.mclachlan@futurenet.com 
account manager tamzyn.young@futurenet.com

CirCUlatioN aNd MarKEtiNG 
Group marketing manager philippa.newman@futurenet.com
trade marketing manager colin.hornby@futurenet.com

PriNt ProdUCtioN
Production controller ian.wardle@futurenet.com
logistics manager mark.constance@futurenet.com
ad production coordinator nola.cokely@futurenet.com

iNtErNatioNal liCENSiNG 
international licensing manager regina.erak@futurenet.com 

SUBSCriPtioNS – dEtailS oN PaGE 32
Phone our UK hotline on 0844 848 2852  
Subscribe online at www.myfavouritemagazines.co.uk  

Next issue on sale  26 September 2014

Windows 7 Help & Advice is an internationally licensed title and  
is exported to another 22 countries. 

Future Publishing Ltd, 30 Monmouth Street, Bath BA1 2BW  
Tel: 01225 442244 Fax: 01225 732275  
Email: windowsmagazine@futurenet.com  
Web: www.facebook.com/windowsmag 

© Future Publishing Limited 2014. All rights reserved. No part of this magazine may 
be used or reproduced without the written permission of the publisher. Future 
Publishing Limited (company number 2008885) is registered in England and Wales. 
The registered office of Future Publishing Limited is at Beauford Court, 30 
Monmouth Street, Bath BA1 2BW. All information contained in this magazine is for 
information only and is, as far as we are aware, correct at the time of going to press. 
Future cannot accept any responsibility for errors or inaccuracies in such 
information. You are advised to contact manufacturers and retailers directly with 
regard to the price of products/services referred to in this magazine. If you submit 
unsolicited material to us, you automatically grant Future a licence to publish your 
submission in whole or in part in all editions of the magazine, including licensed 
editions worldwide and in any physical or digital format worldwide. Any material 
you submit is sent at your risk and, although every care is taken, neither Future nor 
its employees, agents or subcontractors shall be liable for loss or damage.

A member of the Audit  
Bureau of Circulations 

on sale  Friday 26 September 2014



64  |   Help & Advice  |  October 2014



Protect your 
PC from 
malware
Once upon a time, protecting 

your computer from viruses 
was a relatively simple affair. 

All you needed was an antivirus 
program and a firewall, and you could 
consider yourself fully protected. How 
times change – these days there are so 
many different types and varieties of 
malicious programs (known as malware) 
that your PC doesn’t know whether it’s 
coming or going. But what exactly is 
ransomware? How at risk are you from 
phishing? How do you protect yourself 
from rootkits, and what steps should 
you take to remove a spyware infection?

In this feature we’ll run through 10 
common types of threat to your PC’s 
security. We’ll reveal what they are and 
how they work, and show you how to 
spot tell-tale signs that one of these 
pieces of malware might be lurking in 
the recesses of your PC’s hard drive. 

We’ll provide advice on removing 
infections from your PC, and how to 
protect yourself against them in future.

We’ll also reveal some useful tools 
– many of which you’ll find on this 
issue’s free disc – that you can use to 
both remove stubborn infections and 
clean up your PC after they’re gone 
so you’re no longer locked out of Safe 
mode, unable to browse the internet 
or refused access to the Registry.

Multi-layered security
What you’ll realise over the course of 
this guide is that no single program 
can provide blanket protection for your 
PC. To stay safe, what you need is a 
good, strong antivirus and anti-spyware 
program, together with a third-party 
firewall. If you’re strapped for cash, 
consider Comodo Internet Security, 
which combines both in a single 

program for no cost, and is included 
on this month’s free disc. We also 
recommend installing several scan- 
and-remove tools like Malwarebytes 
Anti-Malware Free. These don’t offer 
real-time protection, but regular scans 
should help keep your system secure.

Other layers of security can also 
help keep your PC and your data safe 
online, from protecting yourself from 
dangerous websites using the Web 
of Trust browser plug-in to blocking 
attacks on the programs you use every 
day with Malwarebytes Anti-Exploit 
Free. Of course, there’s also a critical 
layer of security that requires no 
software at all, and that’s modifying 
how you behave online to reduce your 
exposure to risk and react appropriately. 
Armed with these tools and our tips, 
you’ll sleep a lot more soundly (and 
securely) at night…

Learn more about the different types of malware that threaten your 
PC, plus discover how to protect yourself against them. By Nick Peers
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Emsisoft Emergency Kit
Download this tool from http://bit.ly/1lU9jsT onto 
an uninfected PC, then double-click the file, install 
it on a USB thumb drive and plug it into your 
infected PC. The kit consists of two scanners, plus 

two utilities for identifying and rooting out 
infections manually. The scanner isn’t as good at 
removing deep-lying infections, but you may have 
more success by running a custom scan with ‘Use 
direct disk access’ selected.

ComboFix
This tool works with Windows XP, Vista and 7, but 
isn’t (yet) compatible with Windows 8 or 8.1. It’s best 
run in Safe mode – tap [F4] as your PC boots and 
choose ‘Safe mode with networking’. It’s also worth 

Remove stubborn malware from your PC

Viruses, worms and trojans
These are particularly insidious, so discover how to keep them at bay

T he most common and well-known 
threat to your PC is the virus. This 
has become a catch-all term for a 

wide range of threats, but on its own a 
virus is a piece of code that attempts to 
copy itself so it can be distributed widely. 
It’s become interchangeable with the 
threat known as a worm, but while 
they share many characteristics, there is 
one critical difference: viruses work by 
inserting themselves into host programs 
such as Microsoft Word. The most obvious 
example here are viruses written in Visual 
Basic that are hidden away inside macros 
that are stored in Word documents. 
The macro is triggered as soon as the 
document is opened unless your Word 
security settings are designed to block it. 
The first thing a macro virus usually does 
is add itself to the main template (normal.
dot) file, which means it’ll run every time 
you launch Word. These days, Office 
security settings prevent macros from 
running by default.

Worms and trojans
Worms are standalone programs that 
behave in a similar manner to viruses, but 
in a self-contained fashion. Traditionally 
they were distributed via the internet – 
inserted as file attachments into emails, 
lurking as downloads on dubious 
websites, or spread via social media and 
peer-to-peer networks like BitTorrent.

Because they’re standalone, worms 
don’t rely on any other software to run; 
once the file is opened, they’re able to 

replicate themselves and cause whatever 
havoc they have been programmed 
to perform. Some worms also deliver 
additional payloads such as backdoors 
and spyware – see the relevant sections 
on the following pages to find out what 
they are and how to deal with them.

Trojans are programs that appear 
legitimate, but are anything but – hence 
their name, which is inspired by the Trojan 
Horse of legend. Having tricked their way 
onto your system, the trojan can then 
deliver its malicious payload. Spyware and 
backdoor infections are common, but 
standalone trojans include destructive 
trojans, which delete files. Another variant 
– time-bomb trojans – wait for a specific 
date before delivering their payload. 

Symptoms
If your PC is affected by a worm or trojan, 
you’ll notice sluggish performance and 
will be unable to run Windows Update or 
access certain websites. You may also find 
that your security software can’t update 
itself to protect against the latest threats, 
or even run at all. If you’ve accidentally 
installed a trojan, you may find other 
software you don’t recognise suddenly 
appearing on your computer too.

Notable example
In 2009, the Conficker worm reminded 
everyone how devastating even ‘simple’ 
worms can be, and the fact that it used a 
vulnerability in Windows that had been 
patched by Microsoft months before 

showed the importance of installing the 
latest Windows security patches.

Removal
Your security software should be able to 
deal with trojans and worms, even after 
they get on to your system. Try using a 
standalone scanner like ClamWin Free 
Antivirus or Malwarebytes Anti-Malware 
Free (both on your free disc) in Safe mode 
if you’re struggling to remove a threat.

Protection
Aside from keeping your security software 
up to date and running regular scans, you 
can minimise the risk of these types of 
malware from getting on to your PC by 
making sure you keep Windows and your 
key programs up to date. Also use caution 
when opening files, particularly those 
downloaded from unknown sources (see 
the section on social engineering on p71).
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noting that this tool is aimed more at advanced 
users, and there’s a risk that it could introduce 
major problems if not used carefully. Visit www.
bleepingcomputer.com/combofix and read the full 
instructions before downloading it.

Kaspersky Rescue CD
Sometimes your computer is so riddled with 
malware you can’t do anything about it from within 
Windows. Visit http://bit.ly/1mgadog on a clean PC 
to download the Kaspersky Rescue CD ISO file. 

Right-click the ISO file and choose 'Burn disc image' 
in Windows 7 or 8 to create a bootable CD. 
Alternatively, visit http://bit.ly/1zpDFgU to create a 
bootable USB thumb drive. Boot from this and let 
Kaspersky disinfect your PC.

This malware is designed to watch what you’re 
doing and steal your personal information

SPyware

Whereas traditional viruses aim to 
replicate and spread themselves 
far and wide, spyware tends to 

focus its efforts on the computer on which 
it’s installed. Its primary aim is to collect 
information about the computer user 
by spying on their activity. It then uses 
this information to target the user with 
ads and other material for financial gain. 
Spyware can also be used to steal financial 
data and passwords through the use of a 
keylogger, which monitors what you type. 

Like other forms of malware, spyware 
attempts to change computer settings – 
particularly those related to the internet. 
It does this to prevent its removal, and to 
make use of the information it’s gathered 

to bombard the infected computer with 
ads and other unwanted material.

Symptoms
The signs of a spyware infection are 
similar to those of worms and trojans, 
and although you may realise that your 
information has been compromised, it 
might take weeks to become apparent.

Notable example
CoolWebSearch is the name given to a 
family of constantly evolving spyware 
infections that target web browsers 
changing homepages and default search 
engines, bombarding users with ads and 
collecting personal information.

Removal
Try running your usual security software 
in Safe mode first. If this fails, follow the 
step-by-step guide below, focusing on 
using Spybot Search & Destroy and 
Malwarebytes Anti-Malware.

Protection
Keep all your software updated and be 
suspicious of any program that originates 
from the internet. Your firewall may help 
you detect spyware by alerting you to 
processes that try to send information 
from your PC without your knowledge.

Backdoor infections
Backdoor infections allow 

hackers to access and 
control your PC remotely. 

They can be used for all kinds of 
things, from using your PC to 
deliver spam to stealing personal 
information. Even worse, PCs 
infected with backdoor viruses 
can be used in networks known 
as botnets to launch attacks on 
websites through distributed 
denial of service (DDoS) attacks.

Symptoms
Anything from slow performance 
to finding money missing from a 
bank account or spam being sent 
from your email address.

Notable examples
SubSeven, also known as Sub7 or 
Sub7Server, was the first notable 
remote backdoor tool, and has 
been credited with inspiring all 
the botnets that have followed. 

Removal
Most security software should 
be able to remove backdoor 
infections. If necessary, follow 
the advice in the step-by-step 
guide below. Try booting into 
Safe mode, and if all else fails, 
disconnect from the internet 
once you’ve updated your 
security software to prevent 
the malicious program from 
communicating with its owner.

Protection
In addition to your antivirus 
software, make sure you have 
a third-party firewall installed. 
Unlike the built-in Windows 
Firewall, third-party firewalls 
are able to monitor outgoing 
communication from your PC, 
which is how backdoor infections 
communicate. Try Comodo 
Firewall (on this month’s disc) if 
you’re looking for a free option.

Feature 
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Set up and run
Perform a quick check of all running programs and 
processes on your PC by downloading and 
extracting the portable version of System Explorer 

from http://bit.ly/1mMQ5va. Open its folder and 
double-click the SystemExplorer program file. 
Grant it administrator service, then click ‘I accept > 
Start security check’.

Review results
System Explorer will now compare all running 
processes on your computer with its online database. 
A progress bar will let you know how far the scan has 

Perform a security audit

This kind of malware attempts to extort 
money from the infected PC’s owner

raNSomware

Y ou can probably guess how 
ransomware works – it takes control 
of your PC and demands that a 

ransom is paid before it is released. It can 
be delivered in a number of ways – via an 
infection, in a file that the user is tricked 
into downloading and running, or via 
network vulnerabilities such as backdoors.

Once the ransomware is installed, it 
will restrict access to critical parts of 
your PC – either by locking down certain 
parts of the system to prevent you from 
performing key tasks, or by encrypting 
files – typically documents and photos 
that are potentially irreplaceable.

The ransomware will then display 
messages demanding the user pay the 
malware creator – perhaps via online 
payment or by sending a premium-rate 
text message from their phone. In return 
for this payment, the user is given an 
unlock code that should (in theory) 
remove the restrictions and restore 
control. Some demands may even be 
time-limited, trying to force the user into 
responding quickly rather than sitting 
on the problem or seeking external help. 
Of course, like all ransoms, there’s no 
guarantee that control will be returned 
even if the end user follows the demands.

Symptoms
Ransomware has no need to hide – its aim 
is to let the user know it’s been installed 
and extort payment in return for releasing 
control of the computer and its key files.

Notable example
CryptoLocker has extorted tens of millions 
of pounds from affected users by 
encrypting files and demanding payment 
for the unlock code.

Removal
The ransomware infection itself should be 
removed by most security software, but 
any encrypted files or system locks will 
remain. Users can avoid paying the 
ransom for minimum data loss if they 
have secure offline backups of their files.

Protection
HitmanPro.Alert (on the cover disc) offers 
a CryptoGuard tool that prevents your 
personal data from being encrypted 
should ransomware get on to your PC.

Rootkit
This is a special form of malware 

designed to conceal its presence 
and protect itself from being 

removed. Once hidden, it can introduce 
payloads that steal information or hijack 
the computer for use as part of a botnet. 
Rootkits are also used for non-malicious 
purposes, such as anti-theft protection. 
Kaspersky’s security software uses a form 
of rootkit to protect itself from malware.

Symptoms
Your PC may perform more sluggishly 
than normal, but rootkits leave very little 
evidence of their presence and are 
notoriously hard to detect.

Notable example
Sony scored a major own goal in 2005 
when it secretly installed rootkits on 
people’s PCs when they popped a music 
CD into their drive. The rootkit enforced 
Sony’s digital rights management (DRM) 
system, but wasn’t secure and other 
malware was able to exploit it.

Removal
If your security software can’t detect 
the rootkit, try Kaspersky’s TDSSKiller 
(http://bit.ly/1oFCSBb). If all else fails, you 
may have to reinstall Windows.

Protection
Check that your security software 

includes protection against rootkits, or 
switch to one that does. Windows 8 
has four layers of protection against 
rootkits, including Secure Boot.
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progressed. Once complete, it may flag up unsafe 
entries, or claim the scan found nothing untoward. 
Either way, click 'See the results of the security check' 
to review its findings in your web browser. 

Unknown entries
Click the ‘Security’ column header to move all 
unknown (and unchecked) processes to the top of 
the list. If you recognise a process you can leave it 

alone, but entries displaying gibberish in the 
Product Name, Company Name and Description 
fields should be treated with suspicion. Click 
‘Details’ to find out more.

Zero-day attacks
These threats exploit recently-discovered vulnerabilities

Security updates for programs 
are designed to close recently 
discovered holes. Left unrepaired, 

these could be exploited by malware 
developers, allowing them to sneak on 
to people’s systems as part of a ‘zero-day 
attack’. These can take the form of worms, 
trojans and other types of malware, but 
their reliance on a specific vulnerability 
makes them easier to block.

Symptoms
The same as most other malware attacks.

Notable example
The Conficker worm in 2009 preyed on a 
security hole in Windows XP that had 
been closed months before, but because 

users were so lax about keeping 
Windows up to date, many fell foul 
of an easily preventable attack.

Removal
If possible, install the latest security 
patch or update. Use your security 
software to remove the infection.

Protection
Keep your software and OS fully 
up to date. If you’re still using 
Windows XP, consider upgrading. 
If you’re stuck using an older 
browser and your security suite 
doesn’t offer protection against 
zero-day attacks, install Malwarebytes 
Anti-Exploit from this month’s free disc.

Potentially unwanted 
programs (PUPs) are a 
grey area when it comes 

to malware. They’re usually 
bundled with other program 
downloads and offered to the  
user during installation as a way 
to help to fund development of 
that program. They are wrapped 
up along with whatever you’re 
trying to download, often using 
confusing dialog boxes.

Most PUPs are harmless, but 
some can harbour spyware and 

browser hijackers and other 
malware. Most security software 
ignores them as they technically 
require your permission – 
however badly framed – before 
they can be installed.

Symptoms
You install a program and others 
seem to be added automatically.

Notable example
Download.com has garnered 
criticism for providing a small 
download utility that offers extra 
tools before downloading the 
program you’re after.

Removal
Most PUPs should be removable 
using their own uninstaller, but 

stubborn ones can be forcibly 
removed using a tool like IOBit 
Uninstaller (on your free disc).

Protection
The premium version of 
Malwarebytes Anti-Malware will 
block any PUP installers it finds. 
Alternatively, install Unchecky 
from the cover disc, which will 
flag up a warning when you 
might be about to install a PUP 
and give you the chance to stop 
the install process.

PoTeNTiaLLy uNwaNTed ProgramS
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Windows Repair Kit
Download the portable version of this toolkit from www.tweaking.com (click ‘Programs > Windows 
repair (all-in-one)’. Work your way through the tool following our step-by-step guide from last issue – 
pay particular attention to the System File Check part of the process, and reboot whenever prompted.

Scan again
After disinfecting your PC, reboot into Normal mode, update your security software and run full scans 
with everything you have. You’ll find a selection of tools on the cover disc that can be installed alongside 
your existing tools. Try removing any traces of infection in Normal mode. If this fails, try Safe mode.

Recover deleted files
If your files have been deleted by malware, you may be able to get them back using a data recovery 
tool like Recuva (www.piriform.com). To avoid overwriting any data, download the portable version on 
another PC and extract it to a thumb drive, then plug that into your affected PC and run the program.

Clean up after an infection

This malware tries to scare users into 
purchasing a full program using a 
combination of social engineering 

and unethical marketing. While some 
scareware can be delivered via trojan 
or a backdoor infection, users are often 
tricked into downloading and installing 
the program from a website or via a 
pop-up window that attempts to pass 
itself off a genuine program window. 

Symptoms
Software you don’t recognise suddenly 
appears on your PC making unrealistic 
claims or attempting to scare you into 
buying the full version of the product.

Notable example
Fake anti-malware software flashes 
up warning signs claiming that your 
computer is infected. Ironically, this 
software is the infection, not the cure.

Removal
Use your security suite and Malwarebytes 
Anti-Malware to remove the software 
and any underlying infection.

Protection
Avoid dangerous websites (see the guide 
on p71) and always keep your security 
software up to date. Avoid clicking any 
buttons – instead, try to close the 
window via the Taskbar.

SCareware

This term refers to software that modifies 
your web browser settings – typically 
the home page, default search engine 

and even error pages. The aim is to push you 
towards websites containing advertising.

Symptoms
Your browser’s home page and search engine 
are changed, and any attempts to change 
them back fail. Some hijackers block access to 
security sites and install browser toolbars. 

Notable example
CoolWebSearch was one of the first browser 
hijackers in 2004, and was so pervasive most 
security products couldn’t remove it properly. 

Removal
Try Malwarebytes Anti-Malware Free (on your 
free disc) to remove the infection. You’ll need 
to reset the search and home pages yourself.

Protection
See the section on potentially unwanted 
programs for tips to avoid inadvertently 
installing software with a sting in its tail.

Browser 
hijackers
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M alware has become an ever 
more complicated field of study 
for online security experts, but 

armed with the tips and tricks in this 
feature you should now have a much 
better understanding of its various forms. 
You should also now have a good idea of 
what tell-tale signs of infection to look 
out for, but remember that this is no 
substitute for maintaining a vigilant 
watch over your entire PC. Make sure 
your security software is fully up to 
date, and that it’s able to run regular, 
scheduled scans of your computer – 
weekly at a minimum, or daily if it doesn’t 
interfere too much with other tasks 
you’re running. Always take the time to 
review the scan results, and don’t forget 

to follow best practice when it comes to 
avoiding infection in the first place.

If you’re still running Windows XP, then 
upgrading to a newer version of 
Windows should be a priority, but if 
you’re unable to do so at present, then 
dig out your copy of issue 94 for some 
essential security advice to follow in 
order to keep your data secure. 

Finally, we’ve also armed you with the 
tricks you need to disinfect your PC 
should malware sneak through its 
defences, and revealed how to clear up 
any lingering after-effects of an 
infection that slips through.

Simply opening your email can be dangerous
SoCiaL eNgiNeeriNg

Beware idly surfing the web – there 
are websites that are known to 
harbour malware or other security 

and privacy threats. These sites are often 
linked to piracy, supposedly offering 
movies, music and full software for free. 
For a long time users were left completely 
blind when surfing the web, but the latest 
versions of most modern browsers – 
including Internet Explorer, Chrome and 
Firefox – all offer built-in phishing and 
malware protection of varying degrees. 
These are capable of detecting known 
phishing sites, blocking access to the site 
and preventing the user from giving up 
personal data. The tools aren’t foolproof, 
however, and rely on the sites being 
known and reported to online services 
such as www.stopbadware.org. 

There are some tell-tale signs to help 
you avoid dangerous sites - they often 
contain lots of advertising and multiple 
download links that can appear confusing 
(see scareware, opposite), but note that 
others can appear perfectly legitimate. 
Internet service providers are also starting 
to provide some protection, blocking 
access to certain file-sharing sites, but 
these blocks are more to do with 
enforcing copyright than protecting you 
from malware.

Phishing
Another form of trickery falls under the 
catch-all term ‘social engineering’, which 
refers to techniques designed to trick 
users into revealing personal information 
or performing actions that subsequently 
lead to malware infection or theft. One of 
the earliest uses of social engineering 

online was to perpetuate 419 scams, so 
named after the Nigerian Criminal Code 
dealing with fraud whereby people are 
tricked into giving up thousands of 
pounds, personal information such as 
passport details and – on rare occasions 
– even their lives in return for the promise 
of a share in a non-existent fortune.

This quickly led to what is still the most 
common form of trickery today: phishing 
emails. These involve criminals sending 
thousands of emails that purport to come 
from respected companies or financial 
institutions. They are designed to trick 
users into revealing their passwords or 
other sensitive information by logging 
on to a fake website by clicking a link 
provided in the email. 

Both the phishing email and the fake 
website attempt to portray themselves as 
the genuine article, with company logos 
and seemingly legitimate web links 
helpfully provided for the user to quickly 
comply with the request. Some provide 
details of an alleged order within a file 
attachment. Users are then expected to 
log on to the fake website to log into their 
account, but instead their personal details 
are passed on to the criminals, who can 
then use them to empty the victim’s bank 
account. Opening a file attachment could 
result in the computer being infected.

Phishing attempts vary in quality – 
often you can spot tell-tale signs such as 
spelling mistakes or outdated logos in the 
email. If your email client supports it, 
rolling your mouse over the embedded 
link should reveal the real web link, which 
often bears no resemblance to the actual 
company website.

Symptoms
Social engineering is pretty easy to spot 
– an email either offering you something 
that’s too good to be true (such as a 
jackpot prize for a lottery you didn’t 
enter), or warning you that your account 
will be suspended if you don’t verify your 
logon details by clicking the web link.

Notable examples
Dodgy websites take all shapes and forms, 
but two notable types are spyware 
removal sites and certain file-sharing sites.

Removal
If you think you’ve been the victim of 
social engineering, contact your bank or 
other institution immediately and change 
your passwords. Malicious downloads 
may be blocked at source by your security 
software; otherwise, you may have to 
remove it using your anti-malware tools.

Protection
Install a browser plug-in such as Web 
of Trust (www.mywot.com), which alerts 
you whenever you attempt to visit a 
dangerous website. It also provides 
security and privacy ratings for search 
engine results. Never click links in emails. 
If you think it might be genuine, open 
your web browser and type the website 
address manually. n

NiCk’S verdiCT
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Get the messaGe Check out someecards if you want to wish someone happy birthday, 
congratulate them on their exam results, or just insult them in a good-natured way

Even if you don’t recognise the name of this digital card 
publisher, the chances are you’ve seen someone else 
sharing one of its images on Facebook. Many of them 
are fairly cheeky, if not plain rude, and quite a few are 
rather US-centric (so not ideal if you and your friends 
live in the UK). Some others are quite sweet though, 
and the sentiment is always there. 

You can send your chosen card in a message, post 
to your own Facebook wall, or put it on someone 
else’s wall for free. There are cards for every occasion, 
including when you need to say sorry or just send 
something for encouragement. Someecards makes 
Facebook just that little bit more personal and social. 

SomeecardS

essential 
Facebook 
apps
our guide to the most useful 
Facebook extras around

1
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safely does it so many people use facebook, it’s an ideal target for 
scammers and other ne’er do wells. Keep yourself safe with a scanning tool

FlixSter

Sound 
cloud

tripadviSor

This is the Facebook app for movie buffs and 
currently it even offers you a free movie to watch 
when you sign up. You can add other films 
through UltraViolet – a code system that enables 
you to buy movies you’ve bought physically on 
your digital devices. You can also rate films you’ve 
seen, and add ones you haven’t watched to your 
‘Want to see’ list. Once you’ve registered, you 
need to complete the process by signing up for 
an UltraViolet account if you don’t have one. If 
you already have an account, you can just add 
that to your profile and get started straight away.

sound adviCe use soundCloud to share your favourite songs with  
your facebook friends and discover all kinds of new music to enjoy

You might well have heard of SoundCloud. 
It’s fast becoming the YouTube of audio – a 
place where audio is shared and musicians 
share their tracks. There’s spoken word too, 
everything is free to listen to, and you can 
search for and follow your favourite creators. 
No wonder that this app has over 10 million 
users. You can listen to sets of tracks (basically 
collections of audio), and it’s easy to upload 
tracks and share them with people. It’s not just 
about entertainment, either – SoundCloud can 
be a great place to store recordings you’ve 
made of interviews or meetings.

The ultimate travelling website offers you the ability 
to track where you’ve been on a world map and plan 
where you’re going next. You can also rate places 
you’ve stayed, but be warned – the app requires you 
to hand over quite a bit of information, including 
your hometown and current location. It also posts to 
Facebook on your behalf unless you request it not to.©
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norton  
SaFe Web

Like BitDefender Safego on the following page, 
Norton Safe Web is a security tool that scans 
activity on your Facebook wall from the last 
24 hours and reports back if it finds anything 
suspicious. Most of the time this is from fake 
links (often with the promise of a revealing 
video) that your friends have inadvertently 
posted and that appear in your news feed. You 
can opt to have it running in the background 
on your Facebook account, so it alerts you if 
there’s ever anything suspicious on your wall. 
It even shows you the status of individual links 
that have been posted, so you can keep an eye 
out for more from the same people. 

2
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If you’ve got a great idea, you can turn it into your 
own Facebook app with iFrapp. This is one of the 
few premium tools we’ve covered here, and although 
you can try it for free for 10 days, you’ll have to pay 
to keep your app going. Fees start at $15 per month, 
but you can cancel at any time. iFrapp is used by some 
big companies and organisations though, including 
Samsung and Wimp. So what kind of apps can you 
create? Contact forms, video players and bespoke 
competitions are its bread and butter, but there are 
numerous possibilities depending on your needs. 
Find out more at www.ifrapp.com.

There are lots of Facebook apps designed to beef up the security of your 
profile on the social network, and Safego from BitDefender is one of the 
best. Other security apps are available too, and although almost all of them 
are created by companies that also sell commercial products (the Facebook 
apps are largely promotional tools created to market the subscription 
services) they do still have a useful role. Safego scans your wall for any 
items that shouldn’t be there. Most of the time this is scam or spam 
content, such as video links that take you off to another site, or malware 
posting to you and your friends’ Facebook walls. You can also warn friends 
if they’ve unwittingly posted a link that looks suspicious.

As Skype is owned by Microsoft, which also owns a stake in Facebook, 
it was only a matter of time before video calls became part of the social 
network. To make a video call, visit http://facebook.com/videocalling, 
where you’ll find advice on setting up your system. You’ll need a webcam 
to record yourself speaking – you can also make voice-only calls with a 
microphone, but it’s not nearly as much fun. Once you’ve got everything 
set up you’ll notice that video calls are now incorporated as part of 
Facebook’s Chat feature. There’s no extra software to install – just click the 
‘Call’ button at the top of your friend’s profile or chat window. If there’s no 
answer, you can leave a video message.

This is a very basic way to build your own Facebook 
apps. Well, actually, when we say ‘build’, we mean ‘take 
a few standard apps off the shelf and post them to your 
Facebook timeline’. It’s very simple stuff, but there 
are a couple of things that you might find useful, such 
as a polling app that you can use to ask your friends 
questions. This is good for crowdsourcing information, 
or just working out which restaurant everyone wants 
to go to at the weekend. There’s also a quiz app, which 
is essentially the modern equivalent of making up 
your own pub quiz. It’s mostly fun stuff, and harmless 
enough. It’s also free, so you’ve nothing to lose by 
opening it up and playing around.

If you use Google’s Picasa photo-editing application 
for Windows and Mac OS X, you’ll know that it’s very 
flexible, has great face recognition, and is very fast 
and easy to use. However, it can be a bit of a pain to 
get your photos out of Picasa and uploaded to 
non-Google websites. This app helps anyone who 
would rather store their photos on Facebook to share 
easier. Unlike many of the apps here, this doesn’t run in 
Facebook. Instead, it’s a plug-in for your PC. It needs 
Adobe Air to run, but it will install this for you.

do it yourself 
samsung and fhm 

have used ifrapp 
to create their own 

facebook apps

bitdeFender 
SaFego

Skype video 
calling

app 
builder

iFrapp

picaSa 
uploader
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 WINDOWS HELP  HARDWARE FIXES  SOFTWARE SOLUTIONS  INTERNET TIPS

Windows
COmPATIbILITy  
AND UPgRADES 

Q I had a bespoke Windows 
XP desktop computer built 

with some very powerful and 
specific hardware, including a 
Creative soundcard with front-
panel connections to go with my 
job as musician, composer and 
researcher. My family is pressuring 
me into upgrading Windows, but 
I’m concerned about compatibility 

– with the soundcard and my main 
music notation program, Sibelius 4, 
which I believe is not compatible 
with Windows 7. I’m also running 
Office 2003 and a number of other 
programs. What do you advise?
Peter Roberts

matt’s solution
The first thing we did 
was ask Peter to run 
Microsoft’s Windows 7 

Upgrade Advisor, which is available 

free from http://bit.ly/TY148A and 
alerts you to any potential issues 
you may face when upgrading your 
version of Windows. This flagged 
up a few hardware issues, including 
one with his bespoke scanner, but 
Peter can continue to use that with 
the help of a third-party program 
called VueScan (www.hamrick.
com). His HP printer was also 
marked as incompatible with 
Windows 7, but we found a driver 
on the HP website (although it may 
offer basic functionality only).

In terms of software, we were 
able to suggest free alternatives to 
programs such as Paint Shop Pro 5 
(Paint.NET) and PowerDVD (its 
functionality is built into Windows 
7). And when it came to upgrading 
Sibelius – a rather costly exercise 
– we discovered when browsing 
the Sibelius help pages that some 
people had reported success 
running the program in Windows 7 
by giving it administrator privileges. 
With this in mind, we advised Peter 
to hold off paying for an update 
until he’s installed Windows 7 and 
tried his luck with Sibelius 4.

Upgrade 
advisor  

Find out if your  
pC can cope with a 
Windows upgrade

Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com Or 
write to the support 
team and we’ll do our 
best to help 
Support squad, 
Windows 7 Help & 
Advice magazine, 
Future Publishing Ltd, 
30 monmouth Street, 
bath bA1 2bW

Do you have a  
PC problem?  
Get in touch…
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Jargon buster!

Web browsing
REmOvE AUSTRALIS 

Q I recently upgraded to Firefox 
30 and really hate the new 

Australis user interface. Short of 
rolling back to version 28, is there 
some way I can get rid of it?
Hannah Oswald

Simon’s solution
If you're less than 
enamoured with the 
latest Firefox redesign, 

head over to http://addons.mozilla.
org and search for Classic Theme 
Restorer. Once installed, it restores 
the 'classic' Firefox look, complete 
with Firefox menu button. If there 
are bits of the new Australis user 
interface you like, open the Firefox 
menu and choose 'Options > 
Classic Theme Restorer'. You can 
then choose exactly which parts 
you want to keep and which you 
want to ditch.

Windows
bOOT.mgR  
mISSINg ERROR 

Q I recently had an error 
message on startup telling me 

that Boot.mgr was missing and to 
try [Ctrl]+[Alt]+[Delete]. Although 
the problem appeared to disappear 
after running Tweaking.com’s 
Windows Repair tool, my wife said 
it appeared again later. Are there 
any further steps I can take?
John Ellinghouse

Nick’s solution
The error can be caused 
by a number of things. 
One of the simplest 

causes is leaving non-bootable 

media – a floppy drive, CD or USB 
drive, for example – plugged in. 
Removing this resolves the issue, 
although it’s also worth checking 
your BIOS to verify that the hard 
drive containing your Windows 
installation is listed as your 
computer’s first boot device.

Another cause can be failing or 
loose cables – specifically internal 
SATA and IDE data cables, and 
the power cables connecting your 
drives to your power supply. Open 
up your PC carefully to check that 
the connections are solid, and 
replace any suspect cables.

If you’re running Windows Vista 
or later, boot from your installation 
disc or access your recovery options 
and run a start-up repair – this will 

Quickfire questions

Find the solution! Browser Password Remover
Review all the passwords stored across your various web 
browsers – visit http://bit.ly/bpremover to download the tool.

I can no longer open links 
in Outlook 2003 due to 
'Restrictions in effect on this 
computer'. How do I fix this?
John main

It’s a well-documented 
problem. Visit http://support.
microsoft.com/kb/310049, 
where you’ll find a fix-it tool 
that can resolve the issue.
 
I’m revamping my website 
and have come across a load 
of broken links. Is there a 
program that can validate all 
my links for me?
Henry Hall

Try the free LinkChecker tool, 
which you can download free 
of charge from http://wummel.
github.io/linkchecker. 

“Classic Theme Restorer 
brings back the old 
Firefox interface”

 Australis 
The name given to the latest 
iteration of the Firefox user 
interface. Australis first 
appeared in Firefox 29.
 

 Dual-boot
A PC that has been configured 
to boot two separate 
operating systems (usually two 
different versions of Windows). 

ClassiC 
FireFox  
You can use a 
third-party tool 
to restore the 
old interface

Final exCeption 
Microsoft released 

one further update 
for Windows xp 
after it reached 

end-of-life in april

Support 
Technical help
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2 Select a preset item
There are over 30 common system 

folder shortcuts supplied – simply tick an 
item and it’ll appear in the Taskbar, ready 
for access. Untick an item, and it will be 
removed automatically. You can unpin folders 
from the right-hand pane too.

1 Download and run
Download the program from www. 

bit.ly/taskbarpinner. Run the file and the 
program will be downloaded into its own 
folder. Open the Windows 7 Taskbar Items 
Pinner and double-click the program file to 
launch it – no installation required.

PIN ANy ITEm TO THE 
TASkbAR

Q Is there a way I can pin useful 
system shortcuts or folders to 

the Windows 7 Taskbar? 
Wayne Powell

Nick’s solution
Normally you can 
only pin programs to 
the Taskbar, but the 

Windows 7 Taskbar Items Pinner 
(which also works in Windows 8) 
allows you to pin other items too, 
including a shortcut to the Control 
Panel and various folders, files and 
even web links, with custom icons 
too. Here’s how to use it.

Quickfire questions

Microsoft Office
INSTALL OFFICE ON  
A DUAL-bOOT PC 
Q I’ve set up my computer to 

dual-boot Windows 7 Home 
Premium and Windows 8.1 Pro on 
separate drives. I have Microsoft 
Office 2010 Professional Plus 
installed on the Windows 7 drive 
– is it possible to migrate the 
installation to the Windows 8.1 
drive or install it on Windows 8.1 
without a new product key?
Phil

James’s solution
You should be able to 
install a fresh copy of 
Office 2010 on your 

I subscribe to a site that links 
to Soundcloud, but Internet 
Explorer 8 isn’t supported 
on my Windows XP PC. 
What browser would you 
recommend instead?
Peter

Soundcloud works with any 
modern browser, including the 
latest versions of Firefox (www.
getfirefox.com) and Google 
Chrome (www.google.com/
chrome). These both look and 
work in a similar fashion, so 
take your pick!
 
I need to convert a Microsoft 
Word document into a PDF 
for printing a book. Can 
you recommend a suitable 
program and safe download 
site for this, please?
Angelika Schaumberg

One of our favourite tools is 
Nitro Reader 3, which you can 
download safely from www.
nitropdf.com/pdf-reader. It’s 
completely free to use and 
unlike most PDF readers, you 
can use it to create PDFs as 
well as view them.
 
How exactly do I power down 
my Android virtual machine 
when using VirtualBox?
Trevor Smithies

Tap the 'Apps' button on 
the home screen and select 
'Settings'. Scroll all the way 
down to the bottom of the 
list of available options and 
choose 'Power off' followed by 
'OK' to shut down your tablet.

detect and replace any missing or 
corrupt files if they’re the culprit. 
Alternatively, select the 'Command 
Prompt’ option and try typing 
bootrec /fixboot and pressing 
[Enter]. Try bootrec /rebuildbcd 
if the other command fails – see 
http://bit.ly/rebuildbcd for more 
advice on using this.

The error could also be caused 
by a memory timing issue, which 
is usually fixed with a BIOS update. 
This proved the case for John, 
and once he’d sourced one and 
updated his PC with the help of 
a friend, the error message was 
finally resolved.

Security
IS THIS UPDATE  
SAFE TO INSTALL? 

Q I was under the impression 
that Windows XP updates had 

ceased, yet I received notification 
recently of an update (KB2964358) 
for Internet Explorer 8. The 
information link left me worried 
and uncertain – is it safe for me 
to install this update?
Richard Phillips

matt’s solution
The simple answer is yes 
– the security threat in 
question was deemed 

so serious that Microsoft quickly 
made an exception and released a 
patch for Internet Explorer 8. You 
shouldn’t assume that this will 
always be the case, though – since 
the patch was released, Microsoft 
hasn’t released any other specific 
updates for Windows XP, Internet 
Explorer 8 or Office 2003, although 
you will still be delivered updates 
for other Microsoft products, 
including the Windows Malicious 
Software Removal Tool. For more 
tips on securing your Windows XP 
now its end-of-life has passed, 
check out our guide in issue 94.

explorer hang 
shell extensions 
are often the 
culprit if Windows 
explorer freezes
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Jargon buster!
 

 Shell extension 
A special program that 'plugs' 
additional functionality into 
Windows Explorer, often by 
adding new options to the 
Windows context menus, 
which appear when you 
right-click a file or folder.
 

 Soundcloud
A Berlin-based website that’s 
designed to allow musicians 
to share and publish their 
recordings with one another 
and the wider internet. 

4 Customise icon
If necessary, change the 'Name' entry to 

something more descriptive. Taskbar Items 
Pinner will pre-select an icon for you – click ‘…’ 
to change this if required, using the number 
field to select an icon within a file. Click the 
‘OK’ button when done.

3 Pin custom items
You can pin any folder, file or web link 

you like using the Pin Custom Item section. 
First, click '…' next to Path and choose 'File', 
'Folder' or 'URL' (ignore the 'Separator' 
option). Select the file or folder, or type in the 
web address, then click 'OK'.

“The security threat was so serious Microsoft 
released a patch for the outdated Internet 

Explorer 8, but this won’t always be the case”

Windows 8.1 installation without 
having to purchase a new product 
key - when you come to activate it 
should recognise the fact it's on the 
same physical PC and work without 
a problem. We’ve had Office 2010 
installed on both partitions of a 
dual-boot machine in the past 
without any issues, so we’re 
confident you’ll be okay too.

It’s also worth noting that Office 
2010 can actually be installed on 
two PCs you own using the same 
product key, but installing it twice 
on the same PC (albeit different 
Windows installations) should still 
only count as one install.

Windows
DESkTOP FREEzE 

Q I’m running Windows 7 Pro 
64-bit edition on a six-month-

old laptop that’s used solely for 
my work as a digital DJ. Recently, 
I’ve found that Windows Explorer 
stops responding when I click on 
the Computer desktop shortcut. 
The window opens, but then it 
freezes for about seven minutes 
before the drives finally appear.
Dave blake

Adam’s solution
We eventually tracked 
this problem down to 
a shell extension. These 

are often installed by programs to 
provide additional functionality 
via the right-click menu. If one 
is buggy, it can cause Windows 
Explorer to stop responding, 
although this is usually triggered 
when you right-click a folder or file. 

Dave downloaded and ran the 
ShellExView program from www.
nirsoft.net (look under System 
Tools). He used it to disable all 
shell extensions, rebooted, and 
the problem was gone. Selectively 
re-enabling items and trying again 
eventually led him to the culprit: 

TrueSuite KeepSafe, which is related 
to the fingerprint scanner on his 
NovaTech laptop. We couldn’t find 
any fixes for the problem online, 
and the company behind it is no 
longer in business, but thankfully 
as Dave doesn’t use the scanner, 
he can fix his problem by simply 
leaving it disabled.

Windows
HELP A FRIEND 
REmOTELy 

Q My friend is forever plaguing 
me with questions about his 

PC and often I feel it takes longer to 
explain the solution than it would 
to simply sit at his PC and fix the 
problem myself. Rather than drive 
across town each time, is there 
another way I can provide support?
Francis Williams

Simon’s solution
The best solution by 
far is to make one more 
trip to your friend’s 

house, and download and install 
TeamViewer on his computer. 
Follow the installation wizard to set 
the program up – choose 'Basic 
installation' and select 'Personal/
non-commercial use' for the free 
version. Now go back home and 
repeat the process on your PC. 

The next time your friend comes 
across a problem with his machine, 
ask him to run TeamViewer from 
the 'Start > All Programs' menu, 
then communicate his ID and 
password. Enter these details into 
TeamViewer at your end and you’ll 
be able to control his computer 
remotely over the internet as if you 
were there yourself. ■

helping hand 
install teamviewer 
to help you repair 
a troublesome 
computer remotely

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help: 
windowsmagazine@
futurenet.com 
Or write to the support 
team and we’ll do 
our best to help: 
Support Squad, 
Windows 7 Help & 
Advice magazine, 
Future Publishing Ltd, 
30 monmouth Street, 
bath bA1 2bW

Support 
Technical help
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 new hardware   essential accessories   latest GaMes

the days of your 
computer being a 
grey box on your 
desk are long gone. 
You can now take 

your PC with you everywhere 
you go, ready for whenever 
you want to type out a report 
or relax and have fun.

This month we’ve got our 
hands on two lovely new 
laptops from Toshiba – one a 
sleek-looking machine designed 
for business use and the other 
a powerful portable built with 
games in mind. 

If that appeals to you, we’ve 
put four of the best new titles 
through their paces, including 
the award-winning Watch Dogs. 
Whatever you need a computer 
for, there’s something for you!

Nick Odantzis acting editor
nick.odantzis@futurenet.com

Welcome

how we review
One of the key tenets of our 
review philosophy is that 
hardware should be compared 
against like products wherever 
possible. It is only when you pit 
the finest products of a certain 
type against one another – at 
the same time – that you can 
really come up with a definitive 

verdict as to which is the very 
best in that category. The pace 
of development in computer 
hardware means that it is very 
difficult to compare scores 
from today with those from, 
say, six months ago. Magazines 
and websites that review a new 
product on its own run the risk 
of confusing or misleading.

We guarantee to test every 
piece of hardware rigorously 
and thoroughly, using only 
acknowledged experts to 
establish the worth of a 
product. We always review 
from the viewpoint of our 
readers; the day-to-day 
practicality and quality of  
a product is paramount.

We use only acknowledged experts to review products, so you can use 
our ratings with full confidence to make your buying decision

ratinG explained Superb GoodVery good Disappointing Poor

our awards…Our review guarantee
Only the very 
finest products 
receive our Best 
On Test Award. 
These will have 
excellent marks 
for quality.

Our Best Value 
Award is given 
to products that 
quite simply 
represent the 
best value for 
your money.

90 Watch Dogs
Hack your way through the computer 
systems of a futuristic Chicago as you 
uncover the city’s darkest secrets.

82 Gaming headphones
Get closer to the action with a top-quality 
headset that will help you become fully 
immersed in your games.

92 Wolfenstein: The New Order
A lovingly crafted and incredibly violent 
sequel to the classic 2009 shooter, packed 
with robot Nazis and vintage ’60s vinyl.

86 Lenovo ThinkPad 8
The most powerful Windows 8 tablet we’ve 
seen so far, but does poor battery life 
prevent it being a feasible portable option?
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Upgrade 
What’s inside…

You can trust our reviews
Our expert reviewers are 100 per cent 
independent, with years of experience 

in the world of computing. Our rigorous 
testing procedures mean that only 
genuine, high-quality products are 
awarded high star ratings. Further, very  
few are handed our Best Value or Best  
on Test Awards. If you see an item of 
hardware bearing one of these marks,  
you can be confident that it is an excellent 
product. Always check when the award  
was given, to ensure it is still up-to-date.

we choose the best products
Thousands of new products for your 
computer are released every year and 

choosing between them can sometimes be 
an impossible task. Our experts select only 
the best hardware and software to feature 
in this magazine, making your decision on 
which one to choose easier. Even better, 
our awards and star rating system make it 
simple to find the best products for your 
needs, with our recommended products 
section giving you a fast, trustworthy guide 
to a wide range of hardware and software.

we’ll introduce you to new stuff
Wherever we can, we review new 
hardware comparatively, pitching  

it head-to-head against other similar 
products. (Full details of our policy can be 
found in the opposite page, under ‘Our 
review guarantee’.) Of course, this isn’t 
always possible with new products and 
part of our duty to you is to introduce you 
a wide range of fascinating new hardware, 
software, services and games.

The reviews of standalone hardware  
and software are just as thorough as our 
comparative reviews. However, we do not 
allocate scores to them because this can 
often be misleading. The only exception to 
this rule is on our games reviews, where 
the pace of change is a lot slower and 
single scores can be genuinely useful.

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

“Cloudbank is a lusciously detailed 
cyberpunk future built atop the 

memory of a red-gold art-deco past.” 
Turn to page 96

82 Turtle Beach Ear Force XO SEVEN
82 ROCCAT Kave XTD 5.1 Digital
83 Razer Kraken Forged Edition
83 Sennheiser G4ME Zero
83 Astro 850 Wireless System
84 Toshiba Kira
86 Lenovo ThinkPad 8
88 Toshiba Satellite S50D
90 Watch Dogs
92 Wolfenstein: The New Order
94 Wildstar
96 Transistor 
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improved battery life 
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88 Toshiba Satellite S50D: the affordable 
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Game of 
’phones
Embraced the next generation of 
consoles and gaming PCs? It’s time 
for a headset update to match

Turtle Beach Ear Force 
XO SEVEN
Price £130 | $160 (www.turtlebeach.com)

Microsoft’s Xbox One requires a firmware update and 
an adaptor for headset compatibility, but the XO 
Sevens have that sorted, throwing absolutely 
everything you need into the box. They’re wired, so 
you’re tethered to your Xbox’s controller, but the 
sound quality is brilliant and the microphone is 
detachable in case you’re not feeling particularly 
chatty. They’re not the most stylish cans on test, but 
the exterior plates are removable if you want to 
change the look and memory foam cushions are 
comfy for prolonged gaming.

ROCCAT Kave XTD 5.1 
Digital
Price £150 | $170 (http://roccat.org)

Packing three audio drivers per ear, these deliver 
convincing surround sound, with Sound Console 
software giving you exhaustive powers to fine-tune 
the 5.1 audio settings – as long as you can master the 
headset’s clunky interface. 

It’s a wired headset with a removable mic that 
includes a desktop remote with a USB sound card, 
speaker outputs and Bluetooth. That little lot allows 
you to toggle between listening via headphones or 
speakers and receive calls wirelessly from your phone. 
For PC gaming they’re as smart as it gets, but with no 
console compatibility the appeal is a tad limited.
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Sennheiser 
G4ME Zero
Price £200 | $350 (http://en-uk.
sennheiser.com)

The G4ME Zero is another PC-only 
headset. It concentrates on great 
audio quality but lacks almost all 
of the flashy features offered by 
the cheaper Roccat (left). The 
wired surround sound headset 
plugs directly into a PC sound 
card or motherboard, with one 
cable for audio and the other for 
the microphone. 

Credit where credit’s due, sound 
quality is just peachy and the 
auto-muting mic with active noise 
cancelling works a treat at 
blocking out distraction. However, 
those improvements in audio 
aren’t profound enough to make 
us overlook the ugly plasticky 
construction – especially on the 
white version.

Razer Kraken Forged Edition
Price £250 | $300 (www.razerzone.com)

If the future of gaming is mobile, then the Krakens are ready. This headset is as at home 
playing music from your phone as providing the soundtrack to your latest iOS and Android 
apps. There is no console support – next-gen or otherwise – but plug them in via 3.5mm 
and an in-line adaptor controls volume, while a mic handles chat. 

Sound quality is decent, but there’s no active noise cancelling. The closed-ear design and 
40mm neodymium drivers do a good job of blocking out the hum of the world, though. 
Our biggest complaint is their weight; they do fold up to fit into your bag, but at 390g you’ll 
sure know that you’re carrying them.

Astro A50 Wireless System 
Battlefield 4 Edition
Price £250 | $300 (www.astrogaming.co.uk)

No camouflage for this EA shooter tie-in – just an understated black and 
orange livery and cracking Dolby 7.1 sound with almost no interference, 
despite its lack of wires. The A50 headset is built for Xbox 360, but it is 
compatible with the Xbox One if you add a Stereo Headset Adaptor (£20), 
and PS4, as well as all gaming PCs. 

There are some key weaknesses: the headset is heavy for long gaming 
sessions, plus we’d have preferred a detachable mic and compatibility with 
mobile devices. Yet the A50 Wireless System is still winning this war.

Upgrade
Headphones
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Toshiba’s new Kira is a 2014 
update to last year’s model, 
which marked the company’s 

first foray into premium Ultrabook 
territory. With a sleek chassis and 
improved battery life, it joins a 
growing list of competing Windows 
Ultrabooks with high-resolution, 
high-pixel-density displays.

For the Kira’s entry price of 
£1,299/$2,230 you could bag 
yourself a Dell XPS 13, or a laptop/
tablet hybrid such as the Lenovo 
IdeaPad Yoga 2 Pro or Asus UX301. 
In the business arena, the Lenovo 
ThinkPad X1 Carbon and Fujitsu 
Lifebook U904 also pack sharp 
screens, slim designs and the latest 
Intel Core processors. Can Toshiba 
match such fierce competition?

After years of dependable (if 
slightly uninspired) mid-range 
laptops, Toshiba’s original Kira 
was a statement of intent – a flash 
Bentley coming off a production 

line of three-door hatchbacks. 
A performance boost to an already 
attractive Ultrabook is welcome, 
but is it enough to launch the Kira 
into pole position?

Slick design
The Kira’s chassis measures just 
23mm at its thickest point and 
tapers toward the bottom, making 
it appear even thinner. There’s an 
eye-catching black bezel around 
the screen, and the lid and base are 
coated in an attractive silver finish. 
This is complemented by a silver 
edge around the power button, 
Wi-Fi indicator and trackpad.

Build quality is decent overall 
thanks to the Kira’s magnesium 
alloy construction, which uses a 
honeycomb structure for strength. 
You’ll only notice the flex on the 
underside of the base if you go 
deliberately prodding it, but the 
laptop’s lid is worryingly bendable 

and you’ll want to avoid using it 
to pick the machine up.

Though it was more of a 
standout feature on last year’s 
version, the Kira’s 13.3-inch WQHD 
(Wide Quad High Definition) 
PixelPure display still makes for 
impressive viewing, with high 
contrast levels that show off its 
deep blacks and solid colours.

The Kira’s display is far from 
perfect though; despite its solid 
colour reproduction, the panel’s 
image quality is hampered by a 
dim backlight, which maxes out at 
what feels like around 85 per cent 
brightness. This is exacerbated by 
the display’s highly reflective finish, 
which makes viewing its contents 
awkward in brightly-lit places.

The screen features 10-point 
multi-touch, which is responsive 
and accurate. You might wonder 
whether you would need touch on 
a non-hybrid model (especially for 

Toshiba Kira
£1,299 | $2,230 www.toshiba.com

A revised model arrives with improved battery life and its predecessor’s good looks intact



The high cost of the Kira puts it 
at a disadvantage, but it’s a great 
laptop apart from the dim display.

the added cost), but it allows you to 
perform some tasks more quickly 
than a trackpad or mouse.

Despite feeling quite compact for 
a 13-inch Ultrabook (mainly thanks 
to the thin bezel), the Kira doesn’t 
provide a cramped typing 
experience. However, that’s not 
helped by the fact that its chiclet-
style keyboard keys aren’t 
completely square; they’re slightly 
wider than they are tall, which may 
take some getting used to.

You shouldn’t make the Kira your 
main sound system for house 
parties, as its Harman Kardon 
speakers are no substitute for a 

dedicated speaker and subwoofer 
system. However, it’s fine for 
personal listening and you can 
tweak the sound settings using the 
DTS Studio Surround app.

Scale and polish
Like other Ultrabooks with high 
resolutions, the Kira struggles with 
Windows 8.1’s poor scaling abilities, 
making text and UI elements 
difficult to read in certain apps. 
Some apps cope with this better 
than others. The desktop version 
of Evernote, for example, doesn’t 
attempt to adjust to the higher 
resolution. Internet Explorer, on the 
other hand, sets itself to a 200 per 
cent zoom level by default, which 
makes web pages appear comically 
large compared with everything 

else (we found that 125 per cent 
made for comfortable reading).

Aside from playing around with 
individual apps’ settings, the only 
option is to use a lower resolution, 
such as 1,920 x 1,080, which defeats 
the point of a high-PPI display.

Powered up
Our test model was supplied with 
Windows 8.1, an Intel Core i7-4500 
processor running at 1.80GHz, 
8GB of RAM and a 256GB SSD. The 
Kira’s graphics are powered by 
an integrated Intel HD 4400 chip, 
which handled 3DMark 8’s least 
demanding benchmarks with ease, 

but began to struggle with 
increasingly complex tasks. It’s fine 
for playing games running Valve’s 
Source engine around the 40-50fps 
mark (if you lower the resolution 
to 1,920 x 1,080). However, as is 
expected from an integrated GPU, 
you won’t experience those frame 
rates in newer games such as 
Battlefield 4 or Titanfall, even if you 
drastically lower the resolution.

Any tasks we performed in 
desktop mode were nippy and 
responsive – from opening desktop 
programs to snapping multiple 
apps side-by-side. Because of its 
speedy SSD, the Kira only took 10 
seconds to boot from cold.

The Kira’s CPU has been 
upgraded from Ivy Bridge to 
Haswell, resulting in improved 

“The updated Kira’s longer battery life, compact 
styling and attractive looks are all plus points”

battery life. The laptop ran for 
11 hours using PCMark 8 Home’s 
battery life test, which continually 
opens and closes programs and 
loops video until the battery is 
completely depleted.

The port selection is good for 
an Ultrabook, offering a full-size 
HDMI output and two USB 3.0 
ports on the left-hand side. On the 
right-hand side is an SD card slot, a 
3.5mm stereo headset jack and one 
more USB 3.0 port. Connectivity 
options here include 802.11ac Wi-Fi 
and Bluetooth 4.0.

The updated Kira’s longer battery 
life, compact styling and attractive 
looks (with the lid open) are all plus 
points, but some of the flaws could 
be deal-breakers. The most glaring 
one is the display’s dim backlight. 
It’s a shame that Toshiba couldn’t 
crank the display brightness up by 
10-15 per cent, which would make 
it easier to use in direct sunlight 
The amount of flex in the Kira’s lid is 
also cause for concern for a laptop 
in this price bracket. 

Although the Kira only offers 
an integrated graphics setup, 
it’s fine for playing casual games. 
The speedy SSD makes sure you’re 
never waiting for applications to 
respond on the desktop, and boot 
times are fast too. 

All things considered, this is 
a highly portable machine with 
fantastic battery life, competent 
performance and perhaps a little 
more in the way of style than 
substance. If the Kira was a bit less 
expensive it would be easier to 
look over its misgivings, but when 
the competition is this strong, it is 
something of a hard sell. n
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Toshiba Kira
Supplier www.toshiba.com
Processor Intel Core i7-4500 1.8Ghz
Storage 256GB SSD
RAM 8GB
Graphics Intel HD Graphics 4400
Connectivity 1 x HDMI, 2 x USB 3.0,  
SD card, 3.5mm audio 
Weight 1.35kg 
Screen size 13.3 inches 
Display resolution 2,560 x 1,440



The range of 8-inch tablets 
featuring full Windows 8.1 
is growing every day. While 

a few truly great slates have filled 
out this micro-slab space, it’s also 
grown rather stale. Most devices 
sport an uninspiring 1,200 x 800 
resolution screen and nearly 
identical internals.

Lenovo hopes to get out of the 
rut with the ThinkPad 8, which is 
the first 8-inch Windows tablet with 
a Full HD 1,920 x 1,200 resolution 
touch panel and a punchier Intel 
Atom processor to boot. The 
ThinkPad 8 has some promising 
specs on paper, but does this tablet 
truly usher in the next generation 
of small Windows 8.1 slates?

That Full HD display makes 
content look just as crisp as the 
current Nexus 7, which features the 
same pixel count. What’s more, the 
colour is balanced, without any 
extra saturation or hints of blue 
tint from the backlight. The display 
boasts nearly 170-degree viewing 

angles all-around, too. The 
ThinkPad 8 has been equipped 
with a quad-core 2.4GHz Intel 
Atom Z3770 processor. This makes 
it more powerful than any of its 
rivals to date, which have all been 
powered with the same 1.33GHz 
Intel Atom Z3740 chip. This extra 
power comes at a cost though; the 
ThinkPad 8 only comes with 64GB 
of storage in this configuration.

As well as being the most 
powerful and well-equipped 
8-inch Windows 8.1 tablet on 
the market so far, the Lenovo 
ThinkPad 8 is also the best looking. 
This is largely thanks to the slate’s 
aluminium body, which makes 
for an attractive, sturdy and light 
device, weighing in at around 400g. 
Lenovo has clearly aimed to create 
a device with a premium look and 
feel, and it has done exactly that. 
The ThinkPad 8 is backed with 
a machined aluminium shell, in 
contrast to the plastic Dell Venue 8 
Pro and faux-metal Acer Iconia W4.

A soft, rubbery material wraps 
the ThinkPad 8’s slim edges, which 
makes it easier to keep a grip on 
the device. Along the right edge 
you’ll find the power button, 
volume rocker and a USB 3.0 port, 
which connects to Lenovo’s USB 
dock. And don’t worry about 
carrying the cable everywhere 
– a micro USB cable also fits in the 
port for charging. The left side of 
the tablet holds a micro HDMI port, 
while an additional flap hides a 
microSD slot. In a nod to the iPad, 
the tablet’s left side also houses 
hidden magnets for attaching the 
optional Quickshot Cover.

Everyday hero
So how does it perform? In our 
experience, slapping a high-
resolution screen onto a mobile 
chip-powered device is a risky 
manoeuvre. In the Dell XPS 11, an 
insufficient processor sometimes 
left the machine woefully 
underpowered to handle both the 

Lenovo ThinkPad 8
£352 | $604 www.lenovo.com

Meet the most powerful – and most power-hungry – 8-inch Windows tablet yet
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it’s absolutely fine for reading 
documents, it’s a hassle to edit 
them with just a virtual keyboard – 
this is especially true of 
spreadsheets. The ThinkPad 8 
comes with plenty of bundled 
software, but most of it is 
replaceable. Quickcast and Reach 
are Lenovo-specific file transfer 
clients that could be traded up to 
more open systems, like Dropbox 
or Box. The same goes for Rara 
Music, when nearly everyone 
already uses Spotify or another 
streaming service. 

Power and panache
So the Lenovo ThinkPad 8 is 
definitely the most powerful 
Windows 8.1 tablet to come out 
in the 8-inch space. With its metal 
shell, strong CPU and 1,920 x 1,200 
display, it’s also the most attractive 
8-inch Windows slate out there. 
But at the same time, it touts the 
shortest battery life and the biggest 
price tag, the latter of which sends 
the machine into luxury status. The 
higher-resolution screen is by far 
the biggest selling point and makes 
the ThinkPad 8 stand above the 
rest of the competition. It’s not just 
more pixel dense – the display 
looks gorgeous with vibrant 
colours and plenty of contrast to 
show off those deep blacks. Plus, 
the high-powered, 2.4GHz Intel 
Atom Z3770 processor finally lets 
a tablet in this class multi-task with 
ease. Where the Dell Venue 8 Pro 
and Acer Iconia W4 crunched under 
the weight of multiple apps or even 
one intensive desktop program, the 
ThinkPad 8 stands tall.

More expensive than its closest 
competitors, but regardless, it’s a 
big step up for 8-inch tablets.

display and full Windows operating 
system. Luckily that is not the case 
here, but performance still leaves 
something to be desired. The 
ThinkPad lagged somewhat behind 
the Iconia W4 and Venue 8 Pro in 
performance benchmark tests. 

However, in regular use the 
ThinkPad 8 handled multitasking 
desktop applications and a mix of 
Windows 8 apps like a champ. Even 
with 25 Chrome tabs open, Spotify 
running, and Lightroom editing 
images all at the same time, the 
ThinkPad 8 never choked. 

The area where ThinkPad 8 
is weakest by far is battery life. 
Whereas the Iconia W4 managed to 
last eight hours and 30 minutes and 
the Venue 8 Pro for eight hours and 
17 minutes, the Lenovo hung on for 
a measly four hours and 21 minutes 
when subjected to the PCMark 8 
battery test. Even on a lighter 
endurance run, the ThinkPad 8 only 
lasted for five hours and 18 minutes 
running everyday applications, 
playing a movie on Netflix, and 
putting in a quick round of gaming.

Hard working
With its sharp screen and beefy 
CPU, the ThinkPad 8 is aimed at the 
office worker who wants to carry a 
single machine to work and clip it 
into a dock at their desk when they 

arrive at work. Supposedly, the 
Lenovo tablet is powerful enough 
to support one or two external 
displays, but we didn’t receive a 
USB 3.0 dock to test its capabilities. 

As for using the tablet as a 
standalone productivity machine, 
that’s not quite on the cards. Like 
the Microsoft Surface Pro 3, which 
we reviewed last issue, Lenovo’s 
latest tablet needs a keyboard 
to fully function as a workhorse. 
The built-in touch keyboard is 
functional, but it annoyingly fills up 
half of the screen in landscape and 

a decent portion in portrait mode. 
Worse yet, the touchscreen can also 
be frustrating to use because of its 
high resolution. While the screen 
makes media and text look crisp, it 
also turns menu buttons and even 
Taskbar icons into tiny targets that 
take multiple taps to trigger. Ideally, 
we would have liked an option to 
increase the size of the icons and 
text, but Windows 8.1 only comes 
with the ability to scale everything 
to a smaller size. We were also 
disheartened by the bug-ridden 
camera. It’s one thing to have 
a camera that produces subpar 
images, but it’s quite another for it 
to crash the whole device. 

The ThinkPad 8 also feels like 
it’s missing a lot of functionality to 
succeed as a work machine. While 

“Like Microsoft’s Surface Pro 3, Lenovo’s latest 
tablet needs a keyboard to function as a workhorse”
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Lenovo ThinkPad 8
Supplier www.lenovo.com
Operating system Windows 8.1
Processor Intel Z3770 quad-core 2.4GHz
Storage 64GB eMMC
RAM 2GB
Graphics Intel HD Graphics
Connectivity 1x USB 3.0, Micro SD, Micro 
HDMI, combination 3.5mm audio jack 
Weight 430g 
Screen size 8.3 inches 
Display resolution 1,920 x 1,200
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Toshiba remains a reliable 
choice if you’re looking for a 
solid mid-range laptop, and 

the S50D aims to continue that 
tradition with a tempting price. 
At this end of the market there’s 
an interesting battle going on 
between Intel and AMD, and 
although many systems still make 
do with Intel Core-branded chips, 
more machines than ever are 
relying on AMD’s APUs.

The S50D is one such machine. 
It’s powered by an A10-5745M, 
which is the most potent APU that 
AMD currently puts inside laptops. 
It has four cores that run at 2.1GHz, 
and they’ll hit a peak of 2.9GHz 
using Turbo mode. They boast the 
same design found inside AMD’s 
full-fat desktop processors and 
instead of relying on integrated 
graphics, Toshiba has fitted an HD 
8550M discrete GPU.

Sadly, the rest of the S50D’s 
specification isn’t as enticing. 8GB 
of RAM is normal for mid-range 
machines these days, and the 1TB 
hard disk has plenty of space for 
files and programs, but its sluggish 
5,400rpm spindle speed suggests 
poor performance. It ran through 
our sequential read and write tests 
at 106MB/s and 100MB/s – entirely 
average results. The screen’s 1,366 x 
768 resolution is what we expect 
from an affordable consumer 
laptop, and the glossy panel isn’t a 
touchscreen. That low resolution 
isn’t exactly generous – it makes it 
difficult to work with two windows 
open side-by-side, for instance. 
At least there’s a DVD writer, which 
is often omitted from laptops to 
minimise weight and bulk.

There’s little to shout about on 
the connectivity front. Bluetooth 
4.0 is another standard inclusion, 

but the Ethernet connection isn’t 
Gigabit and the 802.11n Wi-Fi is 
single-band. Around the edges 
you’ll find two USB 3.0 ports, a USB 
2.0 connection, HDMI and D-SUB 
outputs, an SDXC card reader and 
two headphone jacks – a pretty 
standard load-out.

Flexible friend
Build quality is mixed; the laptop’s 
wrist-rest doesn’t move much 
when depressed, but the plastic 
underside feels weaker and the 
middle of the screen is similarly 
flimsy. We’d advise slipping the 
S50D inside a robust protective 
case before taking it outside the 
house. The 2.38kg weight and 
24mm-thick body aren’t impressive, 
either; this machine is both thicker 
and heavier than three of its rivals, 
with only the Toshiba Satellite C50 
proving chunkier.

Toshiba Satellite S50D
£549 | $942 www.toshiba.com

An AMD processor and Radeon graphics power – is this a great budget gaming option?



settings toned down to make them 
a little less demanding.

Toshiba’s focus on the laptop’s 
internal components means that 
the screen is relatively poor, and 
the exterior is uninspiring. The lack 
of a touchscreen is particularly 
disappointing, while the 1,366 x 
768 resolution rules out serious 
work on this system – and it’s not 
good enough for Full HD films, 
either. It’s just about bright enough, 
but it falls down in every other 
benchmark, including black level, 
contrast, colour accuracy and 
gamut coverage. The speakers are 
mediocre, the connectivity options 
aren’t any better, and the battery 
life is similarly middling – if that’s 
a chief concern, better longevity is 
available elsewhere.

General purpose
While build quality isn’t bad, 
this machine certainly has the 
occasional structural weaknesses, 
and the plastic and aluminium 
exterior won’t turn any heads. The 
Toshiba isn’t without its issues, but 
none of them are deal-breakers 
if you’re searching for a budget 
laptop – rather, they’re things that 
just have to be accepted.

If you want a system for general 
computing and light gaming and 
you are keen to concentrate on 
processing power, then this an ideal 
buy thanks to the combination of 
an AMD APU and discrete graphics 
core. If screen quality or battery life 
are more important for your needs, 
though, look elsewhere. n

The focus on key components 
means that other areas suffer – 
notably the poor display.

The Scrabble-tile keyboard is 
made from glossy plastic, and it has 
a good layout. Toshiba has found 
room for a number pad, and most 
of the keys are large enough, with 
big [Backspace] and [Shift] keys and 
a double-height [Enter] button – 
we’d only quibble about the tiny 
spacebar. Quality is reasonable, too. 
The keys don’t have enough travel 
for our liking, but that’s not a huge 
problem because they’re heavy 
and consistent enough to provide 
solid feedback without feeling too 
weighty, and the base is strong. 
We quickly got up to speed, and 
it’s an improvement on most similar 
laptops we’ve reviewed, which 
combined low-travel keys with 
flimsy bases. Little stands out about 

the trackpad; while its surface is 
fine and the two buttons are light 
and clicky, their quality isn’t quite 
as high as we’d like.

The AMD APU wasn’t troubled by 
our PCMark 8 graphics benchmarks 
and the processor also proved its 
worth. It is possible to play top 
games – as long as you’re prepared 
to drop down to lower quality 
levels. We ran older racing title DiRT 
3 at high settings and 1,366 x 768, 
and the game ran at a smooth 37 
frames per second. We then tried 
Bioshock Infinite’s low quality level; 
at the same resolution, this more 
modern game ran at 32fps.

Power down
Toshiba hasn’t installed a 
particularly big battery in this 

machine, so it’s no surprise that 
its longevity didn’t impress. In 
Balanced mode with the screen at 
50 per cent brightness the S50D 
lasted for just shy of four hours, 
with this figure extending to four 
hours 17 minutes with Power Saver 
mode enabled and the screen’s 
brightness turned to 25 per cent. 
That’s shorter than its laptop rivals, 
albeit not by much. We then turned 
the screen to full brightness and 
activated High Performance mode, 
and the Toshiba lasted for three 
hours seven minutes – another 
mediocre result. However you cut 
it, this machine just won’t last a full 
day away from the mains.

Building a budget laptop always 
involves compromise, so you’ll have 

to figure out exactly what you 
want before taking the plunge 
with a system like the S50D. The 
AMD APU, when combined with 
the discrete graphics card, makes 
this the most powerful AMD-
powered budget laptop we’ve seen 
recently, and it’s also got more 
grunt than machines equipped 
with Intel’s low-end chips. The rest 
of the specification doesn’t break 
any speed records, but the 1TB 
hard disk and DVD writer provide 
versatility. The core components 
in this system performed well: 
the S50D has enough processing 
power to outpace any machine 
unless it’s got a Core i5 processor 
inside, and there’s enough gaming 
grunt here to run most modern 
titles – albeit with the quality 

“The speakers and connectivity options are 
mediocre, and the battery life is similarly middling”
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Toshiba Satellite S50D
Supplier www.toshiba.com
Operating system Windows 8.1
Processor AMD quad-core A10-5745M 
2.1GHz
Storage 1TB
RAM 8GB
Graphics AMD Radeon HD 8610G + 
8550M Dual Graphics
Connectivity 2x USB 3.0, 1x Ethernet,  
1x USB 2.0, card reader, 1x HDMI,  
3.5mm audio 
Weight 2.38kg 
Screen size 15.6-inch 
Display resolution 1,366 x 768



person open-world action 
game Watch Dogs, beginning 
with its moody protagonist, 
Aiden Pearce. He’s got a few 
days of beard stubble, speaks 
in a whispery growl, and has 
zero sense of humour. He’s 
haunted by, and feels 
responsible for, a tragedy in 
his past, and he’s out for 
revenge – or is it redemption? 
To find those responsible for 
his misery, Aiden needs to 
uncover a shadowy conspiracy 
involving secret organisations, 
organised crime, and 
government corruption, and 
will employ the help of – get 
this – an eccentric cast of 

This has hard drives to hack and hard cars to drive
Price £40 | $60
Developer Ubisoft Montreal
Publisher Ubisoft  
Multiplayer Up to 8 players DRM Uplay Web www.watchdogs.ubi.com
Recommended specs DirectX 11-compliant GPU, 8GB RAM, 3.5GHz CPU

oddball characters, some with 
secrets of their own. There is 
one new and interesting thing 
about Aiden: he’s got a really 
cool smartphone.

I have a lot of issues with 
Watch Dogs, but Aiden’s 
phone is due a lot of credit for 
how much I enjoyed it. In 
profile mode, the phone 
identifies citizens around me 
and enables me to hack into 
their phones with a keypress, 
downloading bank details and 
eavesdropping on their calls. 
And it tells me their secrets. 
Miles Renner is late with child 
support payments. Conner 
Eggers is on probation. Bill 

I’m racing a stolen 
motorbike through a 
cityscape, cop cars 
wailing in pursuit, when 

I smash into a car, shoot 
through the air like a missile, 
and slam face-first into a wall. 
Nothing new – I’ve done this 
many times, in many games. 

While I’m sailing through 
the air, my phone informs me 
the driver of the car I’ve struck 
is Martin Huntley, age 39, who 
works as a telemarketer, makes 
$24,000 a year, and is into 
autoerotic asphyxiation. Okay. 
That part’s new.

There’s no shortage of the 
familiar in Ubisoft’s third-

Watch Dogs Woods is affiliated with a racist 
organisation. Think of 
everything you’ve ever typed 
into an email, text message, or 
search engine – yes, even in 
incognito mode – and then 
think about some mopey, 
stubble-faced man in a stupid 
futuristic coat, standing on the 
street corner, reading about it.

Game of phones
My phone has access to ctOS, 
an omnipresent computer 
network that manages the 
entire city of Chicago. I can 
change traffic lights to cause 
accidents ahead of me (useful 
if I’m pursuing someone) or 
behind me (handy if I’m the 
one being pursued). After a 
few skill upgrades, I can blow 
up steam pipes buried 
beneath the streets, raise 
barricades and tyre spikes, 
disrupt radio transmissions, 
cause massive blackouts and 
disable helicopters. 

Where the magical 
smartphone truly shines is 
during the infiltration of 
secure locations crawling with 
armed guards. No need to 

Remote hacking is great, but sometimes
it’s nice to get out and meet people
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rush in, just scout the 
perimeter until you spot an 
external security camera on 
the side of a nearby building. 
Accessing it with your phone 
enables you to ‘hop’ into the 
camera and look through its 
lens. If you spot another 
security camera with the one 
you’re controlling, you can 
project yourself into that one, 
and so on, forming a chain of 
digital leaps Aiden refers to as 
“riding the cameras.” There are 
entire buildings you can 
infiltrate and escape from, all 
while standing safely outside 
on a street corner, looking like 
just another dude absorbed 
with his mobile phone.

Remote hacking and camera 
riding gets you into a lot of 
places, but many missions 
require a personal touch, by 
which I mean stealthily 
sneaking through buildings, 
shooting a thousand men in 
the face with guns and driving 
at top speed all over the city. 

The gunplay was mostly 
satisfying: mouse-aiming felt 
natural without being too 
easy, the bigger guns had a 
reasonable amount of recoil 
(except for the full-auto 
shotgun, which has none), and 
the single-shot grenade 
launcher got me out of more 
jams than I can count.

Less satisfying is the driving, 
which was pretty awkward 
with keyboard and mouse. 
Eventually, I switched to my 
wireless 360 controller for this, 

swapping back to mouse and 
keyboard for everything else. 
On the plus side, the game 
detects what you’re using, 
instantly updating any 
on-screen prompts to reflect 
your control scheme. Also, 
brace yourself for yet another 
irritating checkpoint save 
system. Did you enjoy that 
lengthy phone call at the start 
of the mission so much you 
want to hear it again? 
Interested in re-killing those 
first 20 goons before getting 
to the boss goon who killed 
you? If your answer to any of 
these is “no”, never fail a 
mission in this game.

Chicago itself feels a bit 
bigger than GTA IV’s Liberty 
City, and the areas are all 
seamlessly connected (the 
only loading screens you’ll 
encounter are while fast-
travelling). I found the city 
attractive if not particularly 
memorable, perhaps because 
there are no planes to pilot 
over it, nor infinite parachutes 
to leap off its buildings with. 

As far as the citizens 
themselves go, they’re not as 
loud nor obnoxious as those in 
GTA or Saints Row, which 
makes them considerably less 
fun to terrorise. 

Busy signals
There’s also plenty of extra 
work in Watch Dogs for the 
eager vigilante. Notifications 
pop up alerting you to 
upcoming crimes in the area. 

Some hunting around will 
reveal either the potential 
crook or possible victim, and 
you can tail them, witness the 
crime, then chase down and 
punish the offender.

And, of course, you can 
unlock vehicles, buy guns, and 
visit shops to purchase slightly 
different versions of your 
stupid coat. There are lots of 
fun things to do in Watch 
Dogs, along with a main 
storyline that takes a little over 
20 hours to complete.

I was a little worried that  
I wouldn’t have time to check 
out Watch Dogs’ multiplayer 
modes, but that problem was 
solved for me when I was 
notified that multiplayer was, 
in fact, checking me out. 
Another player was in my 
singleplayer game hacking 
into my data. In Watch Dogs’ 
one-on-one hacking game, 
you have to use your phone to 
locate the intruder (who will 
be disguised as a normal 
citizen) and kill them before 
they can finish their download 
and slip out of your game.

Suddenly realising another 
human player is in your game 
is wonderfully unsettling, 
especially since they’ve 
potentially been there for a 
while. Thematically, it’s 
perfect, given all the spying 
you do in Watch Dogs, and it’s 
especially fun when you’re the 
invader. In one heart-
pounding match, I sat behind 
the wheel of a parked car in a 

busy part of town, watching 
my mark circle the area again 
and again, frantically scanning 
for me among the NPCs. My 
hack slowly climbed to 99 per 
cent – so close! – before he 
finally spotted me and ran 
toward my car. I gunned the 
engine and screeched away 
into traffic, his gunshots 
thunking into my bonnet, and 
lost him after jumping a 
drawbridge, safely returning to 
my game with most – not all 
– of his data. Incredible fun.

I found little to like in Watch 
Dogs’ storyline. Aiden’s 
gloominess and introspection 
are tiresome, and the best 
character, a fixer named Jordi, 
gets almost no screen time. 

Watch Dogs can seem like a 
game we’ve played before. But 
when it deviates from the 
familiar, it really soars: hacking 
the city and all its cameras, 
communications and utilities is 
freeing and fun, while 
invading the games of other 
players is an unusual and 
welcome thrill. ■

 Hacking traffic lights is useful 
 for escape. Or just for fun 

 Yes, you can go nuts and blow up   
 the city. In virtual reality mode, anyway

Aiden’s too moody to be  
part of your community

Creative hacking and covert 
multiplayer breathes new life 
into a familiar experience.
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extraordinary style. The New 
Order is Inglourious Basterds by 
way of Moonbase Alpha – an 
X-rated episode of Captain 
Scarlet starring the world’s 
most militarised jacket potato.

BJ Blazkowicz returns during 
a last-ditch Allied assault on a 
Nazi compound in 1946. This 
game is technically a sequel to 
Raven’s 2009 Wolfenstein, but 
all you really need to know is 
that the Nazis have figured out 
how to graft a gigantic staple 
remover onto a dog’s face. 
Advances like this one have 
given them the edge, and BJ is 
left in a 14-year coma when 
that final assault goes south. 

Loud, violent, and smarter than you might think
Price £35 | $60
Developer Machine Games
Publisher Bethesda  
Multiplayer None  DRM Steam Web www.wolfenstein.com
Recommended specs Quad core CPU, 4GB RAM, 2GB GPU 

He wakes up in a world 
controlled by the Third Reich 
and becomes the cornerstone 
of a resistance movement.

History is treated like a 
toybox when it comes to 
providing you with evils to 
revolt against. The New Order’s 
basic thesis is that this is okay: 
concentration camps, secret 
police and brutal eugenics can 
all be used as motivators for 
violent entertainment. If these 
sorts of ideas make you upset 
or uncomfortable, or if you are 
otherwise disturbed by body 
horror, scalpels or surgery, it 
might be best to stay away 
from this game.

Bethesda title 
Wolfenstein: The New 
Order has been made 
with love. This might 

not be obvious when you are 
giving a Nazi both barrels as 
the world around you collapses 
in a shower of bone and blood 
and concrete. I’d forgive you 
for missing this care and 
attention to detail when you 
wrench a lasergun from its 
fixed emplacement and use it 
to mulch a charging column of 
Third Reich roboguys.

But it is there if you go 
looking for it. This vision of 
Nazi-dominated 1960s Europe 
has been constructed with 

Wolfenstein: The New Order
For all that brutality, though, 

this is a far more thoughtfully 
written and well-acted game 
than it has any right to be. It’s 
never explicitly ironic – that 
would get tiresome – but its 
characters are intelligent, 
larger-than-life and invested in 
the world around them. You’ll 
periodically return to the 
resistance headquarters for 
some non-combat missions, 
and the well-written 
backmatter makes this space 
well worth exploring.

Could be wurst
There are exceptions, of 
course – stock situations, stock 
characters and heroic 
sacrifices that you see coming 
hours in advance. This game 
does not deserve to be put on 
a pedestal for its presentation 
of history – unless that 
pedestal also includes a pair of 
thundering megashotguns 
and a Nazi who doesn’t have 

Robots with glowing red eyes  
also make an appearance
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arms any more. But it’s better 
than you’d expect, and I 
pressed eagerly through the 
campaign’s nine hour running 
time and would do so again.

An array of collectibles and 
difficulty modes encourage a 
second run, which is a 
welcome inclusion for a 
singleplayer game. Machine 
Games have invested a 
remarkable amount of time in 
this optional material: the 
game includes collectible 
recordings of ’50s and ’60s 
pop songs in their alternate 
universe… German language 
versions. Plus, a decision you 
make in the prologue has an 
influence on the campaign: 
you’ll either be able to pick 
locks or hotwire devices 
depending on your choice, 

granting you access to 
different routes and upgrade 
paths. It’s also – and here’s the 
important bit – an excellent 
shooter. Weapons have 
tremendous weight, animation 
is top-quality, and levels are 
divided into arenas that are, in 
the main, fun to fight across. 

Major encounters normally 
include one or two 
commanders who will 
continuously summon 
reinforcements to the area if 
they’re alerted. If you play The 
New Order as a straight 
shooter, enemies will continue 
to arrive until you fight your 
way through to the 
commander and kill him. 

The best thing about The 
New Order as a stealth game, 
though, is that it’s fun to fail: 

fumble a takedown and you 
transition seamlessly into 
Rambo. I found myself 
adopting an all-or-nothing 
playstyle, going in quiet at first 
before gleefully transitioning 
to the double shotguns.

BJ picks up an upgradable 
laser cutter that can be used 
to carve freeform shapes out 
of certain fences and vent 
covers, but beyond a few 
puzzles its potential goes 
unexplored. The laser should 
be Wolfenstein’s gravity gun, 
but it’s really just another gun. 

History repeating
The game is further held back 
by a lack of new ideas in its 
second half. It remains a very 
good shooter, but the 
underlying structure never 
escapes familiar patterns. I’ve 
also got a gripe with its 
damage indicators – it’s often 
quite tricky to tell when you’re 
being attacked from the sides 
or behind; as enemy numbers 
ramp up this can lead to some 
unfair-feeling failures at higher 
difficulties. The AI’s love of 
flanking manoeuvres is 

laudable, but a little bit of 
warning would be nice.

At the time of writing, the 
game has driver compatibility 
issues that impact 
performance. A bit of 
Googling should turn up a 
solution – either upgrading or 
downgrading your drivers, 
normally – but it’s a hindrance, 
as is the abundance of texture 
pop-in that occurs just after 
you load a fresh game. 

That said, it’s great fun. It’s a 
reminder of a time when the 
singleplayer campaign was the 
main event – a time when 
titles of this genre were made 
with attention to detail, lots of 
care and a bit of love.  ■

 He doesn’t need to be able 
 to see to crush your face

My aim’s a little off-centre,  
but it doesn’t seem to matter  

at the end of the day

 There are no nice doggies  
 in the Nazi-controlled future

This place could do with  
a spring clean

 The marksman rifle can clear  
 rooms quickly if you’re accurate

 Rampage down the corridor 
 (shooter) of power

You can blow a Nazi to pieces 
among some lovingly-
designed 1960s furnishings.

Upgrade 
Wolfenstein: The New Order
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insecure about its inspirations. 
WoW’s DNA is unmistakably 
present – you can see it in the 
questing, the structure and 
the expressive cartoon style – 
but developer Carbine has 
tweaked that formula to create 
something distinct. 

At the start of the game 
you pick one of two factions. 
The Exiles are a ragtag bunch 
of space refugees, who have 
come to WildStar’s planet 
Nexus to make a new home. 
The Dominion are the guys 
who exiled the Exiles. Neither 
side is very fond of the other.

Your character is chosen to 
represent their faction in the 

Pack provisions – you could be wandering for some time
Price £35 | $60
Developer Carbine Studios
Publisher NCSoft  
Multiplayer Massively  DRM Account log-in  Web www.wildstar-online.com
Recommended specs 2.66GHz quad-core CPU, 128MB GPU, 8GB RAM

impending Exile vs Dominion 
ruckus. You serve as a solution 
to your faction’s many 
problems – a bit like Harvey 
Keitel in Pulp Fiction, if he had 
bunny ears or was a robot.

Wild at heart
Each mission is categorised by 
its impact on the story at large, 
with World, Zone and Region 
types in descending order of 
importance. At times it can 
feel like you’re being bogged 
down in trivial errands, but 
there’s variety and humour 
sprinkled throughout, and it’s 
easier to forgive WildStar its 
blander episodes when you’re 

Over the nine years 
since World of Warcraft’s 
release, plenty of other 
games have tried to 

capture the same magic. The 
problem, for many, was a basic 
misunderstanding of what that 
magic was. Rather than start 
with a wish to create expansive 
worlds, deep rule-systems and 
engaging lore, those later 
games were conceived out of a 
realisation that having millions 
of regular subscribers looks 
good on an earnings report. 

Having played WildStar for 
more than 50 hours, what 
impresses us is that it feels less 
cynical in its approach and less 

WildStar embroiled in, say, the 
administrative bickerings of a 
corporate race of green clones.

Questing, similarly, has its 
standout moments. You’re 
going to be killing a lot of 
things, and when you’re not, 
you’re probably going to be 
activating or collecting a set 
number of objects by running 
up to them and pressing [F]. 
But then there are moments 
when the game’s penchant for 
silliness kicks in, and you’re 
chasing a naked rabbit around 
town, or attaching a rocket to 
a cute pig-thing.

Such highlights would be 
useless if the general questing 
was an enthusiasm-sapping 
churn of endurance, but it’s 
not. While many of the quests 
ask you to kill a particular type 
of enemy or monster, they 
don’t ask for a set number. 
Instead, a percentage bar 
increases as you carry out your 
task. For the biggest reward, 
take on the Prime monsters, 
denoted by their menacing 
red sheen. These are much 
tougher, and should generally 
be tackled by more than one 

A tiny legion in a single zone;  
this could take a while...
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person. As other players are 
likely doing the same tasks, we 
found that, after a brief dance 
of hesitation, most could be 
coaxed into assistance.

Every player selects a Path, 
which provides a secondary 
set of objectives. Scientists 
scan wildlife, settlers build 
stations that give a temporary 
boost to players, soldiers are 
offered a variety of combat 
scenarios, and explorers chart 
each zone, uncovering secrets 
and jumping on things. We 
picked the latter, and were 
given plenty of opportunities 
to suspend our to-do list in 
favour of climbing mountains 
or scavenging for secrets.

Kill something and you 
might activate a challenge 
– a timed goal to dispatch as 
many of that specific enemy 
as possible. Find a public 
noticeboard and you’ll be 
offered a group quest to take 
down an especially tough 
beast, or you might stumble 
upon a public event, in which 
players from around the area 
are called to work towards 
some large-scale attack. 

Special activities are 
unlocked at various stages. 
Shiphand missions take you 
on a sci-fi adventure that 
scales based on the number 
of players in your party. 
Adventures are five-player 
branching stories that 
repurpose existing zones for 
specific, varied quests. Then 
there are dungeons, which 
provide some of the most 
difficult tactical encounters.

These instanced quests help 
alleviate the issue of open-
world grouping. There’s no 
level scaling in WildStar’s open 
zones, which means that it can 
be very difficult to adventure 
with friends. Even during 
launch – with guild-mates 
of a similar level – finding 
moments when our quest-logs 
aligned was rare.

All of which means that 
now, as we approach level 25, 
we have a variety of potential 
options available every time 
we log in. And we’ve almost 
always achieved something 
when we log out. That could 
mean completing any of the 
above activities or winning a 

PvP match. Alternatively, 
we might find a new table 
for our house – a terrifyingly 
compelling Animal Crossing-
like piece of land that can be 
upgraded in various ways.

On target
What really keeps us engaged 
is the combat, which is both 
lively and fluid. Hold down a 
number key and the range of 
your attack will be shown in 
blue. Let go to activate that 
ability, damaging everything 
in the highlighted area.

Enemies follow the same 
rule for any attack above their 
most basic. Not only are you 
required to land your own 
attacks, but also to dodge 
the red zones that telegraph 
theirs. It’s here that the system 
really comes alive. In PvP 
battlegrounds – WildStar’s 
10v10 objective-based 
matches – the floor becomes a 
shifting patchwork of blue, red 
and the green of your healers.

Carbine has created a 
brilliant foundation for a 
successful MMO, but there’s 
a lot riding on the days and 

months to come. WildStar 
has a subscription fee, plus a 
system called Credd. This, like 
EVE Online’s Plex, is game time 
bought with real-world money 
that can be traded to other 
players for in-game gold. As 
of writing, it isn’t active, which 
makes it impossible to predict 
if it will prove a reasonable 
alternative to a monthly fee. 

If WildStar is to be 
worthwhile in the long 
term, its developers will 
need to keep it regularly and 
substantially updated. For 
now, the game is a love letter 
to MMO fans, with more than 
enough content to justify its 
initial cost. ■

The chunky art style owes  
much to World of Warcraft

Big attacks require 
speedy evasion

 Dungeon bosses can have  
 some unusual attacks

The explorer path is all about  
being where you shouldn’t be

Clever questing and combat 
make for a huge game that’s 
full of character.

Upgrade 
Play this…
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abilities – and disappointed 
that the rest of the world felt 
so shallow in comparison.

Like Supergiant’s first game 
Bastion, Transistor is an 
action-RPG. The Transistor can 
freeze time and initiate a 
planning mode called Turn() 
for queuing abilities called 
functions against the Process. 
Walking around the map and 
queuing abilities fill up an 
action bar, and more powerful 
abilities eat up more space on 
the bar. After you’ve 
committed to a sequence 
of attacks, the world snaps 
back into action and enemies 
move in slow-mo as Red 

The sword proves mightier than the pen
Price £15 | $20
Developer Supergiant Games
Publisher In-house 
Multiplayer None DRM Steam Web www.supergiantgames.com
Recommended specs 2.6GHz CPU, 4GB RAM, 1GB GPU

attacks in real time. There’s a 
great cadence to the combat. I 
sometimes spent a full minute 
planning the most efficient 
turn, then watched Red 
execute four of the Process in 
as many seconds.

Transistor’s combat is 
malleable thanks to the 
sword’s functions. All 16 of 
these can be used as active 
abilities – stuns, explosive 
AoEs, cloaking fields, dodges 
– or as upgrades that augment 
the effects of other functions. 
Early in the game, I upgraded 
the slow-but-powerful Breach 
function with Jaunt, which 
made the attack trigger 

Transistor begins with a 
woman, a dead body, a 
talking sword and a 
dying city. Red is a 

singer with no voice, trapped 
in a sprawling digital 
metropolis that’s being erased 
by white robot programs 
called the Process. Byte by 
byte, block by block, 
Cloudbank is vanishing. 

But Red has the Transistor, 
which is a mysterious sword. 
She is the hero, but the 
Transistor is narrator and star. 
Eight hours after grasping that 
sword, I reached the end of 
Red’s journey in love with the 
Transistor’s nuanced combat 

Transistor instantly and let me use it 
while my meter was 
recharging itself. 

As if there weren’t enough 
active and upgrade 
combinations, all 16 functions 
have another effect when 
equipped in a ‘passive’ slot. As 
an active function, Help 
summons an AI companion to 
assist in battle. Equip it as 
passive, and it offers a 25 per 
cent chance to become a 
SuperUser when triggering a 
turn, which grants unlimited 
movement range and a 
one-hit-kill attack. Purge, a 
damage-over-time active, is an 
automatic counterattack when 
equipped as a passive. 

Transistor is built to be 
played with a controller, as 
each function is mapped to a 
face button and Turn() is 
controlled with the triggers. 
The default mouse/keyboard 
controls are a little clunky 
– pressing [1]-[4] will highlight 
a function, and the right 
mouse button triggers it, but 
an alternate option will fire off 
the function instead of 
highlighting it. The keys can 

It’s cyberpunk with a 
delicious art deco vibe
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also be remapped, and 
Transistor has the most 
impressive on-the-fly UI 
switching I’ve ever seen for 
controls. Touch the keyboard 
or mouse, and all the in-game 
UI elements will show PC 
controls. Touch the controller, 
and they’ll automatically 
switch to controller prompts. 
It’s one of those little touches 
that’s so slick, you wonder why 
it’s not in every game.

Combat is on the easy side, 
though – I only died twice in 
the game, and I played at least 
half of it with a combination of 
‘limiters’ equipped. These 
unlock throughout the game 
and make the Process spawn 
in greater numbers, hit harder, 
or gain protective shields. 
Fighting with limiters engaged 
earns Red more experience.

While Transistor’s combat 
only gets more fun in New 

Game+, I also rolled into a 
second playthrough with the 
forlorn hope that there 
was more to Transistor’s story 
than I’d got the first time 
around. Unfortunately, there 
just wasn’t.

Questions
The city of Cloudbank is 
absolutely stunning. It is 
a lusciously detailed, hand-
drawn cyberpunk future built 
atop the memory of a 
red-gold art deco past. As the 
Process consume the region, 
streets awash in vivid green, 
red and purple lighting fade to 
austere white. 

Exploring the empty streets 
of Cloudbank had me as 
entranced as the first time I 
stepped foot into BioShock’s 
Rapture. Supergiant’s 2D art is 
compelling, and the blend of 
sci-fi and classic architecture 

promises a fascinating 
backstory. I was still waiting 
for that backstory when the 
game ended.

I thought the narrator’s 
cryptic references to 
Cloudbank’s past were 
building up to a moment that 
would do the city justice, but 
that moment never comes.  
I hoped I would encounter 
people and learn their stories, 
but after battling the Process 
from empty environment to 
empty environment, that hope 
shrank. Only a handful of 
terminals offer any insight into 
the city’s culture.

Like Bastion, Transistor is 
focused on a hero and a 
narrator traversing the ruins of 
their world. But as the mystery 
of Bastion unfolded, it tied the 
fates of its characters to that of 
its setting. Red’s story feels like 
a sliver of what is interesting 
and compelling about 
Cloudbank. Transistor is 
disappointingly linear in a city 
that begs for exploration.

The story Transistor does tell 
is dished out in tantalising 

morsels, and I had to spend 
some time reflecting on the 
ending to decide what 
happened. Perhaps because of 
that vagueness, Transistor’s 
emotional climax didn’t hit me 
like Bastion’s did. Supergiant’s 
games are, in that sense, 
mirror images – the first with 
shallower combat but a 
powerfully told story, the 
second with deep, tactical 
battles but a story that doesn’t 
fulfil its promise. Then again, 
that promise lives on after the 
credits roll. I hope the 
developer isn’t done with the 
world of Transistor – there’s so 
much more I want to know. ■

Discovering how Red 
lost her voice, and not 
her life, is central to  
Transistor’s mystery 

 Transistor’s sporadic cutscenes  
 pan across its wonderful artwork 

 What? It’s a very  
 heavy sword

Boats are cool

A brilliant combat system 
propels a story that is never 
as interesting as it should be.

Upgrade 
Transistor
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Your disc
Hello and welcome 
to your free disc, 
exclusive to 
Windows 7 Help & 
Advice. This month’s 

packed CD-ROM features great 
programs to help you get the 
best from your computer, plus 
essential resources for every 
Windows user.

This issue we’ve assembled 
a brilliant toolkit to help you 
keep your hard drive neat, tidy 
and running as efficiently as 
possible. We’ve also created 
a suite of security software to 
protect your PC and data when 
you’re online. Enjoy! 

Jeremy Ford disc editor
jeremy.ford@futurenet.com

Welcome This issue’s highlights

1 Get started 
Place your free disc into your computer’s disc drive. The 

AutoPlay prompt should appear on your screen and once this  
has happened, click ‘Run OWV.exe’ to start up the disc interface.  
A new window appears, telling you some important information. 
Read it, then click on ‘I agree’ to continue.

2 Browse the categories 
Click on one of the categories in the menu underneath the 

magazine logo to discover all the programs that are contained in 
each. Simply click on an app’s name to find out more about it.  
Full commercial products usually have information about how  
to register. To try out an app, just click the ‘Install Now’ button.

Step-by-step How to use your free disc

67 Let Comodo Firewall give your 
PC an extra layer of protecton

26 Access TV shows, films and  
music with Media Browser Server

70 Remove security threats with 
Malwarebytes Anti-Malware

34 Use GIMP to liven up your 
summer holiday photos

 full productS   Handpicked toolkitS   eSSential reSourceS
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Your disc
Make the most of it!

3 install the program 
When you begin to install your chosen applications, the  

disc brings up another message window to take you through the 
installation process. Each one of these is different – just follow the 
prompts until you get a message telling you that the installation 
is complete. Now it’s time to try out your free apps – have fun!

Find the solution! How to get your disc to play
If the disc doesn’t start automatically, hit the [Windows] key, 
then click ‘Computer’. Double-click the DVD drive to get going.

if you have  
a problem…
Please visit www.
futurenet.com/support. 
To contact our reader 
support team, email 
support@futurenet.com 
or call 01225 822743, 
quoting the magazine 
name and issue. We are 
only able to provide help 
with this disc, not the 
software contained on it.

 
diSk toolS
•  Active KillDisk
•  AOMEI Backupper 

Standard
•  Crystal DiskMark
•  Desktop Media
•  HDD Guardian
•  Macrorit Disk Scanner
•  MiniTool Partition 

Wizard Home Edition
•  SSDLife Free
•  TestDisk
•  UltraDefrag

Malware protection
•  Baidu Antivirus
•  Clamwin Free Antivirus
•  Hitman.Pro Alert
•  iObit Uninstaller
•  Malwarebytes  

Anti-Exploit
•  Malwarebytes  

Anti-Malware
•  Norascan
•  RogueKiller
•  Unchecky

printinG
•  BullZip PDF Printer
•  GIMP
•  GreenCloud Printer
•  iCopy
•  PaperCut Print Logger
•  PosteRazor
•  PrinterShare
•  Scribus
•  SSuite Envelope  

Address Printer
•  UnderCoverXP

extraS
•  Autorun Organizer
•  Baidu PC Faster
•  Essential guides
•  Media Browser
•  WhoCrashed Free  

Home Edition
•  And more!

Full disc  
contents
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